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Preface

Welcome to the TB9100 Customer Service Software User’s Manual. This 
manual provides you with information about the Tait TB9100 Customer 
Service Software in PDF format. You can view it online or print it if you want 
a paper copy. It describes how to use Version 2.1x of the Customer Service 
Software. 

■ New users should begin at Part B: Getting Started.

■ For explanations of essential concepts, look in Part A: Introduction. 

■ The rest of the manual assumes that you are familiar with Part C: Basic 
Tasks.

Associated Documentation
TB9100 product documentation is provided in PDF format on the product 
CD. Updates are made available on the Tait support web.

Online Help. The CSS also has online Help. It contains more or less the same 
information as this manual. To view it, start the CSS, then press F1 or click the 
Help icon on the toolbar. If you are in a dialog box, click the Help button. The 
Calibration Software also has online Help.

TB9100 Safety and Compliance Booklet (MBA-00012-xx). A printed booklet 
supplied with the base station.

TB9100 Installation and Operation Manual (MBA-00002-xx).

CTU Operation Manual (MBA-00013-xx). Instructions on using the calibration 
and test unit.

Encryption Key Loading Guide (MTA-00004-xx). Instructions on how to define 
encryption keys and load them into the analog gateway and other Tait P25 
products. 

Service Manual (service centers only).

TB9100 Product Catalog provides information about base station parts and 
modules.

Technical notes are published from time to time to describe applications for Tait 
products, to provide technical details not included in manuals, and to offer 
solutions for any problems that arise. The product CD includes technical notes 
that were available at the time of release. Look for new or updated technical 
notes on Tait’s technical support website. 
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Typographical Conventions
‘File > Open’ means ‘click File on the menu bar, then click Open on the list of 
commands that pops up’. ‘Monitor > Module Details > Reciter’ means ‘click 
the Monitor icon on the toolbar, then in the navigation pane find the Module 
Details group, and select Reciter from it’. 

Within this manual, the following types of alerts are used: Important, Note, and 
Tip. The following paragraphs illustrate each type of alert and its associated 
symbol.

Important: This alert is used to warn about the risk of equipment 
damage or malfunction.

Note: This alert is used to highlight significant information that may 
be required to ensure procedures are performed correctly.

Tip: This alert is used to draw your attention to ways of doing things 
that can improve your efficiency or effectiveness.

Publication Record

Version Date Description

 MBA-00003-01 January 2005 First release. Describes version 01.00 of 
the CSS.

 MBA-00003-02 January 2005 Describes version 01.01 of the CSS.

MBA-00003-03 March 2005 Describes version 01.10 of the CSS. 

MBA-00003-04 August 2005 Describes version 01.2x of the CSS. 

MBA-00003-05 December 2005 Describes version 2.0x of the CSS. This 
adds the analog gateway, encryption 
support, and a configurable preamble.

MBA-00003-06 May 2006 Describes version 2.1x of the CSS. This 
adds support for an antenna relay, 
configurable digital inputs and outputs, 
the ability to separately configure RF 
repeat and  simplex/duplex voting.



TB9100 Customer Service Software User’s Manual   Introduction 1

Part A Introduction

The Customer Service Software (CSS) is a Windows-based 
software program that makes it easy to monitor and configure a 
Tait TB9100 base station. You can also use it to carry out 
diagnostic tests and to update the base station’s firmware. 

The CSS can also work with an analog gateway. Where the term 
‘base station’ is used in this manual, it can often be taken to 
include the analog gateway as well. 

The introduction explains concepts that are fundamental to the 
base station and analog gateway. You need to understand them 
before you can use the CSS effectively.

Topics

Channels

Profiles

Receiver Squelch

Subaudible Signaling

RF Repeat Function

Task Manager

Alarms

Data Logging

Analog Gateway

Base Station Security

Software Feature Enabler
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Channels

A TB9100 base station consists of the equipment needed to operate on just one 
channel. However, using the CSS you can program up to 255 channels into a 
single base station. This is confusing, until you realize that ‘channel’ has 
different meanings. The one channel is the transmit and receive frequency pair 
and the 255 channels are different channel configurations, each with its own 
number and name. Task Manager selects one of these channel configurations 
and the base station operates according to the settings in it. These consist of a 
transmit and receive frequency pair and many other settings, grouped into a 
number of profiles. The presence of many channels means that base station 
operation can be modified in any of a large number of ways simply by changing 
to a channel with the desired settings. 

 

Figure 1: Channel terminology

No Name Tx & Rx
Freqs

Mains &
Batt Power Profiles Channel

group
1 Ch 001
2 Ch 002

Channel Table

TB9100

The base station
transmits and
receives on one
channel

One channel in the channel
table tells the base station
which frequencies and other
settings to use

A Task
Manager
task selects
the current
channel

The channel profile (and
other profiles) group channel
settings

The channel group specifies
(for voice calls) which other base
stations this one belongs to
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Channel table Each base station has a channel table. This is the database that stores the channel 
configurations. It is a good idea to maintain a single channel table for your 
network of TB9100 base stations. This means that you can use almost the same 
configuration file for all base stations. To configure a new or replacement base 
station, all you need to do is copy the standard configuration file and make a 
few modifications, for example to the Task Manager statements that select the 
current channel. Working from one configuration file simplifies maintenance. 

Current channel The current channel is the channel that the base station is actually using. Task 
Manager action selects the current channel and Monitor > Interfaces > RF 
Interface displays it.

Note: If the base station is reset, it starts up on the channel that Task 
Manager selects on going to Run mode.
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Profiles

Profiles are groups of settings that configure a base station interface. 

Channel and 
signaling profiles

These profiles configure the RF interface. The channel profile determines 
which modes the receiver supports and (for analog mode) receiver gating and 
channel properties. The signaling profile determines the NAC, any subaudible 
signaling, and transmit tail timers. 

Calling profile The calling profile determines the properties of the analog line as a virtual radio: 
the mode it uses when transmitting, its individual ID, and the group or 
individual that calls are addressed to. The groups it listens to are determined by 
the group membership assigned to the calling profile. The calling profile also 
determines whether calls are encrypted and what key is used. 

Channel group The channel group specifies the group of base stations that this base station 
belongs to. It determines the multicast IP address that the digital line sends to 
and receives from. It also configures voting.

Service profile The service profile determines which digital P25 services are allowed. One 
service profile can be applied to the RF input and another to the analog line input. 

Assigning profiles 
to a channel

Each channel in the channel table must be assigned a set of profiles. Using 
profiles simplifies the work of defining channels. Channels have a large number 
of configuration settings. Instead of configuring them all each time you set up 
a channel, you configure sets of them in profiles. Whenever a different setting 
of a particular configuration parameter is needed, you create a new profile. In 
this way, you establish several profiles for each profile type, any of which can 
be selected when defining a channel. Figure 2 shows how different profiles are 
assigned to channel 2 in the channel table. 

Figure 2: Profiles assigned to a channel in the channel table

No Name Tx & Rx
Freqs

Mains &
Batt Power

Channel
profile

Signaling
profile

Channel
group

Service
profile

Calling
profile

3 Signaling
profile2 Signaling

profile1 Signaling
profile

3 Channel
profile2 Channel

profile1 Channel
profile

3 Channel
profile2 Channel

profile1 Channel
group

3 Service
profile2 Service

profile1 Service
profile

3 Calling
profile2 Calling

profile1 Calling
profile

1 Ch 001 1 1 1 1 1
2 Ch 002 2 3 2 1 2

3 Group
profile2 Group

profile1 Group
Membership

Group 1 =
Group 2 =
Group 3 =
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Receiver Squelch

The TB9100 supports three basic types of squelch operation. In normal squelch, 
the receiver unmutes if the voice signal has the correct Network Access Code 
(NAC) or subaudible signaling. Selective squelch unmutes only if the voice 
signal is addressed to a specific group or individual. Monitor squelch unmutes 
to almost anything. In addition, for normal and selective squelch in analog FM 
mode, the receiver only unmutes if the voice signal exceeds the configured 
RSSI and/or SINAD levels. You set these levels in channel profiles (Receiver 
gating area). 

The following describes the different types of squelch operation and how to 
configure the TB9100 for them.

Normal squelch In digital P25 mode, the receiver accepts one particular NAC. When an 
incoming signal has that NAC, the receiver unmutes. In analog FM mode, the 
receiver is configured with subaudible signaling (see “Subaudible Signaling” on 
page 7). The receiver only unmutes if it detects the specified CTCSS tone or 
DCS code. You select the NAC, CTCSS, and DCS in signaling profiles.

Selective squelch The base station as a whole does not apply selective squelch. The analog line 
can, in digital P25 mode. This is necessary, because analog console systems 
cannot understand P25 signaling. Accordingly, the analog line’s calling profile 
lets you choose selective squelch.

In analog FM mode, selective squelch is achieved by MDC1200 or Selcall 
signaling. The analog line simply passes this signaling through. Selective squelch 
must be provided by the connected console system, only responding if a 
configured MDC1200 or Selcall address is received. 

Monitor squelch Monitor squelch is required so that the dispatcher can monitor the channel. For 
received analog FM signals, monitor squelch simply provides the demodulated 
output, irrespective of its subaudible signaling. For received digital P25 signals, 
monitor squelch provides any recognizable voice signal addressed to any group 
or individual. To set up monitor squelch, you use a calling profile with normal 
squelch and use Task Manager to lock the decoding of the NAC and subaudible 
signaling, so that these squelch mechanisms are bypassed.
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Subaudible Signaling

In analog FM mode, the TB9100 base station can transmit and receive using 
subaudible signaling. Both CTCSS tones and DCS codes are supported. 
CTCSS attaches a subaudible tone to the carrier signal. DCS attaches a digital 
code. A receiver programmed with a particular tone or code will not unmute 
unless that tone or code is presented with the RF signal. 

CTCSS tones and DCS codes are referred to collectively as subtones. Subtones 
make it possible for different groups of users to operate on the same channel 
without hearing or disturbing each other. The base station and the radios that 
use it need to be programmed with the same subtone(s). 

Important: In some parts of the world, the use of subtones is 
regulated. You need to confirm with the regulatory authority in 
your region whether and how you can apply subtones.

Assigning 
subtones

You assign a receive and a transmit subtone to signaling profiles, then assign a 
signaling profile to a channel by editing the channel table. When the base 
station is operating on that channel, it opens the receiver gate to signals with 
the receive subtone and transmits using the transmit subtone.

Matching DCS 
codes

Matching the base station’s DCS code to the code programmed into a group of 
radios can be tricky. This is because the polarity of a DCS code can become 
inverted. For example, a radio has a DCS code of 017 but the base station may 
need to be programmed with 050 (017 inverted). Use simple trial and error to 
see which code works.

Advanced options When using DCS, the base station always transmits a DCS end tone for muting 
the receive audio, but transmitting a CTCSS reverse tone burst is optional and 
configurable.
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RF Repeat Function

A repeater re-transmits what it has received on its RF interface. In the TB9100, 
this repeat function is enabled by default but it can be disabled or put under the 
control of the dispatcher. When the repeat function is enabled, a standalone 
TB9100 repeats what it receives, unless it is handling a call from the dispatcher 
or the maintainer at the control panel microphone.

Repeat function 
of a channel 
group

If the TB9100 is part of a channel group, the repeat function is modified. 
Instead of only repeating what it receives on its RF interface, the base station 
repeats the vote-winning signal out of all the valid RF signals that the base 
stations in the channel group receive. A distributed voting process (each base 
station has its own built-in voters) selects the signal to repeat. In effect, the 
channel group is a wide-area repeater; each base station in the channel group 
repeats the same signal. 

If a dispatcher call is in progress, the channel group broadcasts it and does not 
repeat any radio calls. However, if the call group is duplex, the vote-winning 
radio call is forwarded to the dispatcher.

Configuring the 
repeat function

The repeat function can be enabled or disabled in the channel table.  

Alternatively, the repeat function can be put under dispatcher control, so that 
the dispatcher can turn it on and off as needed. When a dispatcher command 
enables the repeat function, the dispatch equipment sends a tone remote 
function tone to an analog line. Task Manager detects the tone and enables the 
repeat, as well as propagating the command to the other members of the 
channel group so that they also enable repeat.

It is not possible to configure a base station in a channel group to only repeat 
its locally received RF; it can only repeat the vote winner.

Normally, all base stations in the channel group have the same repeat setting. 
However, it is possible to generally enable repeat yet disable it in individual base 
stations (for example, those on solar-powered sites) without disrupting channel 
group operation.

If pin 1 of the system interface is configured for antenna relay and the receive 
and transmit frequencies are the same, the base station will not attempt to 
repeat. 
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Task Manager

Task Manager is a powerful processing engine that adds intelligence to each 
base station, enhancing its flexibility and configurability. Part of the firmware 
running on the reciter's digital board, Task Manager is able to respond to 
various inputs or operating parameters. Task Manager monitors a wide range of 
base station parameters. If one of them changes, Task Manager can take 
appropriate action, for example by changing channel, setting the digital output, 
or locking a function. A locked function cannot operate.

What action (if any) Task Manager takes depends on the tasks it has been given. 
Using the CSS, you are able to define these tasks. Tasks are statements in a very 
simple programming language. Tasks say what action is to be carried out when 
a monitored parameter changes. All tasks have one of two forms: 

IF input, THEN action

IF NOT input THEN action.

For example: 

IF Tone remote detected (550) THEN Go to Channel 3.

This means that when the analog line receives a tone remote function tone of 
550 Hz, the base station changes to channel 3. 

To define a task, you combine an input with an action, using an intuitive set of 
drop-down menus. No programming expertise is required. The list of tasks, 
defined in this way, is the ‘computer code’ that Task Manager processes. In 
effect, this means that you can modify the base station's firmware-based 
operation without needing to compile new firmware. 

Task Manager is essential for selecting a channel. Task Manager actions can 
select a channel whenever the base station enters Run mode, when a tone 
remote function tone is received from the console system, or when the 
combined value of selected digital inputs changes. 

Task Manager is also essential for letting the other base stations in the channel 
group know that a dispatcher command has been received, so that they can 
respond accordingly. 

Task Manager only operates when the base station is in Run mode. 
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Alarms

The base station monitors a large number of conditions. When a condition rises 
above or falls below a defined threshold, the base station generates an alarm and 
stores it in its log. Using the CSS, you can view the current status of all alarms 
(Monitor > Alarms > Status) and a log containing recent alarms (Monitor > 
Data Logging > System Log).

You can also disable any alarms that you do not want (Configure > Alarms > 
Control). 

Most alarms indicate a fault condition, but some are generated by conditions 
external to the base station, such as mains power failure or high BER on the 
RF input. 

The base station can send alarm (and other) messages to a central message 
collector. 

All alarms are inputs into Task Manager. You can create tasks that tell the base 
station what to do when an alarm is triggered.
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Data Logging

The TB9100 logs events such as alarms, calls, Task Manager actions, and 
signaling events in syslog format. The system log (up to 1000 records) stores 
events at level Notice and above. The trace log (up to 1000 records) stores 
events at Information level. Using the CSS, you can view these logs and save 
them to a file. 

If the TaitNet P25 network is set up with a PC running syslog collector 
software, you can configure the base station to send syslog messages to it. In the 
CSS (Configure > Alarms > Logging), you specify the IP address of that PC 
and select a significance level. Messages with that level or higher are sent and 
messages below that level are not.

In addition, the CSS has its own log: Application.log (the log of the previous 
CSS session is Previous application.log). These log files are in the Log Files 
folder and you can view them in a text editor. 
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Analog Gateway

The CSS can configure and monitor analog gateways as well as TB9100 base 
stations. An analog gateway has a 4-wire E & M analog line and an IP/Ethernet 
digital line. The digital line is connected to the TaitNet P25 network and the 
analog line is connected to an analog console system. This provides the console 
system with a connection to one channel group.

The analog gateway makes it possible for legacy console systems to be used with 
Tait digital P25 infrastructure equipment. It also serves as an encryption/
decryption point. 

Each base station also has a 4-wire E & M analog line and can therefore carry 
out gateway functions. However, in systems with encryption, analog gateways 
are normally preferred, so that encryption and decryption occur as close as 
possible to the end points of the message path. 

Analog lines are only available in digital P25 mode if they are enabled by an 
analog line license. Additional licenses are required for MDC1200 signaling and 
for encryption.

The analog line could also be used to connect another base station, voting 
equipment, or recording equipment. Generally, this manual assumes that a 
console system is connected to the analog line and that the analog line is part of 
an analog gateway if encryption is used. 

Configuration of the analog line determines the following:

What type of signaling is used (E & M, keytone, tone remote function tones, 
MDC1200). 

Whether calls originating from the analog line are transmitted as analog FM 
or digital P25 calls. 

What source ID is given to calls originating from the analog line, when they 
are transmitted in digital P25 mode.

Which calls are passed to the analog line (which individual ID and group 
IDs are assigned to the analog line).

Whether calls are encrypted and which encryption key is used.

The last four settings are grouped as the calling profile. 

From the point of view of the radio network, the analog line can be thought of 
as a logical radio. It is an end-point for calls. It has an individual ID and can 
belong to a number of talk groups. 
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Base Station Security

The security of the TB9100 is protected at the base station and at the CSS. The 
base station is protected through a password. The CSS is protected through 
access codes to privileges. Both protections are optional.

By default, the base station has no password, but you can use the CSS to give it 
one. The CSS then remembers the password. Each time you connect to the 
base station, the CSS must authenticate itself to the base station. 

The CSS has three different privileges: Guest, Maintainer, and Administrator. 
When you start the CSS, you automatically have the Guest privilege. If access 
codes have been set, when you try to carry out an operation requiring the 
Maintainer or the Administrator privilege, you are asked for the corresponding 
access code. If access codes have not been set, you automatically have all 
privileges. An icon on the toolbar indicates your current privileges. 

Access codes can be set at installation time or during any CSS session. 

The following operations require Maintainer or Administrator privileges:

All other operations only require Guest privilege. 

Operation Maintainer Administrator

Save configuration files X

Program base station configuration X

Change base station mode X

Perform diagnostics X

Change base station password X

Reset base station X

Edit connections file X

Download firmware X

Enable additional features X

Change privilege access codes X

Zeroize encryption keys X
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Software Feature Enabler

The TB9100 base station has many capabilities, but some of them require a 
license before you can use them. Generally, base stations are delivered with one 
or more features already enabled. The CSS lets you enable (license) additional 
features that you require. The following features are available:

Default radio 
system

The Default radio system feature makes it possible for the base station to 
transmit and receive analog FM transmissions.

P25 common air 
interface

The P25 common air interface feature makes it possible for the base station to 
transmit and receive P25 digital voice transmissions.

Note: If neither of the above features are enabled, the base station 
can operate in Standby mode but not in Run mode. 

Analog line The Analog line feature makes it possible for the base station to make digital 
P25 calls from the analog line and to pass received digital P25 calls to the analog 
line. This license is not needed for analog FM mode or for TSBKs.

Digital line The Digital line feature makes it possible for the base station to send and receive 
voice data streams over the digital line. This feature is not needed for CSS 
communications via the digital line.

Networked user 
data

The Networked user data feature makes it possible for the base station to pass 
user data between its RF interface and an IP address, via the digital line. This 
feature does not require the Digital line feature to be enabled. 

MDC1200 
signaling

The MDC1200 signaling feature makes it possible for console systems to use 
MDC1200 signaling to communicate with radios that are operating in P25 
digital mode. (You do not need a license for this feature to use MDC1200 
signaling in analog FM mode: the base station passes such signaling on 
transparently.) 

Transmit enable The Transmit enable feature is normally licensed. Without it, the base station 
is unable to transmit. Analog gateways and receive-only base stations do not 
need this license. 

Base encryption The Base encryption feature makes it possible for the analog gateway to encrypt 
and decrypt speech using the DES algorithm.

AES encryption The  AES encryption feature makes it possible for an analog gateway with a 
Base encryption feature to also encrypt and decrypt speech using the AES 
algorithm.
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Part B Getting Started

To establish a CSS session with a base station, you must first 
connect to it using the CSS software. If the CSS PC is physically 
connected to a TaitNet P25 network, you can connect to any 
base station in the network.

In a CSS session, you can monitor the base station and carry out 
diagnostic tests. You can also view the base station’s 
configuration and modify it.

Topics

Connecting

Monitoring Alarms

Monitoring the Base Station

Viewing Configuration Settings

Diagnosing Problems



16 Getting Started     © Tait Electronics Limited May 2006



TB9100 Customer Service Software User’s Manual   Connecting 17

Connecting

The following instructions describe how to routinely connect a CSS to a base 
station. For more details, see “Connecting” on page 28 and for information 
about connecting to a base station for the first time, see the Installation and 
Operation Manual. 

To connect to a base station

1. If the CSS is not already running, select Start > Programs > Tait 
Programming Applications > TB9100 CSS v2.02.01 > TB9100 CSS.

2. Make sure that the PC running the CSS is connected via an Ethernet cable 
to a hub on the TaitNet P25 network or directly to the TB9100’s digital 
line. 

3. On the toolbar, click the Connect icon. The Connections dialog box 
appears.

4. Select a row in the list of base stations. If the base station's IP address has not 
been changed, select ‘Default base station.’

5. Click Connect.
If you are asked for a base station password and one hasn’t been set, just click 
OK.

The CSS establishes a connection to the base station you specified. The 
Status bar displays ‘Connected.’

You can now monitor the base station, conduct diagnostic tests, and read and 
modify the base station’s configuration.
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Monitoring Alarms

When you are connected to a base station, the CSS regularly polls the base 
station for alarms. If an alarm is detected, a flashing Alarms icon appears in the 
status bar. If the Alarms icon disappears, the CSS has detected that the alarm was 
cleared.

To monitor alarms

1. Check the status bar. If it has a flashing Alarms icon, click the Alarms button 
on the toolbar. This opens the Status form.

2. Look to see which LED is flashing red. A flashing LED means that the alarm 
is on. One problem can set off more than one alarm. A gray LED means that 
the alarm has been disabled (Configure > Alarms > Control) or that the 
function it monitors is unavailable.

Note: Many monitoring forms have an Alarm status LED, which 
indicates whether the module has any active alarms.
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Monitoring the Base Station

Once you are logged on to a base station, you can monitor various aspects of it. 

To view a monitoring form

1. On the toolbar, click Monitor. The navigation pane displays a menu of 
options. 

2. In the navigation pane, click a subheading (for example ‘Reciter’).

The main part of the CSS window displays information relevant to the 
subheading.

Options To view the current status of all base station alarms, select Monitor > Alarms 
> Status.

To see what is happening at a base station interface, select an item under 
Interfaces.

To see what is happening inside a base station module, select an item under 
Modules.

To view the contents of a log that the base station has recorded, select an 
item under Data Logging.
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Viewing Configuration Settings

From the CSS, you can view a base station’s configuration settings. This 
information must be read after you have logged in to the base station. 

To view configuration settings

1. On the toolbar, click Read. 

The Reading dialog box displays progress.

2. On the toolbar, click Configure. The navigation pane displays a menu of 
options. 

3. In the navigation pane, click a subheading (for example ‘Channel Table’); 
the main part of the CSS window changes to display the corresponding 
form. 

In this way, you can view any aspect of the base station’s current 
configuration. 
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Diagnosing Problems

From the CSS, you can carry out a variety of tests on aspects of the base station 
you are logged on to. These can help you diagnose any problems you may be 
experiencing. 

To carry out a diagnostic test

1. On the toolbar, click Diagnose. The navigation pane displays a menu of 
options. 

2. In the navigation pane, click a subheading (for example ‘Self Tests’); the 
main part of the CSS window changes to reflect your selection. 

3. If the rectangle beside the Start Test button is yellow and gray, click 
Standby on the toolbar to put the base station in standby mode. 

4. Click Start Test. View the results of the test on-screen.

5. If necessary, click Stop Test.

6. Return the base station to Run mode. 
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Part C Basic Tasks

Before you can get down to the real work on a base station, you 
need to know how to carry out basic tasks such as setting up a 
connection, changing the base station’s mode, or reading 
configuration information. 

The Basic Tasks section explains in detail how to do these and 
other preliminary tasks. 

Topics

Using the Customer Service Software

Base Station Operations

Working with Configurations

CSS Tools

CSS Options
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Using the Customer Service Software

The following topics describe starting the CSS, the application window, the 
toolbar and the status bar. 

Starting the CSS
To start the CSS software, select Start > Programs > Tait Programming 
Applications > TB9100 CSS v2.02.00 > TB9100 CSS.

Application window
When you start the CSS, a splash screen appears, followed by the application 
window. 

By default, the Monitor icon on the toolbar is selected and the navigation pane 
gives you options for monitoring. When you click an item in the navigation 
pane, the main pane displays the corresponding form.

Toolbar
The toolbar gives you quick access to commonly used menu commands. For 
example, instead of selecting Functions > Configure, click the Configure icon 
on the toolbar.

Navigation pane

Status bar

Menu bar

Main pane

Toolbar
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Open Lets you open a configuration file that is stored on the CSS computer.

Save Saves the open configuration. When saving a configuration file for the first 
time, you are asked to give it a name. 

Connect Opens a dialog box that lets you connect to a base station. See also 
“Connecting” on page 28. If you are connected, this icon displays 
‘Disconnect.’ Click it to disconnect from the base station.

Read Reads in the configuration information of the base station you are connected 
to. See also “Working with Configurations” on page 34.

Program Sends the whole set of configuration information in the CSS to the base station. 
The base station must be in Standby mode. Once the configuration has been 
programmed, the base station operates using that configuration. See also 
“Working with Configurations” on page 34.

Standby Puts the connected base station into Standby mode. 

Run Puts the connected base station into Run mode. 

Monitor Displays the Monitoring navigation pane so that you can monitor the 
connected base station. See also “Monitoring the Base Station” on page 19.

Configure Displays the Configuration navigation tree, so that you can view and edit 
configuration information. If a configuration is not already selected, you are first 
given the option of creating a new configuration, opening an existing one, or 
reading the base station’s current configuration. See also “Viewing 
Configuration Settings” on page 20.

Diagnose Displays the Diagnose navigation tree, so that you can carry out diagnostic tests 
on the connected base station. See also “Diagnosing Problems” on page 21.

Alarms Turns red when any base station alarm is triggered. Click Alarms to display the 
current status of all base station alarms. See also “Monitoring Alarms” on 
page 141.

Privileges Displays your current privileges. If the icon is disabled, you have Guest 
privilege. If the upper key is yellow, you have Maintainer privilege. If the lower 
key is red, you have Administrator privilege. Click Privileges to change 
privileges. See “Changing Privileges” on page 46.

Help Displays a Help topic for the form you are currently in.
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Status Bar
The status bar provides you with useful information that supplements the 
display in the main pane.

 

Panels in the status bar provide the following: 

CSS status information, for example whether the CSS is reading or 
programming a configuration. ‘Ready’ means that the CSS has completed 
the last user request and is ready to respond to another request.

Flashing alarm icon (when an alarm is triggered).

The mode that the base station is currently in (Run or Standby).

Whether the CSS is connecting, connected, or not connected to a base 
station.

The IP address of the base station.

The name of the base station.

Connection status 
CSS status Current modeFlashing alarm icon Base station IP address

Base station name
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Base Station Operations

The CSS can connect to any base station in the TaitNet P25 network. Once 
connected, you can change the base station’s operating mode or its password. If 
the base station is not operating correctly, you can reset it. 

Connecting
Before you can work with a base station, you must connect to it. A connection 
establishes a communication session with the base station. Data can go back and 
forth, for example, to display monitoring information or to carry out a 
diagnostic test. However, a further step is necessary before you can work with 
configuration information: you must read the base station or open a 
configuration file, even to view the configuration forms.

To connect to a base station

1. Ensure that the CSS PC is connected physically to the base station. It can be 
connected by an Ethernet cable to a hub on the TaitNet P25 network or 
directly to the base station’s digital line. For the direct connection, an 
ordinary or a crossover Ethernet cable can be used; the digital line supports 
both. 

2. Ensure that the CSS PC has a suitable IP address and subnet mask. The 
network administrator can help you with this. You may need to vary the 
settings of your local area connection, depending on whether you are on site 
or in the office. See also “Connecting a Networked PC to a Base Station” 
on page 29. You may also need to tell the PC how to route to the TaitNet 
P25 network, see “Defining Routes for a Networked PC” on page 29.

3. Run the CSS software.

4. On the CSS toolbar, click Connect. The Connections dialog box appears 
and displays a list of base stations that you can connect to.

5. Click on the row with the base station name and IP address. If the base 
station is not in the list, click Edit Connections and add it. (See 
“Maintaining the Connection List” on page 39 for instructions).

6. Click Connect.

If the CSS does not know the base station password, you are asked to supply 
it. 
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If the base station is new, don't enter anything; just click OK. This is because 
base stations are supplied with a null password. (When you make subsequent 
connections, you will not be asked for a password, because the CSS now 
knows that the base station password is null.) 

If you want to set a base station password, wait till you are connected, and 
then select Element > Change Base Station Password. You can only set the 
password after you have connected to the base station. 

Once the connection is established, ‘Connected’ appears in the CSS status bar. 
If there is a connection icon in the system tray, it indicates whether there is any 
network traffic. Hovering the mouse over it pops up information about the 
connection speed and the number of packets sent and received. 

Note: The base station can only have a single CSS session at any one 
time. If you are connected, this prevents other CSS users from 
connecting.

Defining Routes for a Networked PC
You may need to define routes so that the PC uses the correct IP routing path 
to the TaitNet P25 network. Without a correct entry in the network routing 
table, the CSS will be unable to remotely connect to the base station. You can 
provide this using the ‘route’ command. The operating system Help gives 
assistance on the use of this command. 

To define a route

1. Select Start > Run.

2. Enter cmd.

3. At the command line prompt, enter route print. 

4. If the displayed list of persistent routes at the bottom of the output does not 
provide a route to the TaitNet P25 network, add one or more persistent 
routes in the format:

route -p add destination mask subnetmask gateway

For example: 

route -p add 172.16.16.0 mask 255.255.240.0 172.25.206.252

Connecting a Networked PC to a Base Station
You may want to temporarily disconnect a networked PC from its LAN in 
order to be able to establish a direct connection with the TB9100. A physical 
connection is needed as well as an alternate (Windows XP) or temporary 
(Windows 2000) IP address and subnet mask. 

To connect from a PC with Windows XP professional 

1. Remove the local area Ethernet connection and connect an Ethernet patch 
cable between the PC and the TB9100. (Either a straight through or 
crossover Ethernet patch cable may be used with the current TB9100 
software.)

2. Click Start > Control Panel.

3. Double-click Network Connections.

4. Double-click the Local Area Network icon.

5. Click Properties.

6. Click Internet Protocol (TCP/IP), and then click Properties.
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7. Click Alternate Configuration.

8. Select the User configured option, and then enter a number that is on the 
same subnet as the TB9100 base station. For example, if the TB9100 has IP 
192.168.1.254, enter 192.168.1.1 for the PC. 

9. Enter a suitable subnet mask, for example 255.255.255.0.

The CSS should now be able to connect to any physically connected base 
station that is on the same subnet.

10.When you have finished the CSS session, re-connect the local area network 
cable to the PC. The PC then uses its normal TCP/IP properties. 

To connect from a PC with Windows 2000

1. Remove the local area Ethernet connection and connect an Ethernet patch 
cable between the PC and the TB9100. (Either a straight through or 
crossover ethernet patch cable may be used with the current TB9100 
software.)

2. Select Start > Settings > Network and Dialup Connections.

3. Double-click the Local Area Connection icon.

4. Click Properties. 

5. Click Internet Protocol (TCP/IP), and then click Properties.

6. Note the current settings so that you can restore them later.

7. Select Use the following IP address, and then enter a number that is on 
the same subnet as the TB9100 base station. For example, if the TB9100 has 
IP 192.168.1.254, enter 192.168.1.1 for the PC. 

8. Enter a suitable subnet mask, for example 255.255.255.0.
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The CSS should now be able to connect to the base station.

9. When you have finished the CSS session, re-connect the local area network 
cable to the PC and then restore the original PC configuration. When you 
close the Network connection dialog box, the restored configuration is 
applied.

Troubleshooting Connection Problems
If your attempt to connect to a base station failed, consider these possible causes.

1. You have just switched the base station on and it is not yet ready. Try again.

2. Another CSS is connected to the same base station. A message is displayed 
indicating this.

3. Another CSS was connected to the same base station and the session did not 
complete properly. Wait one minute and try again.

4. You have just calibrated the base station. The base station is still in 
calibration mode and cannot respond to connection requests. Reset the base 
station.

5. You are attempting to connect to the wrong IP address. Check that you are 
using the correct IP address. 

6. The base station is not yet using the IP address you are attempting to 
connect to. A previous session changed the base station’s IP address. The 
base station configuration specifies the new address but the base station is still 
using the old IP address. Reset the base station. 

7. The link to the base station is down. Use ping to check.

8. A router on the link uses network address translation. You need to connect 
using the router IP address, not the base station IP address.

9. The firewall is blocking access to the base station. Ask the system 
administrator to give you access.
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Disconnecting
When you have finished working with a base station, click Disconnect on the 
toolbar. Alternatively, press F9 or select Element > Disconnect. You are now 
ready to connect to another base station.

If the base station is in Standby mode, you are reminded of this and asked to 
confirm that you want to proceed. This is to make sure that you do not 
inadvertently leave the base station out of service when you end a CSS session. 
You can select No to cancel disconnecting, and then change the base station’s 
mode back to Run before disconnecting. 

Changing Mode
Normally, the base station operates in Run mode. However, you must put the 
base station into Standby mode before you can carry out some functions. 

Run mode is used for normal operation. 

Standby mode takes the base station out of service. It is required if you want 
to program a configuration into the base station or carry out invasive 
diagnostic tests (for example to determine the lock range) on it. In Standby 
mode, the base station cannot repeat across its RF interface or send and 
receive on the digital line. This means that radios cannot talk to or hear each 
other. Dispatchers and radios also cannot talk to or hear each other. 
However, the control panel is still effective; the maintainer can talk to and 
hear radios. If the base station is in repeater mode, the maintainer can also 
talk to and hear any dispatcher connected to the analog line. 

When you end a CSS session and the base station is in Standby mode, you are 
asked to confirm. This is so that you do not inadvertently leave the base station 
out of service.

To put a base station in Standby mode

1. Connect to the base station.

2. On the toolbar, click Standby. You are asked for confirmation.

Once the base station has gone into Standby mode, the status bar displays 
the Standby icon. Functions such as programming a configuration into the 
base station are now enabled. 

To put a base station in Run mode

1. If necessary, connect to the base station.

2. On the toolbar, click Run. The base station is now fully operational.

If the base station cannot go into Run mode, the CSS displays an error code.

Error codes 1 and 2: Check to see which alarms are displayed and take 
appropriate action.

Error code 4: return the reciter to Tait.

Error code 10: The base station does not have the licenses that enable it to 
operate in Run mode. Obtain one or more licenses and use the Software 
Feature Enabler to let the base station operate in analog FM and/or digital 
P25 modes.
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Assigning a Base Station Password
Each base station can be given a password to safeguard access to it. A CSS must 
know the password before it is able to connect to the base station. If you do not 
give the base station a password, any CSS can connect to it. If you assign or 
change a password, users of other CSS PCs will need it before they can connect 
to the base station. 

To assign or change a base station password

1. Connect to the base station.

2. Select Element > Change Base Station Password. 

3. If requested, provide the Administrator access code. The Password - Base 
Station dialog box appears.

4. If you are changing an existing password, enter that password. Otherwise 
leave the Current password box empty.

Note: If you have lost the base station password, contact your Tait 
dealer. 

5. Enter the new password.

6. Re-enter the password in the next box.

7. Write down the new base station password and do not lose it: there is no 
other way to find out what a base station’s password is. 

8. Click OK to change the password and close the dialog box. The CSS sends 
the password to the base station and stores it in an encrypted form. It will 
use this password to authenticate itself when establishing a connection to the 
base station.

9. Inform any other CSS users of the password.

Resetting the Base Station
You can use the CSS to remotely reset the base station. This may become 
necessary if the base station stops functioning properly.

1. Select Element > Reset Base Station.

2. Wait for the base station to restart, and then connect to it again. If you 
attempt to connect before the control panel LEDs have been out for 10 
seconds, the attempt will fail.
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Working with Configurations

Base stations are programmed with many configuration settings. Using the CSS, 
you can view these settings, change them, and then program them into the base 
station.

Configuration works differently from other CSS functions. Once you are 
logged on, you can monitor the base station but you can’t yet view its 
configuration. First you must click the Read icon, which instructs the base 
station to supply its configuration information.

Programming the base station with a new configuration can only be done 
when the base station is in Standby mode.

It is a good idea to always save a configuration to file immediately before 
programming it into a base station. 

You can obtain configuration information from a base station, from a 
configuration file on disk, or from the default configuration template. 

Creating a New Configuration
You can create a new base station configuration from scratch, modify it, and 
save it as a new configuration. This means that you can define a configuration 
without being connected to a base station. This is a good way to learn how to 
use the configuration part of the CSS program. It also means that you can do 
all the work of configuring before a base station is delivered. When the base 
station arrives, you just open the configuration file and program it in. (This 
method completely overwrites the base station’s current settings.)

Figure 3: Obtaining and storing configuration information
File >

 N
ew

Base Station

Read

Program

On-Screen
Configuration
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To create a new configuration

1. Select File > New. 

The title bar displays Default.apt, indicating that the configuration is based 
on the default template and that you have not yet given the configuration a 
name and saved it. 

2. Click Configure in the toolbar and make the desired configuration 
changes. 

Reading a Base Station Configuration
Before you can view a base station’s configuration settings, you must read them. 

Note: Reading configuration settings overwrites any settings that the 
CSS has in memory. If you have opened a configuration file, save it 
first.

To read a configuration

1. Connect to the base station.

2. Click Read.

The CSS reads the base station’s configuration information. 

The Reading dialog box displays progress and gives you the option of 
canceling the process. 

When reading the configuration is complete, click Configure. You can now 
view the current configuration settings, make any configuration changes, and 
save the configuration settings to a file. You can also put the base station into 
Standby mode and program it with the new settings. 

Saving a Configuration
It is a good idea to regularly save your current configuration settings as you 
work on them. You should also save them just before you program them into 
a base station. In this way, you have a backup, in case the base station fails or its 
memory becomes corrupt.

To save configuration settings

1. After making any changes to configuration settings, click OK to confirm 
them.

2. Select File > Save or click Save.

If the configuration settings are already named, they are saved. If not, the 
Save Configuration File dialog box appears and you must continue as 
follows:

3. Enter a name for the configuration file into the File name box.
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4. If you want to save the configuration file somewhere other than in the 
Configurations folder, alter the default path.

5. Click Save. The name you provided appears on the title bar. 

Programming a Configuration into a Base Station
To change a base station’s configuration settings, you must make the changes 
using the CSS, and program them into the base station. Programming only 
affects the settings that you can view after clicking Configure.

To program a configuration into a base station

1. If you have made any changes to the current form, click OK to confirm 
them. 

2. Make sure that the current configuration settings displayed in the CSS are 
what you want.

3. Connect to the base station (if you aren’t already). 

4. Put the base station into Standby mode. 

5. Select File > Save to create a copy of the configuration settings as a file in 
the Configurations folder.

6. Click Program. 

7. If the configuration in the CSS has a different IP address or subnet mask to 
that of the base station, you are asked for confirmation. Click Overwrite to 
change the base station’s IP address or subnet mask. Click Keep Existing 
to program the configuration into the base station but keep the base station’s 
existing IP address and network mask. 

The Program dialog box appears and indicates the download progress. 
When the base station has successfully received all the configuration settings 
and programmed them in, the dialog box closes. 

If the download is not completely successful, programming is aborted and a 
message appears. Later, you can open the file you saved and try again. 

8. If you changed the base station’s IP address or subnet mask, reset the base 
station so that the new parameters take effect.

9. Return the base station to Run mode.

Synchronizing a Configuration File
Synchronizing a configuration file with the configuration on a base station 
makes sure that the file has the same settings as are in the base station itself. 

Tip: Synchronizing a configuration file is the quickest way to make 
a base station’s configuration available to the CSS.

To synchronize a configuration file

1. Select File > Open and open the configuration file for the base station.

2. Connect to the base station and click Read on the toolbar.

3. Save the file. 
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Handling Older Configuration Versions
If you read a base station configuration (or open a configuration file) and its 
version is older than the CSS, a warning appears. This is because the CSS and 
the base station communicate configuration and monitoring data based on a 
database with a defined structure. If the base station and the CSS have the same 
version, they share the same database structure. 

Generally speaking, it is best to use a CSS with the same version as the base 
station that you intend connecting to. Use an older CSS whose version matches 
the base station, or upgrade the base station firmware to match the CSS. 

If you continue to work with an older configuration, the following occurs.

Reading an older 
configuration

If you read a configuration from an older base station:

The CSS displays new data items and gives them default values.

The CSS cannot display data items that have been subsequently removed. 
You cannot view or change them. 

Programming If you program this configuration back into the base station, the following 
occurs.

The base station cannot store or use new items. They are ignored. 

Data items that are no longer supported by the new CSS remain unchanged. 

If you save the configuration, the CSS saves it in the new configuration version. 

Handling Newer Configuration Versions
If you read a base station configuration (or open a configuration file) and its 
version is newer than the CSS, a warning appears. This is because the CSS and 
the base station communicate configuration and monitoring data based on a 
database with a defined structure. If the base station and the CSS have the same 
version, they share the same database structure. 

Generally speaking, it is best to use a CSS with the same version as the base 
station that you intend connecting to. Install the new CSS and use it; you can 
have many different CSS versions on your PC at the same time. 

If you continue to work with a newer configuration, the following occurs.

Reading a newer 
configuration

If you read a configuration from a newer base station: 

The CSS cannot display new data items.

The CSS displays data items that the base station no longer supports and 
gives them default values. 

Programming If you program this configuration back into the base station, the following 
occurs.

The base station cannot store or use the data items that it no longer supports. 
They are ignored. 

New data items remain unchanged.

If you save the configuration, the CSS saves it in the old configuration version. 
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Working With Different Base Station Options

There are many variants of the TB91900 base station, consisting of different 
combinations of its modules. The following gives some guidance on how the 
different combinations affect the use of the CSS. For information about these 
base station options, see the TB9100 Installation and Operation Manual. 

Base Station With 
External Power 
Supply

When a base station is used with a third-party external power supply, a PMU 
is not required. The Alarm Status form will report ‘No PMU detected.’ You 
can disable this alarm (Configure > Alarms > Control). This stops the control 
panel alarm LED flashing because of this alarm. You can edit power 
configuration settings (Configure > Base Station > Miscellaneous) but these 
have no effect. PMU control tests also have no effect.

Receive-Only 
Base Station

A receive-only base station has no PA and the reciter has no Transmit enable 
license. The Alarm Status form will report ‘No PA detected.’ You can disable 
this alarm and all other PA alarms (Configure > Alarms > Control). This stops 
the control panel alarm LED flashing because of this alarm. PA control tests 
have no effect.
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CSS Tools

The Tools menu gathers together less commonly used operations.

Maintaining the Connection List
Select Tools > Connections to open the Connections List dialog box. This is a 
simple text editor that lets you maintain the list of base stations that the CSS can 
connect to. This list is stored in the host information file (conncfg.dat).

To add a base station to the list

1. Select Tools > Connections.

2. In the Connection List, enter the name of the base station and its IP address. 
Make sure that the same base station name is programmed into the 
corresponding base station (Configure > Digital Line > Network Identity). 
Your entry should have the following format:

Base station name = 172.25.206.26

3. If desired, copy the file containing the connection list to all your PCs that 
run CSS.

Alternatively, you can use any text editor to edit the file.   

Firmware Download
You can use the CSS to update the firmware of base station modules. This is a 
two-stage process. First the CSS downloads the firmware to the base station 
(this can be done in Run mode and does not affect base station operation). 
Then the base station takes itself out of service and activates the downloaded 
firmware. After activation, the base station resets itself. 

The base station is supplied with all necessary firmware, but it may become 
desirable to upgrade to a newer version. It is also possible to downgrade a 
module to an older firmware version to ensure compatibility with other base 
station modules. The CSS makes sure that the new firmware will not lead to 
incompatibility between firmware and hardware or between modules.

Firmware Download Form
The Firmware Download form (Tools > Firmware Download) displays 
information about the versions installed on the base stations and in the set of 
firmware that you select. It lets you initiate a download and monitors its 
progress.

Download
The Download area lets you select a set of firmware for downloading. It displays 
information about the firmware in the selected set and the hardware that it is 
compatible with.
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The list box lets you select a set of firmware. The drop-down list displays the  
available firmware sets. (The CSS looks for firmware files in the folder specified 
by Options > File Folders.)  

The rest of the Download area displays version numbers of the individual items 
of firmware in the selected set: Network board, digital board, power amplifier, 
and power management unit. It also shows the versions of hardware that the 
firmware can work with. 

When you install the CSS, firmware for the different base station modules is 
copied into a folder that different CSS versions can access. A compatibility file 
is also copied over. Firmware versions are also available from the Tait support 
website. 

Firmware The version of the firmware in the set of firmware that you selected. ‘Loaded’ 
instead of a version number means that the firmware version in the selected set 
is the same as the firmware version already installed in the connected base 
station.

Kernel The version of the network board’s operating system kernel that is required for 
working with the network board firmware. A ‘-’ means that there is no 
particular kernel version required. ‘Loaded’ means that the kernel version 
required is present on the connected base station. A red verion number means 
that the kernel version installed on the connected base station is incompatible 
with the network board firmware in the firmware set you selected. To upgrade 
the kernel, follow the instructions in TN-977b. This also upgrades the network 
board firmware. 

Required 
hardware

The range of version numbers of hardware that is compatible with the 
corresponding firmware. Version numbers below the minimum or above the 
maximum displayed are not compatible.

If the version numbers are displayed in red, the firmware version in the selected 
set is incompatible with the hardware or kernel version of the connected base 
station. You are unable to download.

Force download When the Force download check box is selected and you click Download, all 
firmware files in the set are downloaded. When the check box is cleared, 
firmware files that display ‘loaded’ are not downloaded.  

Installed Versions
The Installed Versions area displays the version numbers for firmware, kernel, 
and hardware that are currently installed in the connected base station. It also 
displays the serial numbers of each module. 
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Downloading Firmware
A set of firmware files is copied into the CSS’s Firmware Files folder at 
installation. More recent firmware can be obtained from the TaitWorld support 
site. You need to copy the file containing the set of firmware (firmware.exe) to 
the Firmware Files folder (the default location is C:\Program Files\Common 
Files\Tait Programming Applications\TB9100 CSS\Firmware Files) and run it 
to extract the individual firmware files.

Important: Save a backup copy of the base station configuration 
before downloading firmware. You will need this if the firmware 
download does not successfully complete on the first attempt.

To download new base station firmware

1. Run the CSS software and connect to the base station. 

2. Read the base station’s configuration and save it to a file, so that if necessary, 
you can restore it manually (see “Manually Updating the Configuration” on 
page 42).

3. Select Tools > Firmware Download. The Firmware Download dialog box 
appears. 

The CSS obtains information about the base station’s modules and displays 
it in the Current versions area. 
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4. Under Download, select the firmware file set you want to download. The 
version numbers of each firmware item in the set appear in the Download 
area. If the firmware item is already downloaded and activated, its display is 
disabled and shows ‘Loaded.’ 

5. If Required hardware version numbers appear in red, the selected firmware 
is incompatible with the base station’s current hardware. You cannot 
download the firmware.

6. If the Kernel version appears in red, you must first update the kernel. For 
instructions, see TN-977b.

7. If you want to download all items in the firmware file set, even if they are 
the same version as the firmware already on the base station, select the 
Force download check box.

8. Click Download. 

The CSS downloads firmware for the modules you selected. This is a 
background activity and can proceed while the base station is in Run mode. 
The bottom of the dialog box indicates progress.

The base station sends its configuration to the CSS, which temporarily stores 
it. The base station then goes into Standby mode and activates the 
downloaded firmware by programming it into flash memory. The base 
station resets itself. The CSS waits 30 seconds for the base station to get up 
and running, then re-establishes the connection and loads the stored 
configuration back into the base station, adding any new data items used by 
the new firmware. The base station then begins operating with the new 
firmware and returns to Run mode.

Note: If the activation of a module fails, an alert informs you of this. 
If you have no backup of the current configuration, contact your 
Tait dealer. If you do have a backup, you can repeat the download 

procedure. When that is completed, you must manually restore the 
configuration, see “Manually Updating the Configuration” on page 42.

9. Re-open the Firmware Download form and verify that the base station has 
the new firmware versions. 

10.Check the Release Notes for new data items added by the firmware 
upgrade. New data items are given default values designed to give safe, 
expected behavior, but in particular systems they may have undesirable 
effects. Check that they are appropriate and change them if necessary. 

11.Save the configuration (do not overwrite the old configuration file) and 
program it back into the base station. 

Manually Updating the Configuration
If you needed to repeat the download procedure, the base station’s 
configuration is probably unusable and must be restored from backup. 

1. Using the new CSS, open the backed-up configuration file. The CSS adds 
any new data items to the configuration, so that its database structure 
matches that of the new base station firmware. 

2. Check the default settings of any new data items (information in the Release 
Notes) and change any that do not suit your system. 

3. Save the configuration (do not overwrite the old configuration file) so that 
you have a backup and program the configuration back into the base station. 
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Working with the Software Feature Enabler
The software feature enabler (Tools > Software Feature Enabler) lets you 
enable additional features in the TB9100 base station you are connected to. The 
base station already has these features but it needs license keys to enable them. 
Each base station requires a unique license key for each feature. A license key 
for one base station cannot be used in another. The software feature enabler also 
displays the status of all features and lets you disable any that are enabled.

The form displays the name and reciter serial number of the base station you are 
connected to. Each row in the table displays information about a feature: the 
Feature code used to order a feature, its name, and whether it is enabled or 
disabled. The Seq column indicates how many times it has been enabled or 
disabled. 

Determining the Feature Licenses You Need
To determine which feature licenses a base station requires, apply the following 
rules (full details are in the table below).

1. The base station must have a default radio system license. 

2. If the base station will carry digital P25 speech over its RF interface, it needs 
a P25 common air interface license.

3. The base station needs a transmit enable license, unless it is receive-only.

4. If the base station will be networked with other base stations to form a 
channel group, it needs a digital line license.

5. If the base station uses its analog line and will carry digital P25 speech, it 
needs an analog line license. In this case, it also needs an MDC1200 signaling 
license (if the console system uses that type of signaling) and a base 
encryption license (if the analog line is an encryption/decryption point). 

To determine which feature licenses an analog gateway requires, apply the 
following rules.

1. The analog gateway must have a default radio system license and a digital 
line license. 
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2. If the analog gateway will carry digital P25 speech, it needs an analog line 
license. It also needs an MDC1200 signaling license (if the console system 
uses that type of signaling) and a base encryption license (if the system uses 
encryption). 

Enabling Additional Features
If you want a feature, obtain a license key from Tait for that feature, and then 
use the CSS to enable it.

To license a feature

1. Connect to the base station.

2. If you received the license key in a license file, copy that file (and any others 
that you received for other features or other base stations) to the CSS’s 
license file folder (select Options > File Folders to see which folder the CSS 
uses).

3. Go into Standby mode, and then select Tools > Software Feature Enabler. 

4. Click the feature to select it.

5. If you received a license file, click Find License File. This searches the 
license file folder for a license file for the current base station and the selected 
feature. If the CSS finds one, it displays the license key (in the feature’s row 
and in the Feature License Key boxes), and increments the Seq column by 1. 

Feature License
Affected 
Interfaces

License Required for the Service?

Analog 
FM

Digital 
P25

TSBK
User 
Data1

Tone 
Remote

External 
Trunking

Default radio system2 All Y Y Y Y Y Y

P25 common air 
interface2

RF N Y N Y Y Y

Analog line3 Analog line N Y N n/a N n/a

Digital line Channel group Y Y Y N Y Y

Networked user data4 Data gateway n/a n/a n/a Y n/a n/a

MDC12005 Analog line n/a n/a Y n/a n/a n/a

Transmit enable RF Y Y Y Y n/a Y

Base encryption6 Analog line N Y N n/a n/a N

AES encryption7 Analog line N Y N n/a n/a N

External trunking8 Digital line N N N n/a n/a Y

1.A user data service is not yet available
2.The base station or analog gateway cannot go into Run mode unless it has a default radio system license or a 

P25 common air interface license.
3.Applies to digital P25 speech only. 
4.Not yet available. This license will determine whether the base station supports wide area data repeat and data 

gateway functionality. It is independent of the channel group license.
5.Determines whether ANI and the conversion between MDC1200 and TSBKs is supported.
6.Required for encryption at the analog line interface. Enables DES encryption and decryption. 
7.Enables AES encryption in conjunction with the Base encryption feature license.
8.Only available for operation with external trunking equipment.
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6. If you don’t have a license file, enter the license key into the Feature License 
Key boxes.

7. Click Enable. A ‘Feature enabled’ message appears. The license key appears 
in the feature’s row and the Seq column is incremented by 1.

Disabling a Feature
Features are not normally disabled. However, disabling may be desirable in 
special circumstances, for example, if you are trying out the feature and decide 
not to purchase it. 

Important: A disabled feature can only be re-enabled by purchasing 
a new license key. The original feature license key cannot be re-
used. 

Before disabling a feature, make sure that the base station configuration does not 
use it. Once a feature is disabled it does not work, even if you enable it in the 
CSS. 

If the base station configuration requires a function but the software feature 
enabler has disabled it, a syslog message will be generated when the base station 
attempts to implement the function. For example, if you disable the P25 
common air interface, but use a calling profile that tells the base station to 
handle dispatcher calls as digital P25 calls, the dispatcher will be unable to make 
calls. Each attempt produces a syslog message. 

To disable a feature

1. Connect and log on to the base station with the Administrator access level.

2. Go into Standby mode, and then select Tools > Software Feature Enabler. 

3. Check the Reciter Serial Number box to make sure that you are logged 
on to the correct base station.

4. Click the feature’s row. 

5. Click Disable.

The progress bar indicates how far the disabling has progressed. On 
completion, a new number appears in the Feature License Key column. 
Communicate this new number to Tait if you are entitled to a refund or if 
you want to re-enable the feature. 

Working with Privileges
If access codes have been set, you must enter an access code to obtain the 
Maintainer or the Administrator privilege before you can carry out some 
functions. From the toolbar you can change privileges. Only the Administrator 
can change access codes. 

Obtaining a Privilege
If you request a function that you don’t currently have the privilege for, the 
Access Code Required dialog box appears, prompting you for an access code. 
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1. Enter the access code for the required privilege.

2. Click OK. The Privileges icon on the toolbar indicates the privileges you 
now have. A yellow key indicates Maintainer privilege. A red key indicates 
Administrator privilege. 

Changing Privileges
The Privileges dialog box indicates which privileges are currently active and lets 
you enable or disable them. You may, for example, have enabled Administrator 
privilege in order to change a base station password, but now you want to 
return the CSS to Guest privilege, because a number of people have access to 
the CSS. The Guest privilege is always enabled and cannot be disabled.

If a row is disabled, the privilege has no access code and you automatically have 
this privilege. If you want the privilege to be controlled by an access code, select 
Tools > Change Privilege Access Codes. 

To enable a privilege

1. On the toolbar, click Privileges.

2. Select the check box of the privilege you want to enable.

3. Alongside the check box, enter the corresponding access code.

4. Click OK. 

To disable a privilege

1. On the toolbar, click Privileges.

2. Clear the check box of the privilege you want to disable.

3. Click OK. 
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Setting up and Changing Privilege Access Codes
If access codes have not been set up, CSS users automatically have all privileges 
and they are not asked for access codes. If you want to increase security, you 
can set up access codes simply by entering them as described below. 

If access codes have been set up (for example during installation), you can 
change them with Administrator privilege. 

To set up or change an access code

1. Select Tools > Change Privilege Access Codes. 

2. If the Access Code Required dialog box appears, supply the current 
Administrator access code. The Change Privilege Access Codes dialog box 
appears.

3. In the Privilege box, select the privilege whose access code you want to set 
up or change.

4. In the New access code box, enter the new access code.

5. In the Confirm new access code box, enter the same code again.

6. Click OK. 
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CSS Options

The Options menu lets you configure aspects of the CSS software.

Temperature Display
The CSS can display temperature in degrees Fahrenheit or Celsius. 

Select Options > Settings and select the option you prefer. 

File Folder Locations
The Default file locations area (Options > File Folders) specifies folders for 
configuration files, log files, license files, and firmware files. To modify a default 
location, click the button to the right of the box and select a folder.

Configuration 
files

When you save a configuration file for the first time, the folder specified in the 
Configuration files box is shown in the dialog box. You can select another 
folder if you want. (You already chose a folder for configuration files during 
installation.) 

Firmware files Specifies where the CSS will look for firmware files when you ask it to 
download new firmware into a base station. If you receive new firmware for a 
base station upgrade, copy it to this folder.

License files Specifies where the CSS will look for license files when you ask it to enable 
additional features in a base station. If you receive a license file, copy it to this 
folder.
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Part D Monitoring

The CSS lets you monitor the TB9100 base station. It can provide 
operational information about the various interfaces and 
modules. The CSS can also display data logs and details about 
the hardware and software of installed modules. Monitoring can 
take place while the base station is in Run mode; it has no effect 
on base station operation.

For information about monitoring alarms, see “Alarms” on 
page 139. For information about monitoring Task Manager, see 
“Monitoring Task Manager” on page 205.

To monitor a base station, connect to it, click Monitor, and 
select an item from the navigation pane. 

Interfaces

Monitoring the RF Interface

Monitoring the Digital Line

Monitoring the Analog Line

Modules

Monitoring the Reciter

Monitoring the Power Amplifier

Monitoring the Power Management Unit

Data Logs

Viewing Call Records

Viewing the System Log

Viewing the Trace Log

Viewing Call Statistics

Viewing the CSS Application Log

Module Details

Viewing Reciter Information

Viewing Power Amplifier Information

Viewing Power Management Unit Information
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Interfaces

The CSS can monitor the base station’s interfaces. You must be connected to 
that base station. 

Monitoring the RF Interface
The RF Interface form (Monitor > Interfaces > RF Interface) shows you what 
the base station is currently doing. It displays:

Details about the channel that the base station is currently operating on

Operational information about the receiver

Operational information about the transmitter

Current Channel
The Current channel area shows you which channel the base station is 
operating on and displays its main configuration settings. The choice of channel 
is the result of Task Manager action. If the channel name is Invalid channel, 
Task Manager has told the base station to operate on a channel that does not 
exist. 

To view additional settings defined by the channel, look in the channel table 
(Configuration > Base Station > Channel Table) and in the profiles assigned to 
the channel.

Receiver
In the Receiver area, you can check that the receiver is enabled, see whether it 
is gated, and view information about the NAC or subaudible signaling. You can 
also view the RSSI, SINAD, and the digital P25 signal quality (EVM or BER). 

Status If the Status box displays Enabled, the receiver is able to function. If it displays 
Disabled, look at the items to the right to see what the problem is.
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Note: It is possible in the configuration to disable the receiver (in the 
channel profile, clear both the analog and the digital receiver 
modes). This is not reflected in the status display, which still shows 
‘Enabled.’

Gated When the Gated LED is green, the receiver has unmuted; a valid signal is being 
received. The LEDs alongside indicates whether that signal is analog FM or 
digital P25. 

NAC The two NAC boxes display the NAC that the receiver is configured with and 
the current or most recently received NAC. Alongside the Received NAC 
box, an LED tells you the following.

If the Lock padlock is locked, the receiver will unmute irrespective of the 
received signal’s NAC. Task Manager has locked the decoding of subaudible 
signaling and the NAC.

Subaudible The two Subaudible boxes display the configured and the received CTCSS 
tone or DCS code. The configured tone or code is specified in the signaling 
profile for the current channel. The receiver can only detect a CTCSS tone if 
it is the same as the configured one, but it can detect any DCS code. The form 
displays what the receiver is currently receiving (or has just received). 

Alongside the Received box, an LED tells you the following about the 
received tone or code.

Item Status Meaning

Lock Locked Task Manager has locked the receiver. The receiver 
cannot operate.

Valid channel Red The currently selected channel does not exist or is 
corrupted. 

Synthesizer 
locked

Flashing 
Red

The receiver is unable to operate on the configured 
frequency. 

LED Color Meaning

Green The receiver has detected a matching NAC. 

Red The receiver has detected a NAC that is different from the 
one it is configured to receive. 

Gray The receiver is not currently detecting a NAC.

LED Color Meaning

Green The receiver has detected a valid code or the particular tone that it 
is configured to recognize.

Gray The receiver is not currently detecting any subaudible signaling.
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If the Lock padlock is locked, the receiver will unmute irrespective of the 
received signal’s CTCSS tone or DCS code (and the received NAC). Task 
Manager has locked the decoding of subaudible signaling and the NAC.

RSSI The RSSI gauge displays the current strength of the received signal in dBm. 
The equivalent numeric value appears under the gauge heading. If this value is 
red, it exceeds the maximum or has fallen below the minimum that the gauge 
can display. A pointer indicates the configured threshold for opening the 
receiver gate. 

SINAD The SINAD gauge displays the signal-to-noise ratio of the received signal in 
dB. The equivalent numeric value appears under the gauge heading. If this 
value is red, it exceeds the maximum or has fallen below the minimum that the 
gauge can display. A pointer indicates the configured threshold for opening the 
receiver gate.

EVM Click EVM and the box to the right displays the error vector magnitude of the 
received signal. This ranges between 200 (high quality) and 1000 (low quality).

BER Click BER and the box to the right displays the estimated bit error rate of the 
received signal, expressed as a percentage.

Transmitter
In the Transmitter area, you can check that the transmitter is enabled, see 
whether it is keyed, view information about the NAC and the subaudible 
signaling, and see the source of what is being transmitted. You can also monitor 
the forward and reverse power. 

Status If the Status box displays Enabled, the transmitter is able to function. If it 
displays Disabled, look at the items to the right to see what the problem is.

Item Status Meaning

Lock Locked Task Manager has locked the transmitter. The 
transmitter is unable to function.

Valid channel Red The currently selected channel does not exist or is 
corrupted. 

Synthesizer 
locked

Flashing 
Red

The transmitter is unable to operate on the configured 
frequency. 
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Note: It is possible in the configuration to disable the transmitter 
(clear the RF transmit check box). This is not reflected in the status 
display, which still shows ‘Enabled.’

RF repeat When the RF repeat LED is green, the base station will repeat the channel 
group’s winning RF signal, which is not necessarily the RF signal received by 
this base station.

When the RF repeat LED is gray, the base station’s RF repeat setting is 
currently disabled.

The box alongside indicates what last changed the RF repeat setting.  

PA keyed When the PA keyed LED is green, the transmitter is transmitting; carrier is 
present. The LEDs alongside indicate whether that signal is analog FM or digital 
P25. 

The PA keyed LED turns green because one of the following occurs:

A call (the Transmitting source LED is green and the Voter box indicates 
the origin of the call)

A CWID transmission (CWID LED is green)

A transmit tail (Tail LED is green)

The Carrier button on the control panel has been pressed 

NAC The two NAC boxes display the NAC that the transmitter is configured with 
and the NAC that the transmitter is currently transmitting or has most recently 
transmitted. The configured NAC is specified in the signaling profile for the 
current channel. 

Subaudible The two Subaudible boxes display the CTCSS tone or DCS code that the 
transmitter is configured with and the CTCSS tone or DCS code that the 
transmitter is currently transmitting or has most recently transmitted. The 
configured tone or code is specified in the signaling profile for the current 
channel.

If the Lock padlock is locked, the transmitter does not send any subaudible 
signaling. Task Manager has locked the encoding of subaudible signaling.

Transmitting 
source

The Transmitting source LED is green if the transmitter is transmitting signal 
from a user. The Voter box shows where the signal came from. 

Reason Description

Config The configuration changed the setting. This occurs when the 
base station last changed channel. 

Task Mgr Task Manager action (Enable/Disable/Toggle RF repeat) 
changed the setting. This can only happen if the channel table 
puts RF repeat under dispatcher control. Such Task Manager 
actions are usually triggered by a dispatcher command.

Control channel Trunking operation changed the setting. Beginning to operate 
as a control channel disables RF repeat. Ceasing to operate as 
a control channel (and therefore operating as a traffic channel) 
causes the base station to use the RF repeat setting in the 
channel table). 
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CWID The CWID LED displays green when the base station is currently transmitting 
its CWID.

Tail In analog FM mode, the Tail LED displays green when the base station is 
transmitting its tail. This consists of the hang time (subaudible signaling but no 
audio) followed by the soft-off time (carrier only).

Forward power Displays the measured forward power of the PA output. Click Watts or dBm 
to select the units used. 

Reverse power Displays the measured reverse power of the PA output. Click Watts or dBm 
to select the units used.

VSWR Displays the Voltage Standing Wave Ratio of the PA’s RF output. 

Monitoring the Digital Line
To help in troubleshooting, the Digital Line form (Monitor > Interfaces > 
Digital Line) monitors operation that is related to the digital line. You can use 
the form for the following: 

Checking channel group settings when installing the system

Observing voting operation during coverage tests

Measuring network jitter when setting the transmit preamble

Troubleshooting network link problems

The form displays information about the whole channel group, not just the base 
station you are connected to. 

The following topics aim to help you get the most out of this useful form. Each 
describes how to monitor one operational aspect, even though all aspects are 
inter-related. A final topic gives reference information that is not already 
covered by previous topics. 

Display Description

FM - Line An analog FM call received over the analog line

FM - IP An analog FM call received over the digital line from another 
base station in the channel group The adjacent box displays 
the IP address of that base station.

FM - RF An analog FM call received over the air interface

FM - Panel An analog FM call received from the control panel microphone

P25 Voice - Line A digital P25 call received over the analog line

P25 Voice - IP An digital P25 call received over the digital line from another 
base station in the channel group The adjacent box displays 
the IP address of that base station.

P25 Voice - RF An digital P25 call received over the air interface

P25 Voice - 
Panel

An digital P25 call received from the control panel microphone

P25 Data A digital P25 data call.
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Checking Channel Group Settings
If the system is not behaving as expected, check the channel group settings.

1. Select Monitor > Interfaces > Digital Line. 

2. Under Software feature enable, check that the channel group box is 
checked. If not, the base station has no channel group license and is unable 
to be part of a channel group.

3. Confirm that the expected channel group is in use. The base station uses the 
channel group that is assigned to the current channel.

4. Under Current channel group, check the settings displayed. These are a 
subset of the settings in the Channel Groups dialog box (Configure > Digital 
Line > Channel Groups and click Edit).

5. Check the padlock symbol. If it is closed, Task Manager has locked channel 
group communications and the base station will not send anything to or 
receive anything from the channel group.

6. In the members table, check in the row for ‘localhost’ that the settings for 
channel group mode, RF repeat, and common uplink are as you want. 
These are additional channel group settings for the connected base station.

Check also that these settings are the same in all rows of the table. All mem-
bers of the channel group should have the same settings. 

Monitoring the Network Link
To monitor the base station’s network link to other channel group members, 
select Monitor > Interfaces > Digital Line and view the Quality of Service area.

This area displays quality of service values for the current voice stream(s). 

The Incoming boxes display values for the voice stream that the digital line is 
receiving. 

The Outgoing boxes display the worst set of outgoing values. When the digital 
line sends a voice stream, each other member of the channel group receives it 
and measures its quality of service. These measured values are sent back to the 
connected base station using RTCP and made available to the CSS. The 
Outgoing boxes show only the worst values. 

If the channel group is duplex, incoming and outgoing data can appear at the 
same time.

Jitter The delay variation of RTP packets arriving at the connected base station 
(Incoming) or other channel group member (Outgoing). A high jitter is a sign 
that the network is congested.

Packet loss (per 
call)

The number of packets lost in an over. Packet loss should be rare. Users will 
not notice a loss of up to 10 packets. Packet losses may be caused by inadequate 
linking bandwidth, cable faults, or power cycling of the switch or router.
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Average loss The average number of packets lost per second. Packet losses should be rare. 
Frequent packet loss indicates that there is something wrong with the linking 
infrastructure.

Monitoring the Transmit Buffer
If the jitter on the incoming voice stream is high, the transmit buffer may not 
be able to cope. To check the buffer, select Monitor > Interfaces > Digital Line 
and view the Transmitter area.

Initial delay The configured length of time in milliseconds that the transmitter waits before 
beginning to transmit voice. This is the preamble duration that you set in the 
Network form (Configure > Digital Line > Network). If the base station 
transmits TSBKs, it uses a preamble duration of 100 ms and the display updates 
to reflect this. 

Underflow (last 15 
minutes)

The percentage of packets during the last 15 minutes that arrived late enough 
to cause a buffer underflow. If too many buffer underflows occur, the preamble 
should be lengthened (see “Configuring the Jitter Buffer” on page 112). 

Underflow (worst 
15 minutes)

The highest percentage of packets during any 15 minute period in the last 24 
hours that arrived late enough to cause a buffer underflow. If too many buffer 
underflows occur, the preamble should be lengthened (see “Configuring the 
Jitter Buffer” on page 112).

Monitoring Channel Group Network Links
The members table in the Digital Line monitoring form (Monitor > Interfaces 
> Digital Line) displays information about the network links to each member 
of the channel group. Members are identified by IP address but the base station 
you are connected to is ‘localhost.’ 

Jitter The delay variation of RTP packets as they arrive at the channel group 
member. This value should be zero if the member is the vote winner. 
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Packet Loss The number of packets lost on the link to the member during the last over. 
Packet loss should be rare. Users will not notice a loss of up to 10 packets. 
Packet losses may be caused by inadequate linking bandwidth, cable faults, or 
power cycling of the switch or router.

Average Loss The average number of packets lost per second. Packet losses should be rare. 
Frequent packet loss indicates that there is something wrong with the linking 
infrastructure.

Monitoring Duplex Voting
The members table in the Digital Line monitoring form lets you monitor the 
distributed voting carried out by the members of the channel group. If the 
channel group mode is duplex, there can be two vote winners at the same time; 
one for the inbound and one for the outbound voice stream.

To monitor voting in a duplex channel group

1. Select Monitor > Interfaces > Digital Line and view the members table. 

2. Check in the BS mode column that all members are in Run mode. A base 
station in Standby mode does not participate in voting.

3. Check that all members of the channel group are present. If a member is 
absent, its link may be down.

4. Look for the green cells in the Inbound and Outbound columns. They 
indicate which member won the vote. 

Data in other rows indicates other voice streams that lost the vote. If there 
is a common uplink frequency, this shows which other base stations are also 
able to provide coverage. 

5. If desired, check to confirm that the voter is operating as expected.

For the Inbound voice stream:

Type P25 always wins over type FM

The lowest impairment wins the vote, if the streams have the same type.

For the Outbound voice stream:

Type P25 always wins over type FM

Microphone always wins over Line (control panel microphone wins 
over analog line)

In the above example, the green cells in the Outbound columns indicate that 
the analog line of the first channel group member is providing the outbound 
signal. The green cells in the Inbound columns indicate that a P25 call received 
by the second member is providing the inbound signal. 
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Monitoring Simplex Voting
The members table in the Digital Line monitoring form lets you monitor the 
distributed voting carried out by the members of the channel group. If the 
channel group mode is simplex, there can only be one vote winner at the same 
time. That vote winner is sent on the inbound and the outbound voice streams. 

To monitor voting in a simplex channel group

1. Select Monitor > Interfaces > Digital Line and view the members table. 

2. Check in the BS mode column that all members are in Run mode. A base 
station in Standby mode does not participate in voting.

3. Look for the shaded row. This indicate which member won the vote. 

Data in other rows indicates other voice streams that lost the vote.

4. If desired, check to confirm that the voter is operating as expected.

Type P25 always wins over type FM

Outbound calls (Microphone or Line) win over Inbound calls

The lowest impairment wins the vote, if the streams have the same type.

The green cells in the above screen indicate that localhost has won the vote. 
The call it is receiving is P25 and has an impairment of 2. The second member 
of the channel group is also receiving a P25 call, but it has a higher impairment. 
The green cells cover both the Inbound and the Outbound columns, because 
there is only one winning voice stream in simplex channel groups. 

Monitoring Trunking Operation
If the base station is connected to a trunking site controller, you can monitor its 
trunking operation as follows:

1. Select Monitor > Interfaces > Digital Line.

2.  Under Software feature enable, check that External trunking is enabled. 
If not, the base station needs an External trunking feature license.

3. Under External trunking controller, the Connected LED indicates 
whether the base station is receiving heartbeat messages from the trunking 
site controller. The area displays the trunking site controller’s IP address and 
the port number that the base station is configured to use when it sends 
messages to the trunking site controller.

4. If the Control channel LED is lit, the base station is receiving TSBKs from 
the site controller. 

5. If the Control channel LED is gray, the base station is able to send and 
receive voice packets. It will do this to/from the IP address and port that is 
displayed under Current channel group. 
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Digital Line Form Details
This topic describes details on the Digital Line Form that are not covered by 
the task-based topics involving this form.

Software feature enable
The Software feature enable area (Monitor > Interfaces > Digital Line) 
indicates which software licenses the base station has that are relevant to the 
digital line. 

Channel group Indicates whether the base station has a digital line license. Without this license, 
voice cannot be sent and received across the digital line.

External trunking Indicates whether the base station has an External trunking license. This license 
enables communications with an external site controller using the TCCP 
protocol. 

External trunking controller
The External trunking controller area (Monitor > Interfaces > Digital Line) 
provides monitoring information when the base station is part of a trunking 
system.

Current channel group
The Current channel group area (Monitor > Interfaces > Digital Line) displays 
information about the channel group that the base station currently belongs to. 
Additional details are found in the members table for the row ‘localhost’ under 
the columns CG Mode, RF repeat, and Common uplink frequency. 

Name The name of the current channel group.

IP address The IP address (normally multicast) of the current channel group. The base 
station’s digital line sends voice streams to this address and (if the address is 
multicast) receives voice streams that have this address. 

Lock If the padlock is locked, Task Manager has locked the channel group. The base 
station does not participate in the channel group.

Speech transport If Analog FM is selected, the digital line can send analog FM voice streams to 
the other base stations in the channel group. If Digital P25 is selected, the 
digital line can send digital P25 voice streams. 

Port The port that channel group uses for communications to and from the digital 
line.
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Members Table
The table at the bottom of the Digital Line form differs from other CSS 
monitoring forms in that it functions more as a network monitor than a base 
station monitor. The table displays information for each member of the channel 
group: voting, quality of service, and channel group configuration.

The following example shows how this information is made available to the 
CSS. BS1 wins the vote and supplies the voice stream to BS2 and BS3. Using 
the RTCP protocol, BS2 supplies BS3 and BS3 supplies itself with quality of 
service information about the voice stream that they have just received.

Green cells indicate which member is providing the vote-winning voice 
stream. As that base station provides the voice stream directly, its quality of 
service data is perfect. The rows for the other base stations show quality of 
service data for the voice stream they receive. BS3 obtains via RTCP quality of 
service information about the voice streams that the other base stations 
received.

Note: It’s not unusual for this table to briefly show two vote winners 
for the same (inbound or outbound) stream, or no vote winner at 
all. This is a transient artifact of the monitoring process (delays 

around the network and the slow update rate of the CSS monitoring screen) 
and does not indicate problems with voting. Do not rely on the table to give an 
accurate picture of the network operation for timescales of less than a second. 

Member The IP address of one of the members (base station or analog gateway) of the 
channel group. When the call is outgoing, this is the recipient base station. 
When the call is incoming, this is the source base station. ‘Localhost’ is the base 
station that the CSS is connected to.

BS mode The BS mode column indicates whether the members of the channel group are 
in Run mode or Standby mode. If a member is in Standby mode, it cannot send 
or receive on its digital line.

BS1

BS3

BS2

CSS

RTCP

RTCP

BS1

BS2

BS3
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Inbound The Inbound group of columns display information on inbound RF inputs 
(from radio to dispatcher) that is relevant to voter operation. This can help if 
the channel group is experiencing RF problems. A green background indicates 
that the voice stream won the (inbound) vote. 

Type is P25 (digital P25), FM (analog FM), or Idle (if no voice stream is 
present). P25 always wins the vote over FM. 

Impairment is a number between 0 and 15. It is the inverse of signal quality. The 
lowest impairment wins the vote, if the streams have the same Type. For digital 
P25 calls, the impairment is based on the EVM (error vector magnitude). For 
analog FM calls, it is based on the SINAD. 

Outbound The Outbound group of columns display information on outbound inputs 
(from dispatcher to radios) that is relevant to voter operation.

Type is P25 (digital P25), FM (analog FM), or Idle (if no voice stream is 
present). P25 always wins the vote over FM. 

Source is Line (an analog line) or Mic (a control panel microphone). These can 
belong to any channel group member. 

Configuration The Configuration group of columns display information about configuration 
items relevant to voting behavior.

CG Mode (channel group mode) specifies whether each member is configured 
to operate in simplex or duplex mode. Use this column to check that all the 
members of the channel group have the same setting.

RF repeat indicates whether each base station in the channel group has enabled 
the repeat function. Normally, all base stations in a channel group have the same 
repeat function. Use this column to check that the base stations have the same 
repeat setting. The setting can be defined by the channel table or by Task 
Manager action.

Common uplink frequency indicates whether the member’s configuration tells it 
that it is using the same uplink frequency as other base stations in the channel 
group. This setting affects the way the base station votes.

Statistics The Statistics group of columns provide information about the quality of service 
of the voice stream received by each member.

Jitter The delay variation of RTP packets as they arrive at the channel group 
member. This value should be zero for the vote winner.

Packet Loss The number of packets lost on the link to the base station during the last over. 
Packet loss should be rare. Users will not notice a loss of up to 10 packets. 
Packet losses may be caused by inadequate linking bandwidth, cable faults, or 
power cycling of the switch or router.

Average Loss The average number of packets lost per second. Packet losses should be rare. 
Frequent packet loss indicates that there is something wrong with the linking 
infrastructure.
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Monitoring the Analog Line
The Analog Line form (Monitor > Interfaces > Analog Line) shows you what 
is happening on the analog line. You can check that it is enabled, view 
information about the current calling profile, look at line levels, and view the 
current state of line signaling.

Analog line 
enabled

If the Analog line enabled LED displays red, the analog line is unable to 
function. Look at the first items under Calling profile for the reason. 

RF repeat When the RF repeat LED is green, the base station repeats the signal it receives, 
unless another signal with a higher priority is present at one of its interfaces. If 
the base station is part of a channel group, the signal it repeats may have been 
received by any of the channel group’s base stations. 

When the RF repeat LED is gray, the base station’s repeat function is currently 
disabled. Signals from a receiver (at this base station or at any other base station 
in the channel group) can be sent to the analog line but not to the transmitter. 

Calling profile
The Calling profile area displays details about the current calling profile. The 
calling profile is selected by the channel table or by function tone from the 
console system.

User enabled If this check box is cleared, the current calling profile is disabling the analog line.

Software feature 
enabled

If this check box is cleared, the base station does not have a license enabling the 
analog line.

Lock If the padlock icon is locked, Task Manager has locked the analog line. 

Name The name of the calling profile.

Squelch Specifies what the analog line unmutes to. If the squelch is Normal, the base 
station switches any vote winner onto the analog line. If the squelch is Selective, 
the base station only switches the vote winner onto the analog line if it is 
addressed to the current calling profile’s line ID or to a group listed in the 
current calling profile’s group membership.
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Emergency When the Emergency LED is green, any calls that the analog line makes will be 
emergency calls. This is because the current calling profile configures them that 
way. It does not mean that the base station is currently receiving an 
emergency call. 

Call type Defines the type of call that the base station makes when the dispatcher initiates 
a call. (The analog line can always forward calls of any type.) If the call type is 
P25 group or P25 individual, the following boxes provide further information.

Group 
membership

The name of the collection of groups assigned to the calling profile. Alongside 
are displayed the group IDs belonging to the collection.

Service profile The service profile assigned to the calling profile. The check boxes alongside 
indicate which services are enabled at the analog line input. (The receiver input 
can have a different service profile, assigned to the channel.) For details about 
these services, see “Working with Service Profiles” on page 88.

Encryption Displays the encryption key that is assigned to the current calling profile. 

Encryption Status
The Encryption status area monitors the encryption of the input on the analog 
line input and the decryption of signals destined for the analog line output.

From line The From line LED indicates whether encryption is proceeding normally. 
The box alongside indicates whether the call is clear, what key is being used, or 
what the encryption problem is.

Item Meaning

ID The identity of the caller.

Destination The individual or group ID that the call is made to.

LED Box text Encryption status

Grey There is currently no speech.

Green Clear The input speech is not being encrypted.

Green Key name The speech is being encrypted using the named key.

Red Key empty There is no secure key data for the CKR that the key name is mapped to. 
The speech cannot be encrypted so it is not transmitted. Check that the 
key name is mapped to the correct CKR and that the secure key data for 
that CKR has been loaded. 

Red No license The calling profile specifies an encryption key but the required 
encryption feature license is not present. The speech is transmitted clear. 
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To line The To line LED indicates whether there are any problems with decryption. 
The box alongside indicates whether the call is clear, what key is used for 
decryption, or what the decryption problem is.

Line Status
The Line status area shows the status of line signaling and the levels of the line 
input and output. 

The first row of controls displays information about the analog line input. 

If the Channel seize LED is green, the analog line is receiving a signal that an 
analog input is present. 

The Level boxes display the configured input level (the expected level of the 
line input) and the RMS level currently being measured. 

LED Box text Encryption status

Grey There is no speech output.

Green Clear The speech was not encrypted.

Green Key name The speech has been decrypted using the named 
key. If the key has not been named, the box displays 
the CKR number of the key. 

Red Clear The speech is clear but should not be; the calling 
profile specifies an encryption key.

Red Key name The key used by the caller is not the key specified by 
the calling profile. The speech has been decrypted 
using the displayed key. If the key has not been 
named, the box displays the CKR number of the key.

Red Key empty The key that the calling profile selects has not been 
loaded or has been zeroized. No other key fits, so 
the speech cannot be decrypted.

Red No key The analog gateway does not have the key that was 
used to encrypt the speech. The call cannot be 
decrypted.

Red No license The encryption feature license is not present. If the 
speech is clear, it is provided to the analog line. If the 
speech is encrypted, it cannot be decrypted.
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If the Overload LED is red, the level is too high and is about to cause distortion 
in the DSP. It is acceptable for occasional speech peaks to trigger this LED, but 
if this happens regularly and often, too much gain is being applied and tone 
detection will not work properly. Enter a higher line level (Configure > Analog 
Line > General). If the Overload LED goes red at the beginning of the over, 
the HLGT is too high. Enter a higher line level or configure the console system 
to reduce the level of its HLGT output.

The second row of controls displays information about the analog line output.

If the Analog valid LED is green, the analog line is sending a signal that there 
is a valid output on the analog line. 

The Level boxes display the configured and measured levels of the analog line 
output. 

Signaling
The Signaling area shows the status of line signaling on the analog line. Check 
boxes indicate what is enabled in configuration and LEDs show what signaling 
is currently happening.

E & M If the Enabled box is checked, the analog line is configured to recognize and 
use E & M signaling. If the E Wire (input) LED is green, the base station has 
detected that the E wire has been asserted. If the M Wire (output) LED is 
green, the base station has asserted the M wire.

MDC1200 If the Enabled box is checked, the analog line is configured to recognize 
MDC1200 signaling. If the Received LED is green, the base station has 
detected LLGT. 

Tone remote If the LLGT detected LED is green, the analog line is receiving low level 
guard tone. If the green Monitor LED lights briefly, the base station received 
a command to monitor its channel (not yet implemented).

Last function tone Displays the frequency pair of the last function tone that was received. If a dual 
function tone was received, the two frequencies in the pair are different. If a 
single frequency tone was received, this is still displayed as a pair, but both 
frequencies are the same. 

Last address 
received

Displays the last MDC1200 address that was received. This is the destination 
address of a call initiated from the dispatcher.



TB9100 Customer Service Software User’s Manual   Modules 67

Modules

The CSS lets you monitor operational details about individual modules. These 
details include temperatures, currents, voltages, and levels.

Monitoring the Reciter
The Reciter form (Monitor > Modules > Reciter) lets you monitor the RSSI 
and SINAD of the received RF signal and audio levels on the analog line. Each 
level is displayed graphically as a gauge. The equivalent numeric value appears 
under the gauge heading. If the value is red, it has exceeded the maximum or 
fallen below the minimum that the gauge can display.

RF received level The RF received level area displays the RSSI and SINAD levels of the inbound 
RF signal. (If you want to know the equivalent RSSI in microvolts, see 
“Converting Between Microvolts and dBm” on page 101). The SINAD is only 
an estimation, obtained by measuring the out-of-band noise.

Analog line The Analog line area displays the audio levels for the receive (line in) and 
transmit (line out) paths of the analog line.

Temperature The Temperature area displays a thermometer that shows the temperature 
measured at the reciter heatsink.

Fan Displays whether the reciter has turned the fan on or off.

Fan rotation Active means that the reciter has detected fan rotation. Inactive means that the 
fan has failed, if the Fan box displays On. This box does not apply if the reciter 
is fitted with a 2-wire fan. 
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Monitoring the Power Amplifier
The Power Amplifier form (Monitor > Modules > Power Amplifier) lets you 
monitor the levels of various parameters. Some levels are displayed graphically 
as a gauge or thermometer. The equivalent numeric value appears in or under 
the heading. If a value goes off the scale, it turns red. 

To switch the temperature display between Celsius and Fahrenheit, select 
Options > Settings.

The first box in the form displays the internal name of the PA.

Alarm status The Alarm status box indicates whether the PA has an alarm. If the LED is red, 
select Monitor > Alarms > Status to see which alarm is active.

Transmitter 
output

The Transmitter output area displays the forward and reverse power. Click the 
Watts or dBm option to view these parameters as watts or dBm. 

Heatsink 
temperature

Displays the highest of the three temperatures measured at the PA driver, 
Final 1, and Final 2 transistors. (The 5 W PA has no final transistors and the 
50W PA has no Final 2 transistor.)

Air intake 
temperature

This thermometer displays the temperature measured at the air intake to the PA 
heatsink. 

Duty cycle The Duty cycle area has two gauges. 

The first indicates the average duty cycle over the past 5 minutes. 50% means 
that the PA was transmitting for 2.5 of the last 5 minutes. The display is updated 
once every minute. 
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The second indicates the average duty cycle over the past 24 hours. 25% means 
that the PA was transmitting for 6 of the last 24 hours. The display is updated 
once every hour.

VSWR The VSWR displays the voltage standing wave ratio. If this is greater than 10:1, 
an alarm is triggered and the PA folds its output back to 10% of its capability. 
Only when the VSWR falls below 5:1 will the power output begin to recover.

Fan Indicates whether the fan is on.

Supply Displays the voltage of the power that the PMU is supplying to the PA.

Monitoring the Power Management Unit
The Power Management form (Monitor > Modules > Power Management) 
lets you monitor the operation of the PMU. You can:

Check the voltage of the battery and the current that the PMU outputs to 
the PA.

See whether the base station is running on battery or mains power.

Check the status of the PMU’s inputs and outputs.

This form has gauges displaying the battery voltage, the output current, and the 
output voltage. Boxes represent different PMU submodules and LEDs indicate 
the status of power inputs and outputs. 

Alarm status The Alarm status box indicates whether there is a current alarm. If the LED is 
red and the box displays ‘Alarms active’, one or more PMU alarms have been 
triggered. Select Monitor > Alarms > Status to see which alarms are active.
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Battery voltage 
gauge

The battery voltage gauge indicates the voltage of the DC power supply to the 
PMU (whether or not it is currently being used).

Power inputs
LEDs in the boxes in the middle of the form indicate the status of the different 
power inputs.

AC-DC converter The LED in the AC-DC Converter box indicates the state of AC power.

The box label indicates the voltage the DC-DC converter is designed for (12, 
24, or 48 V). 

DC-DC converter The LED in the DC-DC converter box indicates the state of the battery input, 
whether or not that input is currently being used.

Standby converter The LED in the Standby converter box indicates the state of the DC supply to 
the standby converter. 

Power outputs
The right-hand side of the form displays information about the PMU’s power 
output to other TB9100 equipment in the rack frame. 

PA The PA LED displays green if the PMU is supplying power to the PA and gray 
if it is not. When the PMU is using mains power, it always supplies power to 
the PA. When it is using battery power, it supplies power unless it is in sleep 
mode and using the standby converter. 

LED Text Description

Green On AC power input is usable

Red Off AC power input is too low or too high 

Gray Off Mains Failure test is running

LED Text Description

Green On Battery input is usable. The PMU can provide up to 500 W 
(or up to 40 W of power in low power mode). 

Red Off Battery voltage is too low or too high.

Gray Off No battery power supply is fitted (the box is also disabled).

LED Text Description

Green On The standby DC supply has been turned on. The PMU is 
providing only 10 W of power to the exciter.

Red Off Battery voltage is too low or too high.

Gray Off No standby battery power supply is fitted. 
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Reciter/control 
panel

The Reciter/control panel LED indicates the status of the power supply to the 
receiver and the control panel. Green means that it is supplying power. Gray 
means that it is not, because the PMU is in battery protect mode. 

Auxiliary output The Auxiliary output box has an LED that indicates the status of the auxiliary 
power output.

The box label indicates the voltage that the auxiliary power submodule is 
designed to produce (12, 24, or 48 V). 

Output current 
gauge

The Output current gauge shows how much current the PMU is supplying to 
the rest of the base station.

Output voltage 
gauge

The Output voltage gauge shows the voltage of the power that the PMU is 
supplying to the rest of the base station.

Fan
The Fan box displays whether the PMU fan is off or on.

LED Text Description

Green On The auxiliary output power supply has been turned on.

Red Off There is a fault. This could be because there has been a 
current overdraw and the fuse is blown. On cooling, the 
fuse will automatically reset.

Gray Off No auxiliary power supply unit is fitted or the PMU has 
turned the output off.
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Data Logs

The CSS can ask the TB9100 to provide records of various types of logged 
events so that it can display them and optionally let you save them to a file. In 
addition, the CSS has its own log.

Viewing Call Records
The CSS can display records of digital P25 calls that the connected base station 
has participated in. 

 

Important: Viewing call records can cause voice drop-outs. When 
you click All Records, the base station sends all the entries in its 
log to the CSS. This may flood switched networks, which cannot 

prioritize voice packets. The result is that voice traffic does not arrive in time. 
To avoid this problem, configure the base station to send the data to a syslog 
collector. For details, see “Logging” on page 153. 

To view the call record log

1. Select Monitor > Data Logging > Call Record Log. The appropriate form 
appears, but displays no data. 

2. Click All Records and the CSS asks the connected base station to supply 
all call records it has stored. 

3. If you want to stop the displayed records from scrolling on the screen, select 
the Disable scrolling check box. 

A row of buttons on the bottom of the form lets you tell the CSS to stop 
asking for records, clear the display (new records will appear as calls are com-
pleted), or save the records you have obtained to a file.
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Viewing the System Log
The CSS can ask the connected base station to provide records of events that 
lie above the level of Notice. The base station can store up to 1000 such events.

Important: Viewing the system log can cause voice drop-outs. 
When you click All Records, the base station sends all the entries 
in its log to the CSS. This may flood switched networks, which 

cannot prioritize voice packets. The result is that voice traffic does not arrive in 
time. To avoid this problem, configure the base station to send the data to a 
syslog collector. For details, see “Logging” on page 153. 

To view the system log

1. Select Monitor > Data Logging > System Log. The appropriate form 
appears, but displays no data. 

2. Click All Records and the CSS asks the connected base station to supply 
records, beginning with the oldest. 

3. If you want to stop the displayed records from scrolling on the screen, select 
the Disable scrolling check box. 

A row of buttons on the bottom of the form lets you tell the CSS to stop 
asking for records, clear the display (new records will appear as they are cre-
ated), or save the records you have obtained to a file.



74 Part D: Monitoring    © Tait Electronics Limited May 2006

Viewing the Trace Log
The trace log provides information about the operation of the base station. 
Normally, you would look in the System log for such information. However, 
Tait may request that you look in the Trace log for particular items or that you 
save the trace log to a file and send it to them.

The trace log contains system log messages, call records, and additional messages 
with a severity level of Information. Information messages are Tait-internal and 
very detailed. The base station’s trace log can store up to 1000 messages. 

Important: Viewing the trace log can cause voice drop-outs. When 
you click All Records, the base station sends all the entries in its 
log to the CSS. This may flood switched networks, which cannot 

prioritize voice packets. The result is that voice traffic does not arrive in time. 
To avoid this problem, configure the base station to send the data to a syslog 
collector. For details, see “Logging” on page 153. 

To view the trace log

1. Select Monitor > Data Logging > Trace Log. The appropriate form appears, 
but displays no data. 

2. Click All Records and the CSS asks the connected base station to supply 
records beginning with the oldest. 

3. If you want to stop the displayed records from scrolling on the screen, select 
the Disable scrolling check box. 

A row of buttons on the bottom of the form lets you tell the CSS to stop 
asking for records, clear the display (new records will appear as they are cre-
ated), or save the records you have obtained to a file.
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Viewing Call Statistics
The Call Statistics form (Monitor > Data Logging > Call Statistics) displays 
information about the current or most recent call and statistics about recent calls. 
Statistics are displayed separately for digital P25 calls and for analog FM calls.

 

Last / current Call
Information about the current call. If there is no current call, information about 
the most recent call.

Type Whether the call was digital P25 or analog FM.

Duration How long (in seconds) the call has been in progress.

Source ID The ID of the sender (P25 calls only).

Destination ID The ID of the intended receiver of the call (P25 calls only).

Calls
The Calls area displays statistics separately for analog FM and for digital P25 
calls.

Last 15 minutes The Last 15 minutes columns display call totals for the last completed 15-
minute period. When the next 15 minute period completes, the display updates 
with the totals for that period.

Since reset A column of totals that have accumulated since the base station was last reset.

RF Calls that were initiated from the RF interface.

Line Calls that were initiated from the analog line.

Network Calls that were initiated from the digital line.

Microphone Calls that were initiated from the control panel microphone.
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Viewing the CSS Application Log
The CSS maintains a log of events in a file. This log may provide useful 
information if there are problems with the CSS or in the communications 
between the CSS and a base station.

To view the Application log

1. Navigate to the Log Files folder. This is a subfolder of the main CSS folder. 

2. Open Application.log in any text editor.

A display similar to the following appears.
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Module Details

The CSS can display details about the reciter, PA, and PMU of the base station 
you are logged on to. Items under the heading Module Details give you 
information about the module such as its frequency range and firmware version. 
To monitor the way the modules are operating, see “Modules” on page 67.

Viewing Reciter Information
The Reciter form (Monitor > Module Details > Reciter) lets you view 
information about the reciter module of the base station you are logged on to. 
Use it to confirm exactly what it is that you are dealing with.

Band The RF frequency band of the reciter. This is the frequency range that the 
reciter is type-approved to operate in.

Alarm status Indicates whether the reciter currently has any alarm conditions. If the LED is 
green, there are no active reciter alarms. If the LED is red, the text box displays 
‘Alarms active,’ and there is at least one active alarm. To see which alarm is 
active, select Monitor > Alarms > Status. 

Exciter frequency The current switching range of the exciter, as recorded by the base station when 
it was last tuned using the Calibration Software. You can confirm the actual 
switching range using a diagnostic test (Diagnose > RF Interface > 
Synthesizers).

Receiver 
frequency

The current switching range of the receiver, as recorded by the base station 
when it was last tuned using the Calibration Software. You can confirm the 
actual switching range using a diagnostic test (Diagnose > RF Interface > 
Synthesizers).
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Calibrated The date when the reciter was last modified using the Calibration Software. 
(This includes adjusting the switching range and tuning the frequency 
response.)

External reference Indicates whether the reference frequency is currently being provided by an 
external or an internal source.

Product code The product code and name for the type of reciter. 

Versions
The Versions area (Monitor > Module Details > Reciter) displays version 
information for the reciter’s digital and network boards. 

Serial number A unique identifier assigned to the board in the factory.

Firmware The version number of the firmware currently installed on each board.

Kernel The version number of the network board’s operating system kernel. 

Hardware The version number of the hardware for each board. This version number is 
used to establish compatibility with firmware versions.

Database The version number of the base station’s database. The CSS communicates 
primarily with the reciter’s network board. The CSS and the network board 
must use the same database version.

Viewing Power Amplifier Information
The Power Amplifier form (Monitor > Module Details > Power Amplifier) lets 
you view information about the PA module of the base station you are logged 
on to. Use it if you need to confirm exactly what it is that you are dealing with.

Product code The product code and name for the type of PA. 

Serial number A unique identifier assigned to the PA in the factory.

Band The RF frequency range that the PA is type-approved to operate in.
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Isolator Indicates whether the PA is fitted with an optional isolator. 

Power Specifies the RF power output rating of the PA. There are 5 W, 50 W, and 
100 W variants.

Alarm status Indicates whether the PA currently has any alarm conditions. If the LED is 
green, there are no active alarms. If the LED is red, the text box displays ‘Alarms 
active,’ and there is at least one active alarm. To see which alarm is active, select 
Monitor > Alarms > Status. 

Versions
The Versions area (Monitor > Module Details > Power Amplifier) displays 
version numbers for aspects of the PA. 

Calibrated The date when the PA was last calibrated using the Calibration Software.

Firmware The version number of the PA firmware.

Hardware The version number of the PA hardware.

Viewing Power Management Unit Information
The Power Management Unit form (Monitor > Module Details > Power 
Management Unit) lets you view information about the PMU of the base 
station you are logged onto. Use it if you need to confirm exactly what it is that 
you are dealing with.

Product code The product code and name of the PMU module. 

Serial number A unique identifier assigned to the PMU in the factory.
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Alarm status Indicates whether the PMU currently has any alarm conditions. If the LED is 
green, there are no active alarms. If the LED is red, the text box displays ‘Alarms 
active,’ and there is at least one active alarm. To see which alarm is active, select 
Monitor > Alarms > Status. 

Submodules
The Submodules area (Monitor > Module Details > Power Management Unit) 
indicates which submodules the PMU is fitted with.

AC-DC converter Indicates whether the PMU is fitted with an AC-DC converter submodule, so 
that it can use mains input.

DC-DC converter Indicates whether the PMU is fitted with a DC-DC converter submodule, so 
that it can use DC power as an input. The box alongside indicates whether the 
submodule is designed for a 12, 24, or 48 V input. 

Standby converter Indicates whether the PMU is fitted with a standby converter submodule. 

Auxiliary output Indicates whether the PMU is fitted with a submodule that provides an 
auxiliary power output. The box alongside indicates whether the submodule is 
designed for a 12, 24, or 48 V output.

Versions
The Versions area (Monitor > Module Details > Power Management Unit) 
displays version numbers for aspects of the PMU. 

Calibrated Indicates when the PMU was last calibrated using the Calibration Software.

Firmware The version number of the PMU firmware.

Hardware The version number of the PMU hardware.
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Part E Configuring

The CSS lets you configure the TB9100 base station.

Click Configure, choose a configuration, and select an item 
from the navigation pane. 

Choosing a Configuration

Base Station

Working with the Channel Table

Working with Service Profiles

Configuring the System Interface

Configuring Miscellaneous Items

RF Interface

Working with Channel Profiles

Working with Signaling Profiles

Configuring the CWID

Digital Line

Network

Working with Channel Groups

Analog Line

Interfacing to the Console System

General Analog Line Settings

Working with Calling Profiles

Defining Group Memberships

Mapping Tone Remote Commands

Setting Tone Remote Options

Mapping MDC1200 Addresses
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Choosing a Configuration

If you click Configure and the CSS doesn’t already have a configuration in 
memory, it asks you to choose one to work with. 

Click New to open a new configuration based on the default template.

Click Open to select an existing configuration file.

Click Read to read in the configuration of the base station you are 
connected to.
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Base Station

Under Base Station, the navigation pane groups items that apply to the base 
station as a whole and are not specific to a particular interface.

Working with the Channel Table
The Channel Table form (Configure > Base Station > Channel Table) lets you 
work with channels. You can view the configured channels, edit them, and add 
more channels. 

Channel Table Details
The Channel Table form (Configure > Base Station > Channel Table) displays 
the channels defined in the channel table of the configuration file that you 
opened or the base station database that you read.

The form contains a table that displays a row for each channel. The row 
indicates the channel’s number and name, the configured transmitter power 
output for mains and battery power, and the profiles that have been assigned to 
the channel.

An arrow at the left of one row indicates that it is selected; if you click Add, a 
copy of that row will be added. Use the mouse or the arrow keys to change 
your selection. When you make any changes to a row, the arrow changes to a 
pencil.

Important: The arrow does not define the current channel. To find 
out the channel that the base station is currently operating on, select 
Monitor > Interfaces > RF Interface.

The first two columns indicate the number and name of each channel. The 
other columns define the main characteristics of each channel. Frequencies and 
transmit output power you can edit directly. Profiles and the channel group are 
selected from a list. Click a cell and a drop-down list appears, showing the items 
that have been defined. 
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Num The number of the channel. It is not editable, so that you do not break existing 
Task Manager statements. To replace a deleted channel, select the previous 
channel and click Add. This adds an entry to the channel with the number of 
the deleted channel. 

Name The name of the channel. When you create a channel, it is given a default name 
of the form ‘Channel nnn’ where nnn is the channel number. You can edit this 
name to reflect the channel’s purpose or users. 

RF repeat The RF repeat column specifies whether the base station operates as a repeater. 
For an introduction to the Repeat function, see “RF Repeat Function” on 
page 8. For full details about how the RF repeat setting affects signal voting and 
switching, see the information on voting in the Technical Description section 
of the TB9100 Installation and Operation Manual. 

Transmit 
Frequency

The radio frequency that the channel transmits on. 

Receive Frequency The radio frequency that the channel receives on.

Mains Power The RF power output in watts. This is the power that the channel is configured 
to provide when the base station is using mains power. 

Note: If you specify an RF power of 100 W and the PA is rated at 
50 W, it will run at 50 W. There is therefore no need to alter this 
value if you temporarily substitute an amplifier with lower power, 

for example, if there is a fault and you don’t have a fully powered module on 
hand.

Battery Power The RF power output in watts. This is the power that the channel is configured 
to provide when the base station is using battery power. 

Channel Profile The channel profile assigned to the channel. See “Profiles” on page 5 for an 
overview of the different profiles and their functions.

Signaling Profile The signaling profile assigned to the channel. 

Channel Group The channel group that the base station is part of. 

Option Description

Enabled The base station operates as a repeater. It is able to 
transmit the signal received from its RF interface or the RF 
interface of other channel group members. It repeats the 
best RF signal received by the channel group, not 
necessarily the signal it receives on its own RF interface.

Disabled The base station does not repeat received RF signals. It can 
only transmit what is provided by its analog line, its  
control panel microphone, or the analog line or control 
panel microphone of another channel group member. 

DispatchControlled The base station’s repeat function is controlled by Task 
Manager action and not by configuration. This makes it 
possible for the dispatcher to turn the channel group’s 
repeat function on and off, see “RF repeat actions” on 
page 197. 
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Service Profile The set of services that the inbound channel will support.

Calling Profile The calling profile used by the analog line.

Add Inserts a copy of the selected channel immediately below that channel. For 
more information, see “Adding a Channel” on page 87. 

Delete Removes the selected row from the channel table.

Editing a Channel
Editing a channel is mostly about assigning the correct profiles to it.

To edit a channel

1. In the channel table (Configure > Base Station > Channel Table), click in 
the row that defines the channel. An arrow appears at the left of the row 
indicating that it is selected.

2. If desired, click in the Name cell and edit the channel’s name.

3. If necessary, alter the receive frequency and the transmit frequency.

Important: Do not assign a prohibited frequency to the transmitter. 
For example, 406.0-406.100 MHz is reserved internationally for 
distress beacons.

Note: The CSS does not check whether the base station can operate 
on the frequency pair you enter.

For simplex applications, you can make the receive and transmit frequencies 
the same. The base station automatically increases the transmit frequency by 
25 kHz when it is not transmitting, to avoid desensitizing the receiver.

4. In the Main Power and Battery Power columns, specify values for the 
transmitter’s RF output power when powered by mains and DC 
respectively.

5. In the Channel Profile column, select the channel profile you want the 
base station to belong to. (Click in the cell, then click the arrow that appears. 
A list of the defined channel profiles appears.) The channel profile 
determines a whole range of settings, including switching behavior and (for 
analog mode), receiver gating and channel spacing. 

6. In the Signaling Profile column select the channel profile you want the 
base station to belong to. This defines the use of NAC (for digital P25 
mode), subaudible signaling (for analog FM mode), and tail timers.

7. In the Channel Group column, select the channel group that you want the 
base station to belong to. This determines the multicast address on the 
TaitNet P25 network that it sends voice to and listens to. 

8. In the Service Profile column, select a the service profile that defines the 
set of services that you want the channel to support. 

9. In the Calling Profile column, select a calling profile that you want to 
apply to the analog line (dispatcher commands that use MDC1200 can 
change this selection or override some of its settings.) 

10.Click OK to confirm your changes and close the form. 

Note: If you are editing a large number of channels, periodically 
click OK, and then (on the toolbar) Save. A computer failure will 
result in the loss of data stored only in volatile memory.
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Adding a Channel
You can add a channel to the channel table. 

1. Select Configure > Channels and Profiles > Channel Table.

2. Click on a channel similar to the one you want to add. A black triangle 
appears to the left of the row.

3. Click Add. This inserts a copy of the selected channel immediately below 
that channel. The inserted channel is given the next available number and 
an equivalent name, for example, if the next available channel number is 
008, the name is Channel 008. 

4. If desired, click the Num column heading to sort the new channel into 
numerical order.

5. Edit the values in the channel row as needed (see “Editing a Channel” on 
page 86).

Selecting an Operating Channel
Once a number of channels are defined in the channel table, you need to select 
at least one channel that the base station will operate on. There is no default 
channel; until one has been specified, the base station cannot operate. 

You have the following options.

Option Method

Automatic 
channel 
selection

Set up a Task Manager statement such as IF Base station in 
Run mode THEN Go to channel 2. The result is that every 
time the base station transitions from Standby mode to Run 
mode, it goes to the specified channel.

Dispatcher 
selects channel

Set up Task Manager statements such as IF Tone remote 
detected 550 THEN Go to channel 2. When the analog line 
receives a 550 Hz function tone from the console system, the 
base station switches to that channel.

Dispatcher 
selects channel 
(other base 
station)

If the base station is part of a channel group and the console 
system is connected to another base station in the channel 
group, you must set up Task Manager statements such as IF 
Function code 5 received THEN Go to channel 2. For more 
details, see “Propagating Tone Remote Commands to the 
Channel Group” on page 123.

Digital input 
value

The channel can also be selected indirectly by means of the 
digital inputs. The settings of a specified number of digital 
inputs have a computed value (displayed in Diagnose > Line 
Interfaces > System Interface). Set up Task Manager 
statements such as IF Digital input value 2 THEN Go to 
channel 2. Equipment can be connected to the reciter’s DB9 
socket that is able to switch the digital inputs on and off, 
changing the channel.
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Working with Service Profiles
The Service Profiles form (Configure > Base Station > Service Profiles) displays 
a list of available service profiles. A service profile indicates which additional 
services are permitted. Emergency alert is always permitted, so does not appear. 
All acknowledgements are also always permitted. Service profiles apply when 
the base station is operating in digital P25 mode. They do not affect MDC1200 
signaling in analog FM mode. Tait recommends that all services are normally 
enabled. Consoles and radios can allow or disallow services to the end user. 
However, services can be disabled at the base station to prevent pirate radios 
from using them on the TaitNet P25 network. 

A service profile can be selected by a channel in the channel table and/or by a 
calling profile. When a service profile is selected by a channel, it controls the 
behavior of the inbound RF channel. If a service is enabled, the inbound 
channel supports that service. When a service profile is selected by a calling 
profile, it controls the behavior of the analog line in. If a service is enabled, the 
analog line lets the analog console system use that service. The console system 
sends a MDC1200 signal, which is converted into the digital P25 equivalent 
(see “Additional Services” on page 125).

The profiles display Yes or No for each service. Yes means that the service is 
enabled, No that it is disabled. The following describes briefly what each service 
is.

Name The name of the service profile.

Call Alert Call alert (also known as paging) is a message that asks the radio user to call the 
sender. It may for example trigger a persisting message on the target radio such 
as a repeating tone and flashing display.

Status Report A status report is a message that the radio sends, perhaps in response to a status 
request. 

Status Request A status request is a message that requests a status report.

Message A message is a free-form text string.
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Presence Check A presence check is a message that checks out a given radio. If the radio 
responds, it is within communications range and its RF circuitry is functioning. 
The operator is not disturbed. 

Remote Monitor A remote monitor message causes the radio to initiate a call by itself. It allows 
the sender to listen to what is going on at the radio's location. 

Inhibit An inhibit message disables the destination radio, for example if it is reported 
stolen. When the Inhibit service is enabled, the Uninhibit service is also 
enabled.

Data The data service (not currently supported) involves the sending and receiving 
of data rather than voice.

Configuring the System Interface
The System Interface form (Configure > Base Station > System Interface) lets 
you configure the operation of digital inputs and outputs and the serial port. 
These all connect to the DB9 labeled DIG on the rear of the reciter. To 
monitor the current status of the digital inputs and outputs, or to carry out 
diagnostic tests on them, select Diagnose > Line Interfaces > System Interface.

Pin assignments
The unnamed table displays the functions assigned to each pin on the DIG DB9 
connector. The display reflects the choices made for Pins 1 and 9.

Serial port
Baud rate The default baud rate setting is 57,600 bit/s and is not normally changed. For 

Calibration Software operation it must be at this speed. The setting is ignored 
when the serial port provides raw C4FM data and a baud rate of 19,200 is used 
instead. 
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Computed input value

Number of bits Tells the base station how many bits (digital inputs) to use in calculating the 
digital input value. Digital input 0 provides the least significant bit. Four digital 
inputs are always available. If you configure Pin 1 as Dig in 4,  a fifth digital 
input is also available. Inputs are assigned the value 0 when they are low and 1 
when they are high. To monitor the current computed input value, select 
Diagnose > Line Interfaces > System Interface.

The digital input value can be used as an input in Task Manager statements (see 
“Digital input value” on page 189). Task Manager can for example select the 
channel number to use based on the computed input value.

Pin 1
The three option buttons let you specify one of three functions for Pin 1. 

Pin 9
The two option buttons let you specify one of two functions for Pin 9. 

RSSI Output
The TB9100 can provide an RSSI output on pin 9 of the DB9 labeled DIG. 
This is used for external voting or in systems with two base stations for 
redundancy.

Function Description

Antenna relay Select this option in simplex applications to provide 
a signal that drives an antenna relay. For details, 
see “Antenna Relay Operation” on page 91. 

Dig out 1 Configures pin 1 as a digital output. Select this 
option if you need a digital output.

Dig in 4 Configures pin 1 as a digital input. Select this 
option to make a fifth bit available for the 
computed input value or to make a fifth digital 
input available. 

Function Description

RSSI output Configures pin 9 to output a voltage proportional 
to the received signal strength.  For more details, 
see “RSSI Output” on page 90.

Dig out 0 Configures pin 9 as a digital output. You can also 
configure pin 1 as a digital output. 
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To enable and configure the RSSI output

1. Select Configure > Base Station > System Interface.

2. Under Pin 9, click RSSI output.

3. Under RSSI output, enter into the Signal level boxes the minimum and 
the maximum signal strengths that the base station needs to deal with. The 
RSSI output will be 0.5 V at the minimum signal strength, increasing 
linearly up to 4.5 V at the maximum signal strength. 

Antenna Relay Operation
For simplex applications, the base station can be set up with an antenna relay, 
enabling the receiver and transmitter to share the same antenna. Before the 
transmitter keys up, the base station activates the relay, disconnecting the 
receiver and connecting the transmitter to the antenna. It then powers the 
transmitter up. After it powers the transmitter down, it opens the relay again, 
so that it is ready to receive.

If the transmit and receive frequencies are equal, the base station automatically 
increases the transmitter frequency by 25 kHz when the base station is not 
transmitting, to minimize stray coupling.

Important: Check the specifications of the antenna relay to make 
sure that it closes its contacts within 20ms of activating the antenna 
relay driver. Otherwise, transmissions can begin before the contacts 

have closed. This can damage the PA. It will also burn the relay contacts. 

If the base station will operate with an antenna relay, you must configure pin 1 
of the DB9 labeled DIG as an antenna relay driver. Selecting this function for 
the pin also instructs the base station to operate with built-in timing delays (see 
“Start Timing Delays” on page 92 and “End Timing Delays” on page 93) to 
ensure that the PA begins its output after the relay contacts have closed and that 
the relay contacts close only after the PA has ceased its output.

To enable the operation of an antenna relay

1. Select Configure > Base Station > System Interface.

2. Under Pin 1, click Antenna relay.

3. In the channel table, make sure that RF repeat is disabled in all channels. 
Using an antenna relay when RF repeat is enabled will result in relay chatter. 
When the base station receives a signal, it switches to transmit so that it can 
repeat it. The result is that it can no longer see the signal. As there is nothing 
to transmit, it switches back to receive, which causes it to switch to transmit 
again, and so on. 

4. Program these settings into the base station.
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Start Timing Delays
The diagram below shows timings for the start of an over. The base station 
asserts the antenna relay driver at least 20 ms before the PA becomes active, to 
allow time for the relay contacts to close.

 

When the voter begins providing output for transmitting, the base station waits 
for 20ms before activating the antenna relay line (Pin 1). It then waits a further 
20ms for the antenna relay to close before activating the PA key signal, which 
instructs the PA to begin transmitting. In digital P25 mode, it transmits the full 
preamble before beginning to transmit speech (speech transmission only begins 
after the antenna relay delay and the preamble time).

Note: The configured preamble duration is unaffected up to a 
maximum of 260 ms. Increasing the preamble duration beyond 
260 ms has no effect on a base station with an antenna relay. 

Figure 4: Antenna relay timing diagram for the beginning of an over
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End Timing Delays
The diagram below shows timings for the end of an over. After the PA key goes 
inactive at the end of an over, the PA output can continue for up to 20 ms, if 
the keying duration was very short. The base station makes sure that the PA 
output has been off for at least 10 ms before de-activating the antenna relay 
driver. 

Configuring Miscellaneous Items
The Miscellaneous form (Configure > Base Station > Miscellaneous) gathers 
together a number of settings.

Minimum battery voltages
The Power configuration area (Configure > Base Station > Miscellaneous) 
defines the lowest possible voltages for the DC power input to the PMU. 

Three pairs of voltages are displayed, corresponding to the PMU’s different 
DC-DC converter options (a nominal 12 V, 24 V, or 48 V input). The voltages 
that apply have a white background and can be edited. If there is no AC power 

Figure 5: Antenna relay timing diagram for the end of an over
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and the battery voltage falls below the value in the relevant Power shutdown 
voltage box, the base station shuts down. If the voltage rises above the value 
in the Power startup voltage box and the PMU is fitted with a standby 
module, the base station re-starts.

Note: Base stations with a 12 V PA and no PMU cannot have their 
shutdown and startup voltages adjusted; these voltages are fixed in 
hardware. 

Auxiliary power control
If the PMU is fitted with an auxiliary power supply unit, you need to configure 
it to suit the way it will be used. Generally, its output can be used to charge 
batteries or to power other site equipment. If it is used to charge batteries, 
configure it to be on when mains power is on. If it is used to power other site 
equipment, use Task Manager to turn it on and off.

Caution: While the auxiliary power output can be used for more than one 
purpose at once, this is not generally recommended. It can result in a short-
circuit and equipment damage. The output is floating. If it is connected to a 

negatively earthed battery and to positively earthed auxiliary equipment, a short-circuit 
will result.

In the Power configuration area (Configure > Base Station > Miscellaneous), 
the Aux power control box specifies what controls the auxiliary output. Select 
one of the following options.

Configuring Fan Settings
The Fan area (Configure > Base Station > Miscellaneous) gathers together fan-
related settings. These specify how the base station monitors its PA and PMU 
fan and when the PA fan is turned on. The operation of the reciter fan is not 
configurable.

Option Description

Task Manager The Task Manager action Unlock Auxiliary Supply will turn 
the output on. You need to define suitable tasks for your 
system and application so that the auxiliary power output is 
turned on when it is needed and turned off when it needs to 
be off. See “Auxiliary supply lock” on page 196.

Mains Output is provided only when the PMU uses AC mains power. 
This option is suitable for re-charging the batteries used for the 
PMU’s DC power input. The Task Manager action Unlock 
Auxiliary Supply is not used. If the base station has a DC only 
PMU, this setting never turns the auxiliary power on.
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PA Fan Control
The PA Fan Control area determines when the PA fan is turned on. The 
settings can be adjusted to meet user requirements based on the transmit duty 
cycle and whether the site facility is air-conditioned. Strike a balance between 
lengthening fan life and reducing the PA operating temperature.The settings 
you choose should also help avoid extreme temperature swings. Bear in mind 
that the PA is designed to run at full duty cycle at up to +60°C ambient 
operating temperature into any transmit VSWR load.

Note: While the PA fan on/off thresholds are user-configurable, the 
PMU fan has fixed on/off thresholds controlled by PMU firmware.

Threshold 
temperature

If the temperature at the driver, final 1, or final 2 stages exceeds the threshold 
temperature, the fan is turned on (but only when the PA is transmitting, if the 
check box below is selected). When the temperature at all three parts of the PA 
falls 5°C below the threshold, the fan is turned off. 

Tip: To monitor all PA temperature values, select Diagnose > Power 
Amplifier > Control Tests. 

Only run fan when 
transmitting

When this check box is selected, the fan will only operate if the PA is 
transmitting and any one of the monitored PA temperatures exceeds the 
threshold.

Note: Fans used in the TB9100 must have the correct wiring. Power 
and ground (2-wire fans) or power, ground and rotation detect (3-
wire fans). Both fans in the front panel should be of the same type.

Type
Specify whether the PA and PMU fan type is 2-wire or 3-wire. If you select 3-
wire, the base station will use the third wire as a rotation detector. If it has 
turned the fan on but does not detect rotation, it activates the ‘Fan failed’ alarm.

Emulating T800 Fan Operation
In Tait T800 series base stations, the fan is usually turned on and off based on 
the state of the transmitter’s RF output. To emulate this, follow these steps:

1. Select Configure > Base Station > Miscellaneous.

2. Set the threshold temperature to a value that is lower than the usual site 
ambient temperature.

3. Select the Only run fan when transmitting check box.

With these settings, the PA fan turns on with RF output and cools the PA as 
soon as it begins working. It turns off when the RF output stops. The PA does 
not turn on if its temperature is below the threshold. This is an improvement 
compared with the T800 and lengthens fan bearing life.

External clock reference frequency (if fitted)
The External clock reference frequency (if fitted) area (Configure > Base 
Station > Miscellaneous) lets you specify the frequency of an external reference 
frequency source. If an external source is connected to the reciter, select the 
appropriate option to tell the base station what the source’s frequency is. 

Control panel
The Enable check box in the Control panel area enables the speaker and 
microphone. Disabling them may be desirable for security reasons. Before using 
them, a maintainer on site must first modify the configuration.
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RF Interface

The behavior of the RF interface is determined by the channel profile and the 
signaling profile that are assigned to the current channel in the channel table. 
You can also configure the sending of a morse code station ID.

Working with Channel Profiles
The Channel Profiles form (Configure > Base Station > Channel Profiles) lets 
you view the profile list, add a new profile, or edit an existing one.

The form displays a row of information for each profile. An arrow appears 
alongside the profile selected on the form. To sort the display by a particular 
column, click the column heading.

The Name column indicates the name of the profile. 

The Analog Rx and Digital Rx columns show you whether the profile lets 
the base station receive analog FM, digital P25, or both (dual mode). 

If the Tx Enabled column displays No, the base station cannot transmit if its 
channel is assigned that profile. 

For more detail about these columns, and about other profile details, see 
“Editing a Channel Profile” on page 98.

Buttons along the bottom of the form let you add a new profile, edit the 
selected profile, or delete the selected profile.
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Adding a Channel Profile
The base station requires at least one channel profile but you can define up to 
16 of them. One is needed for each combination of parameter variations that 
the base station needs to provide. For example, the base station may need to 
operate normally in mid-band but sometimes in wideband. In addition, 
conditions may sometimes be noisy, so different receiver gating settings are 
sometimes required. For these options you need four profiles, one for each 
combination of settings. 

The following instructions do not deal with all configuration items. For more 
detailed information about the individual items, see “Editing a Channel Profile” 
on page 98.

Tip: Set up a test profile and assign it to a channel. Use this channel 
when testing your system before commissioning.

To add a channel profile

1. Select Configure > Base Station > Channel Profiles. The Channel Profiles 
form appears.

2. Click a profile, and then click Add. A copy of the profile appears in the row 
below.

3. Click Edit. The Edit Channel Profile dialog box appears. (When you add 
the first profile, this happens automatically.)

4. In the Profile name box, enter a suitable name for the profile.

5. Under Receiver modes, select both the Analog and Digital check boxes 
to enable the base station to receive in both analog FM and digital P25 
modes. Alternatively, select one or the other check box for single-mode 
operation. 

6. Under Receiver gating, set the criteria for receiver squelch. You can have 
gating based on RSSI as well as SINAD and choose whether one or both 
criteria must be met. These criteria apply to analog FM mode only. For 
more details, see “Analog Receiver Gating” on page 99.

7. Under Analog RF configuration, specify the following properties for the 
RF channel.

a. The receiver channel bandwidth and the maximum transmit deviation. 

b. The deviation applied to subaudible signaling if the base station will 
transmit with CTCSS or DCS.

c. The type of filter used on the receive and transmit paths.

d. Whether automatic gain control is applied.

8. Select the RF transmit check box to enable the transmitter.

9. Click OK to confirm your changes and close the dialog box, returning you 
to the Channel Profiles form.
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Editing a Channel Profile
The Edit Channel Profile dialog box lets you view the details of the selected 
channel profile and modify them. 

Profile name Specifies the name of the profile. If you edit this name, ensure that the new 
name is unique.

Previous Profile Displays the previous profile in the list, without requiring that you leave the 
dialog box. This confirms any changes you have made to the current profile, 
which means they cannot be undone.

Next Profile Displays the next profile in the list, without requiring that you leave the dialog 
box. This confirms any changes you have made to the current profile, which 
means they cannot be undone.

Receiver modes
The Receiver modes area lets you specify which modes the base station can 
operate in response to signals that it receives over the air interface. You must 
select at least one mode. If you select both modes, the base station functions as 
a dual mode receiver. If it finds frame synchronization, it operates in digital 
mode. If not, it operates in analog mode.

Analog The base station can receive analog FM signals.

Digital The base station can receive digital P25 signals.
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Analog Receiver Gating
In the Edit Channel Profile dialog, the Analog receiver gating area configures 
the way receiver gating (also known as receiver squelch) operates when the base 
station is receiving in analog FM mode. 

You can have analog gating based on:

RSSI 

SINAD 

RSSI and SINAD

RSSI or SINAD

RSSI gating operates more quickly and is suitable for repeater links. SINAD 
gating takes longer but is more immune to noise interference and is suitable for 
the repeater itself or for a line-connected base station. 

Note: Gating in digital P25 mode is not configurable. The receiver 
unmutes when frame synchronization is achieved. If the signal 
subsequently deteriorates so that forward error correction is unable 
to compensate for errors, the voice stream is discontinued.

If analog gating is set at low levels for a dual mode receiver, breakthrough of 
the digital P25 signal can occur in analog mode. The signal is good enough to 
unmute the receiver but not to achieve frame synchronization. 

Tip: If possible, add subaudible signaling to dual mode receivers. 
This prevents the analog receiver from briefly unmuting to a digital 
signal until frame synchronization is detected.

Time

RSSI or SIN
A

D

Gate 
opens

<
--H

ysteresis-->

Gating level

Gate 
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RSSI Gating 
(carrier)

Enables gating based on the base station’s measurement of the received signal 
strength. This is also known as Carrier gating. This method is not 
recommended for low signal levels. If the level is set low (for example -118 
dBm) and the hysteresis is set to High, the gate may stay open permanently. 

SINAD Gating 
(noise)

Enables gating based on the estimated SINAD (obtained by measuring the out-
of-band noise). This is also known as noise gating. 

Logic When both RSSI and SINAD gating options are enabled, a drop-down list box 
lets you specify the gating logic. 

Tip: Select OR and set the RSSI level high (for example -100 dBm). 
This gives you quick gating when the signal level is high. When the 
signal level is low, gating occurs based on SINAD. This is slower but 
more accurate. 

Level The two Level boxes define the level (of RSSI or SINAD) required to enable 
receiver gating and pass the received audio. The RSSI level is in dBm. For 
equivalent values in microvolts, see “Converting Between Microvolts and 
dBm” on page 101.

Hysteresis The two Hysteresis boxes specify how far the RSSI or SINAD must fall below 
the level set in the corresponding Level box to disable receiver gating and mute 
the received audio. 

The Hysteresis box for RSSI gating provides the options Low, Medium, and 
High. Typically, these options correspond to hysteresis values of 1–2, 2–5, and 
5–10 dB respectively. The actual hysteresis varies with the RSSI gating level 
(see below). 

Set the hysteresis level you want, test TB9100 operation, and adjust the setting 
as appropriate.

Note: SINAD dB hysteresis is a recovered audio level measurement. 
It does not correlate to RF dBm levels.

Option Description

AND The receiver gate opens when both RSSI and SINAD 
values reach the required level. Similarly, it only closes 
when both RSSI and SINAD fall below the required 
level minus their respective hysteresis.

OR The receiver gate opens when just one of the RSSI or 
SINAD values reaches the required level. Similarly, it 
closes when either RSSI or SINAD falls below the 
required level minus the hysteresis. 
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Converting Between Microvolts and dBm
The following table lets you convert displayed levels in dBm into microvolts. 

Table 1: Typical hysteresis values for the different hysteresis options

Gating Level Low Medium High

-119 dBm 0.8 3.5 5

-118 dBm 1.1 3.4 5.9

-117 dBm 1.3 3.8 5.4

-116 dBm 1.9 3.9 6

-115 dBm 2.2 4.7 6.4

-114 dBm 2.4 4.7 6.4

-110 dBm 2.9 5.6 7.4

-105 dBm 3.4 6.1 8.1

-100 dBm 3.8 6.8 8.7

-95 dBm 4.1 6.8 8.6

-90 dBm 4.7 7 9.2

Level in 
Microvolts

Level in dBm
Level in 
Microvolts

Level in dBm

0.10 -126.99 10.00 -86.99

0.20 -120.97 12.50 -85.05

0.25 -119.03 15.00 -83.47

0.30 -117.45 17.50 -82.13

0.40 -114.95 20.00 -80.97

0.50 -113.01 30.00 -77.45

0.60 -111.43 40.00 -74.95

0.80 -108.93 50.00 -73.01

1.00 -106.99 60.00 -71.43

1.50 -103.47 70.00 -70.09

2.00 -100.97 80.00 -68.93

2.50 -99.03 90.00 -67.90

3.00 -97.45 100.00 -66.99

4.00 -94.95 150.00 -63.47

5.00 -93.01 200.00 -60.97

7.50 -89.49 250.00 -59.03 
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Analog RF Configuration
In the Edit Channel Profile dialog, the Analog RF configuration area lets you 
specify the nominal channel spacing for the receiver and the transmitter. No 
hardware modification is necessary when the RF configuration is changed.

Note: Your country may use Narrow band, Mid band and Wide 
band to refer to different channel spacings. Make sure that the 
option you select has the correct value. 

Receiver channel Specifies the receiver’s nominal channel spacing. The available options are 
expressed both as a description (for example, Mid Band) and as the kHz value 
of the nominal channel spacing.

Note: The Receiver channel box does not determine the actual 
spacing between channels. It determines the receiver IF bandwidth. 
For example, 20 kHz Mid Band sets the receiver IF bandwidth to 

12 kHz. Normally, you would select this option if the channels in your band 
plan have a 20 kHz channel spacing. However, your band plan may be 
irregular, or you may want to specify (when you enter frequencies into the 
channel table) a greater spacing between channels, for example, 50 kHz. 

Max Tx deviation Specifies the highest deviation that the transmit channel is permitted to have. 
The available options correspond to the following channel spacings:

Note: The Max Tx deviation box does not determine the actual 
spacing between channels. For example, 4000 Hz Mid Band sets the 
maximum transmit deviation to 4 kHz. Normally, you would select 

this option if the channels in your band plan have a 20 kHz channel spacing. 

Option Equivalent Rx IF Bandwidth

12.5 kHz Narrow Band 7.5 kHz

20 kHz Mid Band 12 kHz

25 kHz Wide Band 15 kHz

Option Channel Spacing

2500 Hz Narrow Band 12.5 kHz

4000 Hz Mid Band 20 kHz

5000 Hz Wide Band 25 kHz
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However, your band plan may be irregular, or you may want to specify (when 
you enter frequencies into the channel table) a greater spacing between 
channels, for example, 50 kHz. 

Subaudible 
deviation

Specifies the deviation that CTCSS or DCS signaling will cause to the carrier 
frequency. Options are specified both absolutely in Herz and relatively as a 
percentage of the selected Max Tx deviation. Gain will be applied to the 
CTCSS signaling to cause the deviation specified. If you subsequently alter the 
Max Tx deviation, the Herz value of the subaudible deviation will alter, but not 
its percentage.

Adding subaudible deviation reduces speech deviation correspondingly. This 
prevents over-deviation by ensuring that the total transmit deviation is not 
increased by the addition of subaudible signaling. In the TB8100, you can 
choose not to reduce the speech deviation, but this option is not currently 
available in the TB9100. 

Receive filter The Receive filter drop-down lists let you select an audio filter (see table below) 
that will be applied to received analog FM signals. 

Transmit filter The Transmit filter drop-down lists let you select an audio filter (see table 
above) for the transmit path. 

Automatic gain 
control (AGC)

Specifies whether automatic gain control is applied at the RF stage. AGC 
provides enhanced high signal handling capabilities and receiver 
intermodulation protection. When signal levels are high, however, the 
minimum sensitivity may be degraded.

AGC is normally enabled, but Tait recommends disabling it when: 

The anticipated receive signal strength is < -107 dBm (1 microvolt) and 
strong interfering signals (> -30 dBm (7000 microvolts)) are anticipated at 
the receiver input.

TIA/EIA or AS-4295 RF performance testing is being carried out.

Switching
The Switching area lets you disable the transmitter.

RF transmit Clear this check box if you want to disable the transmitter. A base station with 
a disabled transmitter and receiver can still function as a gateway between the 
analog line interface and the channel group that it belongs to. 

Audio filter Description

Flat full Passes audio evenly across the audio spectrum. 

Flat speech Passes only speech frequencies.

De pre emph 
speech

Passes audio in the speech range, de-emphasizing 
(attenuating) higher frequencies (receive filter) or pre-
emphasizing them (transmit filter). 

De pre emph 
full

Passes all audio, de-emphasizing (attenuating) higher 
frequencies (receive filter) or pre-emphasizing them (transmit 
filter).
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Microslots per slot This parameter affects the transmission of status symbols. Most base stations will 
use the default value of 1. Trunking control channel operation requires more 
microslots. This sets up a slotted structure on the downlink. When there is only 
one microslot per slot, all status symbols are set to “idle” or “busy”. Busy means 
that a signal is being received that would gate the receiver. When there is more 
than one microslot per slot, a status symbol is transmitted at every microslot 
boundary (every 7.5 ms) but they are set to “Unknown,” except at the slot 
boundary. 

Working with Signaling Profiles
The Signaling Profiles form displays a list of the current signaling profiles.

For each profile, the display shows you the NACs that are used for receiving 
and transmitting in digital P25 mode and the subaudible signaling that is used 
in analog FM mode.

Buttons along the bottom of the form let you add a copy of, edit, or delete the 
selected profile.

Adding a Signaling Profile
The base station requires at least one signaling profile. You can define up to 16 
of them. The signaling profile defines the NACs that the base station uses and 
recognizes, the subaudible signaling and the tail timers. For more detailed 
information about the individual items in the profile, see “Editing a Signaling 
Profile” on page 105. 

Tip: Set up a test profile and assign it to a channel. Use this channel 
when testing your system before commissioning.

To add a signaling profile

1. Select Configure > Base Station > Signaling Profiles. The Signaling Profiles 
form appears.

2. Click a profile, and then click Add. A copy of the profile appears in the row 
below.
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3. Click the profile, and then click Edit. The Edit Signaling Profile dialog box 
appears. 

4. In the Profile name box, enter a suitable name for the profile.

5. Under NAC enter the network access codes that the base station will 
operate on in digital P25 mode. In some circumstances, you need to enter 
different values for transmitting and receiving. 

6. Under Subtones, select the CTCSS tones or DCS codes that the base 
station will use when operating in analog FM mode.

7. In the Tail Timers tab, configure the way that audio, signaling, and carrier 
end at the end of analog FM transmissions.

a. If the network uses CTCSS signaling and the radios are configured to 
respond to reverse tone bursts, you can enable and configure reverse 
tone bursts at the end of transmissions.

b. You can enable a hang timer and specify the length of time that the base 
station continues to transmit carrier and subaudible signaling after audio 
has ceased.

c. You can enable a soft-off timer and specify the length of time that the 
base station continues to transmit carrier after audio and subaudible sig-
naling have ceased. 

8. Click OK to confirm your changes and close the dialog box. The profile 
you defined appears in the Signaling Profiles form.

Editing a Signaling Profile
The Edit Signaling Profile dialog box lets you view the details of the selected 
signaling profile and modify them.

Profile name Specifies the name of the profile. This name is used in the Channel Table and 
Signaling Profile forms.

Previous Profile Displays the previous profile. This means you don’t need to return to the list of 
profiles. 

Next Profile Displays the next profile in the list. 
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General tab
In the Edit Signaling Profile dialog box, the General tab specifies the network 
access codes that the receiver recognizes and the transmitter applies. Network 
access codes only apply to digital P25 mode; in analog FM mode, the specified 
subtones are used. 

NAC
The NAC area lets you specify what network access code the base station uses. 
NACs are always entered and displayed as hexadecimal numbers.

Receive Specifies the network access code that the base station recognizes. You can 
select an ordinary code (the default is 0x293) or choose one of the special values 
reserved by the P25 standard.

Note: Do not use the special NAC values F7E or F7F unless your 
system requires it. TB9100 receivers are highly sensitive in both 
analog and digital modes and can occasionally falsely detect digital 

P25 signals. The result is that spurious noise is repeated. In dual mode, the 
analog FM signal can drop out for up to 180 milliseconds. If the receiver is set 
to unmute only to a particular NAC value, the likelihood of false detections is 
greatly reduced.

Transmit Specifies what NAC the base station uses when transmitting. In most 
circumstances, this will be the same as the receive NAC.

Hexadecimal 
value

Description

F7E The receiver unmutes when a digital signal with any NAC is 
received.

F7F The receiver unmutes when a digital signal with any NAC is 
received. The transmitter uses the received NAC. The base 
station puts the received NAC in the signal it sends on the 
digital line, which tells the other base stations in the channel 
group to use that NAC when transmitting.

Any other 3-
digit value

The receiver unmutes. The transmitter uses its own NAC (see 
below). The base station puts 0xF7E in the signal it sends on 
the digital line, which tells the other base stations in the 
channel group to use their own NAC when transmitting.

Hexadecimal 
value

Description

F7E
Reserved for receivers and not permitted.

F7F

Any other 3-
digit value

The transmitter normally includes this value when 
transmitting. Only radios configured with this NAC, with F7E 
or with F7F will unmute. However, this value is overridden by 
the received NAC if the receiver NAC is F7F. If the receiver is 
at another base station, the received NAC is sent on the 
digital line for use by the transmitter. 
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Subtones
The Subtones area lets you specify subaudible signaling that the base station will 
use in analog FM mode. The base station supports CTCSS frequencies and 
DCS codes. CTCSS attaches a subaudible tone to the carrier signal. DCS 
attaches a digital code. A receiver configured with a particular tone or code will 
not unmute unless that tone or code is presented with the RF signal.

If the radios transmitting to or receiving from the base station are configured 
with inverted DCS codes, you need to program the base station with the 
equivalent normal DCS code. For details, see “Configuring the Base Station for 
Inverted DCS Codes” on page 107.

Note: If you select a transmit DCS code, the base station will always 
transmit a DCS end tone for muting the receive audio. However, 
transmitting a CTCSS reverse tone burst is optional and 
configurable.

Configuring the Base Station for Inverted DCS Codes
DCS codes can be expressed as a normal or an inverted code. For each inverted 
code, there is an equivalent normal code. For example 023 inverted is the same 
as normal 047 and vice versa. In the Edit Signaling Profile dialog box, the 
Receive and Transmit drop-down lists indicate for each normal code the 
equivalent inverted DCS code, by displaying it alongside in brackets. If the 
radios are programmed with inverted DCS codes, you configure the base 
station with the equivalent normal code. You can ascertain that code by looking 
up a table or by following this procedure. 

To program the base station with an inverse DCS code

1. Note the inverted DCS code that the radio is programmed to transmit with, 
for example 023.

2. In the Receive drop-down list, scroll down until you find that code in the 
list of normal codes. The inverse equivalent (in this example, 047) is in 
brackets beside it. Note this code.

3. In the Receive drop-down list, scroll down again until you find the code 
you noted (in this example, 047). Select it. When you program this 
configuration into the base station, the receiver will unmute to the radio’s 
inverse DCS code (in this example, 023, which is the same as the normal 
code 047). 

Tail Timers tab
In the Edit Signaling Profile dialog box, the Tail Timers tab lets you configure 
tail timers that the transmitter users.

In analog FM mode, different tail timers give you power and flexibility in tail 
timing. The total tail time is the sum of the hang time and the soft-off time.

Tail timers are used to:

eliminate squelch tail (the ‘tish’ sound caused when the CTCSS detector 
doesn’t immediately re-mute the user’s radio when carrier ceases) 

prevent users on different subtones from taking control of the repeater 
during a temporary lull in the conversation

In digital P25 mode, tail timers are not used.
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Reverse tone burst
The base station can send a reverse tone burst at the end of each transmission. 
This applies only to analog FM transmissions with a CTCSS tone. The reverse 
tone burst consists of the same tone, but is 180 degrees out of phase with it. In 
suitable radios, this quickly mutes the receiver. 

Note:  Transmissions with a DCS subtone have an equivalent: the 
DCS end tone. This consists of a 134 Hz tone that lasts 180 ms and 
is not configurable.

In the Edit Signaling Profile dialog box, Tx Timers tab, the Reverse tone 
burst check box enables the sending of reverse tone bursts. 

Duration The Duration box specifies the length of the tone burst. You can specify this in 
milliseconds or in cycles. If the burst has too many cycles, it comes back into 
phase with the original subtone and the radio may detect it again, re-opening 
the receiver gate. Specifying the duration in cycles for different CTCSS 
frequencies can help prevent this. 

Hang time
The hang time is the length of time at the end of each analog FM transmission 
when the base station continues to transmit subaudible signaling after Tx keying 
has ceased. During the hang time, radios in the talk group that uses the 
subaudible signaling can initiate a call but other radios cannot.

In the Edit Signaling Profile dialog box, Tx Timers tab, the Hang time check 
box enables this timer and the Duration box specifies the length of the hang 
time. 

Soft-off time
The base station can also send only carrier (carrier without modulation of any 
kind) at the very end of each analog FM transmission. 

In the Edit Signaling Profile dialog box, Tx Timers tab, the Soft-off time 
check box enables the feature for analog FM transmissions and the Duration 
box specifies the length of time that only carrier is transmitted. 
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Configuring the CWID
The CWID form (Configure > Base Station > CWID) lets you configure the 
way the base station broadcasts its identity using Morse code and set up the 
automatic sending of the CWID. In the USA, the FCC requires that base 
stations broadcast their identity. 

Tip: Transmit using CWID before your radio system is 
commissioned; if there are any other users of the frequencies you 
have been assigned, this gives them advance warning. 

The Morse area defines what the base station broadcasts and the Automatic 
CWID system area lets you enable and configure the regular sending of identity 
broadcasts. 

Morse
The Morse area (Configure > Base Station > CWID) lets you specify a unique 
ID for the base station. The speed of transmission and the tone used can also be 
configured, but you should not need to alter the default settings. 

The settings in this area apply to the automatic CWID transmission and to any 
CWID transmissions triggered by Task Manager action. 

Words per minute Specifies the speed of Morse code transmission. The 5-letter word PARIS is 
used to establish the number of words per minute. This word corresponds to 
50 dots. 

Tone frequency The frequency of the tone used to transmit the Morse code.

Message Enter into this box up to 30 characters to be transmitted as the station ID. You 
can enter any character or digit that the international Morse code alphabet 
supports (A-Z, 0-9, and punctuation marks). These characters will be 
transmitted using the International Morse Code convention. You can also enter 
spaces. They result in a silence equivalent in duration to seven dots. 
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Automatic CWID system
The Automatic CWID system area (Configure > Base Station > CWID) lets 
you enable and configure the automatic sending of the base station’s CWID 
according to the configuration in the Morse area. 

Important: If automatic CWID is enabled, calls that are in progress when a 
CWID is due for transmission will be interrupted. A future release will allow 
the base station to delay the CWID transmission until the Tx tail.

Select the check box to enable the system. 

Transmit every Specifies the interval in minutes from the end of one CWID transmission to the 
start of the next. For example, if the interval is one minute and the transmission 
takes 20 seconds, the CWID will be transmitted every one minute 20 seconds.

Tip: Use the Task Manager action Transmit CWID now to set up 
identity broadcasts in ways that the Transmission interval area does 
not permit.
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Digital Line

This section lets you define the name and identity of the base station on the 
TaitNet P25 network. You also set up the channel groups that the base station 
can belong to. The channel group assigned to the current channel is the one 
that the base station currently belongs to.

Network
The Network form (Configure > Digital Line > Network) lets you view or 
change the base station’s network settings. These settings are normally only 
changed at installation time. It also lets you configure the transmit jitter buffer.

Setting the Network Identity
Each base station has a unique name and IP address. The default settings 
provided by the factory must be changed when the base station is installed. 

Important: See the Installation and Operation manual for 
instructions on changing the network identity. If you give the base 
station an unknown IP address or subnet mask, the CSS will be 

unable to connect to it.

When you program a configuration into a base station, the CSS checks whether 
the IP address and subnet mask are the same as that of the base station. If there 
is a difference, you are given the choice of overwriting these items or keeping 
the existing ones, while updating the rest of the configuration. If you do change 
the IP address and subnet mask, the changes only take effect when the base 
station is reset.

Base station name The name of the base station. This is the human-readable equivalent of the IP 
address of the base station and appears on the status bar when you are 
connected. The default name is TB9100 but you should make sure that each 
base station on the network has a unique name. It is a good idea to use the same 
name as you enter into the connection list (Tools > Connections). A blank 
name is not permitted.

This name is a hostname and has all the restrictions that apply to hostnames (for 
example, you cannot use spaces).  

IP address The unicast IP address of the base station in dotted quad format. The default 
address when the base station leaves the factory is 192.168.1.254. This address 
is used for example in communications with the CSS. 

There should be a line in the connections list (Tools > Connections) that 
contains the name of the base station and its IP address, so that this CSS knows 
what IP address to connect to. The names programmed into the base stations 
should be the same as the names in the connection lists. 
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Subnet Mask The subnet mask for the router that the base station is connected to. Enter the 
mask required by the IP addressing plan for the network.

Note: IYou may also need to specify a gateway address. At present, 
the base station uses Proxy ARP (RFC 1027) to find out which host 
on the LAN will forward packets destined for the network. The 

routers recommended by Tait support this protocol. Some networks may use 
different routers, or not use a local router at all. In these circumstances, it is 
necessary to set a gateway address in the base station. Tait’s intention is to make 
the gateway address configurable in the CSS in a future release. Currently, 
however, the gateway address is set as one of the environmental variables of the 
network board’s Linux operating system. See TN-977b for instructions or 
contact Tait for advice and assistance. 

Configuring the Jitter Buffer
The TB9100 has jitter buffers to accommodate the variation in the delay of 
speech, but only the RF jitter buffer is configurable. Two timers configure its 
operation. The optimal settings depend on the system design and are important 
for the operation of radio scanning and voting. 

Preamble Specifies the length of time that the base station transmits a preamble before 
beginning to transmit the call. The preamble consists of a high deviation test 
pattern. While the preamble is transmitted, arriving voice packets are stored in 
the jitter buffer. The longer the preamble, the greater the voice delay. The 
minimum preamble duration is 40 ms. For signaling messages (TSBKs), the base 
station applies a minimum preamble of 100 ms. 

Generally speaking, the aim is to keep the preamble as short as possible (to 
minimize the voice delay) but as large as necessary to ensure reliable subscriber 
unit scanning and voting, to support base station re-voting, and to fill the jitter 
buffer sufficiently to prevent speech dropouts, because the transmitter ran out 
of data to transmit.

The maximum available preamble duration is 300 ms. If the base station has an 
antenna relay, the effective maximum is 260 ms; entering a preamble larger than 
260 ms will not lengthen the preamble.

Local repeat 
hold-off

Specifies the length of time that the base station waits before beginning to 
transmit the preamble, if it is repeating the RF signal that it received. This value 
makes it possible for the locally repeating base station to begin transmitting at 
the same time as the other base stations in the channel group. It is of importance 
if the base stations re-vote (are using a common uplink frequency) and if the 
receiving radios are scanning or voting. 

The combined duration of the local repeat hold-off and the preamble and the 
Hold-off time should not exceed 200 ms, to limit the speech delay.
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Jitter Buffer Settings for Common System Designs
The following offers general guidance on the settings to choose for common 
system designs.

Radio voting In this system design, subscriber units scan the channels in the channel group 
and vote on the best signal. Set the Preamble to a long enough value (for 
example, 150 ms) to allow the radios to scan the channels and vote on the best 
signal before the call itself begins (avoiding late entry is particularly important 
with encrypted speech). The Local repeat hold-off should be the (average) 
network delay. Not only does this present signals to the scanning radios at the 
same time, it also allows the base stations to seamlessly vote if they use a 
common uplink frequency.

Single repeater Set the Preamble to the minimum of 40 ms and the Local repeat hold-off 
to 0.

Radio scanning In this system design, subscriber units scan the channels in the channel group 
until they find a signal. Once a signal is detected, scanning ceases. Set the 
Preamble to a sufficiently long value to allow the radios to scan the channels 
in the list. If the uplink frequency is not common between base stations, the 
Local repeat hold-off can be set to 0, as there is no terminal voting or base 
station re-voting.

No radio scanning 
or voting

In this system design, the main consideration is that the preamble is long enough 
to fill the jitter buffer sufficiently to prevent buffer underruns and the 
consequent drop-out of speech. In most situations, setting the Preamble to 
40 ms (for jitter originating in the base station and its interface) plus an 
allowance for jitter originating in the routers should be sufficient. Otherwise 
follow these steps.

1. Monitor the digital line and note the jitter for incoming calls. 

2. Select Configure > Digital Line > Network.

3. Under Jitter Buffer, enter into the Preamble box the jitter value you 
noted plus 40 ms.

4. Monitor the jitter buffer (Monitor > Interfaces > Digital Line.) If 
underflows occur, increase the initial delay. 

If the channel group does not use a common uplink frequency, the Local 
repeat hold-off can be set to 0.
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Working with Channel Groups
The Channel Groups form (Configure > Digital Line > Channel Groups) 
displays information about the channel groups that the base station can be part 
of. It lets you add channel groups and edit them. 

For details about the other columns in the table, see “Editing a Channel Group” 
on page 115.

At any particular time, the base station is a member of the channel group 
specified by the current channel in the channel table. 

Adding a Channel Group
1. Select Configure > Digital Line > Channel Groups.

2. Click Add.

3. Click Edit. The Channel Groups dialog box appears. 

4. If desired, edit the name of the group.

5. Under Speech transport, specify which call types the digital line will send.

6. Under Voting, select the Receivers use same frequency check box, if 
the receivers in the channel group use the same frequency.

7. Under Voice stream, enter into the IP address box the multicast IP 
address for the channel group. Generally, you can use the default port 
number. 

8. Click OK.



TB9100 Customer Service Software User’s Manual   Digital Line 115

Editing a Channel Group
In the Channel Groups form (Configure > Digital Line > Channel Groups), 
select a channel group, and then click Edit to modify it. 

Important: When you edit a channel group, make sure that all base 
stations in the channel group have the same channel group settings.

Name The name of the channel group. Each channel group must have a unique name.

Mode The channel group can operate in duplex or in simplex mode. All base stations 
and analog gateways in the channel group must have the same mode setting. 
Here, simplex and duplex apply to the digital line; the base stations’ RF 
interface is always duplex. A duplex channel group makes it possible for a radio 
user to get through to the dispatcher, even when the dispatcher is talking. A 
simplex channel group places less load on the linking infrastructure. 

Mode Description

Duplex A duplex channel group has an inbound (radio to dispatcher) and an outbound 
(dispatcher to radio) stream. The base station votes each stream separately; it 
selects the best inbound RF signal for presenting to any analog lines and control 
panel speakers. It selects the best outbound signal from the control panel 
microphones, the analog line input(s), and (if repeat is enabled) the output from 
the inbound voter. The outbound signal is broadcast over the RF interfaces.

In a duplex channel group, the channel group is able to forward a radio call to the 
dispatcher while the dispatcher is talking. However, the maintainer cannot talk to 
dispatchers via the control panel. A duplex channel group can support only one 
analog gateway, as it is unable to provide a voted stream from one gateway to 
another.

Simplex A simplex channel group has a single stream and each base station has only one 
voter. The voter selects a winner from all the signals that the base station receives 
on its interfaces and sends them to the outgoing interfaces.

Because a simplex channel group has only one stream, its linking infrastructure 
requires less bandwidth. Radio calls cannot be provided to the analog line if the 
dispatcher is talking.
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Speech transport
The Speech transport area lets you specify which types of call can be passed to 
the channel group along the base station’s digital line. Normally, both types are 
enabled, but analog FM can be disabled if the bandwidth of the linking 
infrastructure is insufficient to support it. Either may be disabled to assist with 
troubleshooting. The settings in this area have no effect on data calls. 

Digital P25 enable Enables the base station to send digital P25 voice over its digital line. The digital 
P25 voice stream is in the form of IMBE packets, which are compressed and 
low bandwidth. 

Analog FM enable Enables the base station to send analog FM voice over its digital line. The analog 
FM voice stream is in the form of G.711 packets, which are uncompressed and 
require a 64 kbit/s bandwidth. 

Voting

Receivers use 
same frequency

Select this check box if the receivers in the channel group operate on the same 
frequency. This tells the base station that simultaneous calls are probably from the 
same radio. If the check box is enabled, when the base station has won the vote, 
it periodically asks the other base stations in the channel group to re-vote. If the 
radio has moved, giving a different receiver better reception, that receiver takes 
over the call. If the check box is cleared, simultaneous calls are treated as if they 
come from different terminals and the vote winner does not request a re-vote.

Voice stream

IP address Specifies the IP address (normally multicast) that the base station belongs to as 
a member of the channel group. The base station sends its voice stream to this 
IP address and (if the address is multicast) accepts any voice stream that is 
addressed to this IP address. If there are only two base stations in the channel 
group, the unicast IP address of the other base station can be used. If the base 
station is part of a trunking system, enter the IP address of the site controller.

Port number The port number that the base stations in the channel group use for the voice 
stream. Generally, the the default port number is used. If the base station is part 
of a trunking system, enter the port number that the site controller uses for 
sending and receiving the voice stream.

Trunking controller
When the base station is part of a trunking system, it uses the IP address and 
port number specified here for TCCP control communications with the site 
controller. See TN-1141 for details. 
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Analog Line

An analog line can belong to an analog gateway or to a TB100 base station. Its 
behavior is determined by the current calling profile. A calling profile is assigned 
to the current channel in the channel table. This functions as the default calling 
profile. A dispatcher command can select a different calling profile.

Line levels for the audio and for MDC1200 output must be set. The types of 
signaling used by the console system must be enabled and configured.

Interfacing to the Console System
An analog gateway connects the console system to a channel group. The channel 
group is a set of TB9100 base stations that operate as a single logical channel. If 
a base station is used to carry out the gateway function, the console system is still 
connected to the whole channel group, not just to that base station. The channel 
group and its analog line function as follows. In outbound communications, the 
console output generally wins the vote and is transmitted over all the base 
stations in the channel group, as shown below. 

Figure 6: Interfacing a channel group to a console system
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For inbound communications, a radio making a call must win the vote. If it 
does, it is repeated by the base stations in the channel group (unless the repeat 
function is disabled). The call is also sent on the analog line to the console input, 
provided it is addressed to an ID that the analog line interface is configured to 
receive.

This section describes the following

Signaling options that the analog line supports (and how to enable and 
configure them)

Dispatcher commands that use tone remote signaling (and how to configure 
the base station for them) 

How to propagate tone remote commands to the channel group

How to map MDC1200 signaling to the equivalent P25 signaling (so that 
the analog console system can make use of the channel group’s P25 
capabilities) 

Signaling Options
The TB9100 analog line supports E & M, keytone, single and dual tone remote 
function tones, and MDC1200 signaling. 

E & M Line
In a traditional analog system, the E & M lines are used for Tx Key and Rx Gate 
signals. Tx Key tells the base station to transmit. Rx Gate tells the console 
system that the receiver has unmuted. 

In the TB9100 base station or analog gateway, things are more complicated. A 
Tx Key signal doesn’t necessarily key the transmitter. The base station is part of 
a channel group and any request from the analog line to transmit is voted on 
and may lose the vote to a signal on another input. Similarly, an Rx Gate signal 
does not necessarily mean that the receiver has unmuted. It does indicate that 
there is a valid audio signal, but this might have been received by any of the 
base stations in the channel group or have come from the control panel 
microphone. Accordingly, at the analog line interface, we use the terms 
‘Channel seize’ instead of Tx Key and ‘Analog valid’ instead of Rx Gate. 

Channel seize indicates that there is a signal on the analog line and asks the voter 
to vote on it. Analog valid indicates that there has been a vote and that the 
winner is on the analog line out. Channel seize can be conveyed by the E-line, 
by a digital input (in a future release), or by LLGT. If MDC1200 signaling is 
used, channel seize can be configured to occur some time after LLGT begins, 
so that MDC1200 signaling is not included in the voice stream.

To configure the E & M Lines for Channel seize and Analog valid

1. Select Configure > Base Station > System Interface

2. Select the E & M check box. 
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Keytone
With this type of signaling, the dispatcher can only control the transmitters of 
the channel group. When the console system sends a keytone, the base station 
presents the audio on the analog line at the voter. If the audio wins the vote, it 
is transmitted by the base stations in the channel group. When the keytone 
stops, the channel group stops transmitting.

To configure keytone signaling

1. Select Configure > Analog Line > Tone Remote Options.

2. In the Guard tone frequency box, select the keytone frequency. 

3. In the LLGT level box, select a minimum level for the keytone. In the 
HLGT level box, make sure that level selected exceeds the actual keytone 
level. 

4. Enable the notch filter.

Tone Remote Function Tones
The analog line supports the use of single and dual-tone tone remote signaling 
from console to base station. If the analog line is to be used with digital P25 
mode, the base station needs an analog line license. The tones are carried on the 
audio line in. The base station can respond to a tone remote function tone by 
selecting a calling profile or by carrying out Task Manager actions. The selected 
calling profile overrides the calling profile assigned to the current channel. In 
turn, some settings in the calling profile can be overridden by MDC1200 
signaling. Before you configure the base station's tone remote signaling, you 
need to know what tones it will receive from the console system and what 
actions these are intended to trigger.

Tone remote signaling consists of a high level guard tone (HLGT), followed by 
one or two function tones, then low level guard tone (LLGT), accompanied by 
audio.

Figure 7: Tone remote signaling
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To configure tone remote signaling

1. Select Configure > Analog Line > Tone Remote Options.

2. Adjust the parameters in the form as needed so that they conform with the 
tone remote signaling that the console system produces. Enable the notch 
filter.

3. Select Configure > Analog Line > Tone Remote Mapping.

4. Specify whether the console system uses single tone or dual tone signaling 
and clear the Hide Task Manager actions check box. 

The form now displays 16 or 256 tones, depending on whether you selected 
single tone or dual tone signaling. By default, these all have the action Task 
Manager. 

5. For each function tone that is to select a calling profile, assign the correct 
calling profile (You have to create the calling profiles first. See “Working 
with Calling Profiles” on page 130.) 

6. For each other function tone that is to be used, create Task Manager tasks 
with that tone number as an input. These actions tell the base station to carry 
out the function intended by the dispatcher. See “Tone Remote 
Commands” on page 121. 

7. As necessary, propagate the commands received as function tones to the 
other base stations in the channel group. 

For more information, see “Propagating Tone Remote Commands to the 
Channel Group” on page 123.

MDC1200
The TB9100’s analog line supports the use of MDC1200 signaling (also known 
as Stat Alert). In analog FM mode, the base station passes all MDC1200 
signaling transparently between dispatch console and radio and also between 
radios. In P25 digital mode, if the base station has a MDC1200 license, and 
MDC1200 signaling is enabled (Configure > Analog Line > General. Select the 
MDC1200 check box), it is able to convert MDC1200 signaling to P25 
signaling and vice versa. The base station with the analog line to the console 
system must be configured to enable each MDC1200 feature and to map 
MDC1200 addresses to P25 IDs. This enables analog console systems to make 
use of P25 features that are unavailable to tone remote signaling. The other base 
stations in the channel group do not need to be configured; the P25 signaling 
is propagated as part of the voice stream. 

You can use MDC1200 for caller identification (ANI), for additional services 
such as call alert and radio check, and for selective calling. The use of 
MDC1200 for repeater control is not supported; use tone remote function 
tones instead. If MDC1200 is available, Tait recommends that you use voice 
alert in preference to tone remote for individual calls.

Many MDC1200 messages require an acknowledgement and can be retried 
until an acknowledgement is received. The number of retries is determined by 
the console system. The retry rate, also determined by the console system, may 
need to be reduced to take account of the slower response when the message 
and its response need to be converted to P25.
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Tone Remote Commands
The base station can be set up to respond in a default manner to input from the 
dispatch console on the analog line. However, the dispatcher needs to be able 
to operate in different ways, for example to converse first with one group of 
users and then with another, or to converse first on one channel, and then on 
another. Analog console systems have a standard command set for carrying out 
such tasks. In analog systems, each command is communicated as a single or 
dual function tone via a tone panel to the base station. In TaitNet P25 
networks, the function tones are handled directly by a base station at its analog 
line interface. The effect of dispatcher commands is necessarily different, as we 
are dealing with a dual mode system and with a channel group rather than a 
single channel. The base station configuration determines the effect of a 
function tone. Two basic mechanisms are available: the function tone can select 
a calling profile or change the channel. The calling profile defines the ‘line 
personality’, and the channel change defines how the base station as a whole 
operates. The channel change also assigns the default calling profile for that 
channel. 

This section shows you how to configure a TB9100 base station and its channel 
group to enable the dispatcher to make use of the command set. For simplicity, 
separate instructions are given for each command, even though commands will 
be combined, for example selecting digital P25 mode as well as the group to 
speak to and the groups to listen in on. The instructions assume that the console 
system is already set up so that an appropriate equipment control (for example, 
button) is mapped to a single or dual function tone. For information about this, 
see the console system documentation.

Select Mode
If the channel group supports both analog FM and digital P25 users, the 
dispatcher needs to be able to select which mode the analog line uses when 
initiating a call. Configuring the base station for Select mode commands is done 
by defining calling profiles, each with the required mode, then assigning 
function tones to those profiles. 

Selecting a calling profile not only assigns the mode, but many other properties 
or the analog line as well. This means that the dispatcher may need several 
different calling profiles (you can define up to 16). 

To set up commands for selecting analog FM or digital P25 modes

1. Set up calling profiles for the different modes: one for Analog FM and one for 
each group or individual that the dispatcher wants to call in digital P25 mode.

2. Assign the calling profile to be used as the default to the channel or channels 
that the base station will normally use

3. Assign the calling profiles to the function tones that the console system will 
use (Configure > Analog Line > Tone Remote Mapping)

4. Make sure that the channel profiles assigned to the channel(s) that the base 
station uses support receiving both analog FM and digital P25 (otherwise the 
dispatcher will be able to talk to the radios but the base station will not be 
able to receive their reply). 

5. Assign the function tones to suitable controls on the console system. 
Activating these controls will select the corresponding calling profile.

Note: When the console transmits in one mode, it can still receive 
calls in the other mode. To reply, the dispatcher must first select the 
mode used by the caller. 
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Change channel
If the dispatcher needs to communicate with users on a different frequency pair, 
or to change other operating parameters of the base stations in the channel 
group, the base stations can be configured to respond to a dispatcher command 
by changing channel. This is done through Task Manager. 

To set up a command for changing channel

1. Create a Task Manager statement with the function tone as input and a 
change channel command as action.

For example: IF Tone remote detected (550) THEN Go to channel 5.

2. Configure the other base stations in the channel group with the equivalent 
Task Manager statement. See “Propagating Tone Remote Commands to 
the Channel Group” on page 123.

Note: The dispatcher should not use the change channel command 
when the base station is transmitting. The change to the new 
channel’s calling profile will not take place until the analog line 
commences a new transmission. 

Monitor
Most console systems have a command for monitoring the channel. To set up 
the TB9100 to respond to a Monitor command, you need a calling profile with 
normal squelch and (optionally) a Task Manager task that disables (locks) the 
checking for NAC and subaudible signaling. This makes it possible for the 
dispatcher to hear digital P25 calls using a different NAC and analog FM calls 
with different (or no) subaudible signaling.

To set up a command for monitoring

1. Copy the existing calling profile and change its squelch setting to Normal.

2. Assign the calling profile to the function tone sent by the console’s Monitor 
button.

3. Optionally set up Task Manager tasks such as the following:

IF Tone remote detected (550) THEN Lock subaudible/NAC decoding

IF Tone remote detected (750) THEN Unlock subaudible/NAC decoding

Note: This disables normal squelch at the receiver, not just at the 
analog line. If RF repeat is enabled, the base station or channel 
group will repeat the monitored signals, provided they win the vote.

4. Configure the other base stations in the channel group similarly, and 
propagate the dispatcher command to them (see “Propagating Tone 
Remote Commands to the Channel Group” on page 123).

Enable/Disable RF Repeat
The dispatcher can enable and disable the RF repeat function of the channel 
group. 

To set up commands for enabling and disabling RF repeat

1. In the channel table, set the RF repeat column to DispatchControlled. 

2. Set up Task Manager tasks such as the following:

IF Tone remote detected (550) THEN Enable RF repeat

IF Tone remote detected (750) THEN Disable RF repeat
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3. Configure the other base stations in the channel group similarly, and 
propagate the dispatcher command to them (see “Propagating Tone 
Remote Commands to the Channel Group” on page 123).

Calling Groups

To set up a command for calling a group

1. Set up a calling profile and select the call type P25 group. Enter the group 
ID in the Destination field.

2. Set up a group membership with that group included. This ensures that the 
dispatcher can listen to the group.

3. Select Configure > Analog Line > Tone Remote Mapping and assign the 
calling profile you created to the function tone that the console produces 
when the button is pressed. 

Calling Individuals
You have a limited ability to use tone remote signaling to make calls to an 
individual ID. A calling profile is needed for each individual ID and only 16 
calling profiles are available for individual and group calling. 

To set up a command for calling an individual

1. Set up a calling profile and select the call type P25 individual. Enter the 
individual ID in the Destination field. Note: the analog line will 
automatically listen to calls addressed to the Line ID in the calling profile. 

2. Select Configure > Analog Line > Tone Remote Mapping and assign the 
calling profile you created to the function tone that the console produces 
when the button is pressed. 

Propagating Tone Remote Commands to the Channel Group
For a dispatcher function tone command to control base station operation and 
not just the properties of the analog line, it must have the desired effect in all 
the base stations of the channel group. Only in this way can a channel group 
function as a single logical channel. Task Manager tasks are used to propagate 
dispatcher commands to the channel group. When the connected base station 
receives a function tone, Task Manager sends an equivalent function code to 
the other base stations in the channel group. When the other base stations 
receive that function code, Task Manager carries out the appropriate action. 

To propagate a ‘Go to channel 5’ command

1. In the connected base station or analog gateway, set up the Task Manager 
statement:

IF Tone remote detected (550) THEN Go to channel 5

IF Tone remote detected (550) THEN Send function code 0

Note: You can select any function code between 0 and 255 as the 
equivalent of a tone remote function tone.

2. In each of the other base stations in the channel group, set up the following 
Task Manager statement:

IF Function code received (0) THEN Go to channel 5.

When they receive the message from the base station, they also make 
channel 5 their operating channel.



124 Part E: Configuring    © Tait Electronics Limited May 2006

Note: The base stations can be set up to go to different channel 
numbers, but the new channels must fit together: for example they 
must all have the same receiver mode.

Figure 8 shows how the propagation works. 

MDC1200 Functions
The following provides a brief description of each supported MDC1200 
signaling type, explains how the base station handles the conversion between it 
and the P25 equivalent, and provides instructions on configuring the base 
station to support that signaling type when operating in digital P25 mode.

Caller Identification
The most common use of MDC1200 signaling is to provide the called party 
with the identity of the caller. In analog systems, radio equipment can send a 
MDC1200 message containing the ID of the caller. This ID can be displayed 
on the receiving radio or console system. The feature is known as ANI 
(automatic number identification) or PTT ID. Console systems can also send 
ANI messages.

ANI In digital P25 mode, the TB9100 can take the source ID of an incoming P25 
call, convert it into a MDC1200 ANI message with an equivalent MDC1200 
address, and send it to the dispatch console. For outgoing calls, the analog line 
uses the line ID specified by its current calling profile as its ANI. 

Figure 8: Propagating a ‘Go to Channel’ command
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To configure the analog line for caller identification on incoming calls

1. If possible, set up the analog line for trailing ANI (Configure > Analog Line 
> General). This adds the ANI message at the end of the over, reducing the 
delay at the start of the over). 

2. If desired, modify the default mapping of P25 addresses to MDC1200 
addresses (Configure > Analog Line > MDC1200 Address Table). This 
mapping converts the source addresses of digital P25 calls it receives into 
equivalent MDC1200 ANIs.

To configure the dispatcher’s caller identification

1. Ascertain the dispatch console’s MDC1200 address. This is a 4-digit 
hexadecimal number.

2. Convert the number into decimal, and enter it into the Line ID box of all 
the analog line’s calling profiles. (This assumes that the MDC1200 Address 
Table maps the MDC1200 individual IDs 1-EFFF to 1-61439 P25. This is 
the default mapping. You are entering the P25 address that will be 
converted into the console’s MDC1200 address.)

The line ID will be used as the console’s caller identification on outgoing 
digital P25 calls. 

Note: Many radios will send status messages to a dispatcher ID that 
is derived from the talk group they currently belong to. You don’t 
need to configure the analog line for them. The base station 

automatically switches them onto the analog line, if the current group 
membership includes the talk group. The MDC1200 destination ID is 
calculated from the calling profile’s Line ID and not from the actual destination 
ID of the status messages.

Emergency ANI This is similar to ANI, except that the message format is slightly different and 
the associated call is an emergency call. 

Outbound calls: When the analog line receives a MDC1200 emergency ANI 
message, it makes the following call an emergency call (overriding the setting 
in the current calling profile).

Inbound calls: When the channel group receives a P25 emergency call, the 
analog line produces an MDC1200 emergency ANI message.

Additional Services
MDC1200 can also be used to provide a range of services additional to ordinary 
voice calls. If these are to be converted to or from their digital P25 equivalent, 
the current service profile must enable them. Messages on the analog line (in 
MDC1200 format) must be enabled in the service profile attached to the calling 
profile. Messages arriving from a receiver in the channel group must be enabled 
in the service profile attached to the current channel of the base station 
receiving the message.

Call alert
The dispatcher can send a call alert message to a radio. The radio acknowledges 
the message and may provide a tone or LED indication that the user is to call 
back. The radio sends a call alert to the dispatcher, if the service profile assigned 
to the current channel enables it. The base station can convert a MDC1200 call 
alert message into a P25 call alert supplementary service and vice versa. 
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To configure the base station for call alert

1. In the service profiles assigned to the calling profiles that the dispatcher will 
use, enable Call Alert. 

2. If radios are to send call alert messages to the dispatcher, make sure that the 
service profiles assigned to the channels used enable Call Alert.

Radio check
The radio check message lets the dispatcher test whether a radio is powered up 
and within range. 

To configure the base station for radio check

Set the Presence Check column to Yes in the service profiles assigned to 
each calling profile that the dispatcher uses (Configure > System > Service 
Profiles). 

Emergency alarm
The dispatcher can receive an emergency alarm message from radios. This is 
also known as emergency alert or man down. Receiving this message may cause 
an alarm indication on the console system.

No base station configuration is necessary for this message; it is not possible to 
disable this function.

Radio disable/radio enable
The dispatcher can disable or enable radios (P25 refers to this as inhibit or 
uninhibit), provided the radios support the feature and have it enabled. 

To configure the base station for disabling and enabling radios

In the service profiles assigned to the calling profiles that the dispatcher uses, 
set the Inhibit column to Yes. 

Remote monitor
The dispatcher can remotely monitor P25 radios on the network. The console 
system sends the MDC1200 message, which is converted to the equivalent P25 
message. The individual address of the radio is converted from MDC1200 to 
P25 format. 

To configure the base station for remote monitor

In the service profiles assigned to the calling profiles that the dispatcher uses, 
set the Remote Monitor column to Yes.

Status update and status request
The dispatcher can request status information from a radio and the radio can 
send an update on its status. 

Call Addressing
MDC1200 can also be used in analog systems to address calls to particular 
individual radios. The TB9100 can turn the request for an analog call to a 
MDC1200 individual address to a P25 individual call to an equivalent P25 
individual or group. 
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Voice Alert 
In analog systems, the MDC1200 voice alert message (also known as selective 
call) is used to signal a particular individual address. Only the radio with that 
address listens to the call; other radios do not unmute. When the TB9100 
receives a voice alert message on its analog line, it can handle the call as a P25 
individual call, mapping the MDC1200 address to a P25 individual ID.

General Analog Line Settings
The General form (Configure > Analog Line > General) lets you set levels for 
the analog line. You can also enable MDC1200 signaling, set its level, select 
configuration options and monitor the signaling received. 

Setting Line Levels
You set line levels in the General form (Configure > Analog Line > General) 
To help you, the form displays the current line levels at the analog line interface. 
These are measured in the digital domain and adjusted to represent the actual 
values at the interface pins.

Levels need to be set correctly so that the line output level does not exceed 
acceptable limits and so that the signal arriving at the base station switch is 
neither so strong that it risks exceeding the maximum value nor so weak that 
signal quality is affected. The levels that you enter are the absolute levels in dBm 
that a -10 dBm0 test tone would have at the line interface. 

The levels you set should implement the network level plan. In the following 
level plan for a very simple network, a dispatch console is directly connected to 
a base station along lines with a 3 dB loss. The plan specifies 0 dBr for each 
output. This is achieved by setting line levels in both the dispatch console and 
the base station at -10 dBm for the output and -13 dBm for the input. 
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-10 dBm
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Output The Output box specifies a nominal line level for the analog line output. When 
the base station is receiving an analog FM signal at 60% maximum deviation, it 
applies a gain so that it outputs audio at this level. Enter a value based on the 
level plan for the network. For example, if the level plan specifies -0 dBr at the 
analog line output, enter -10 dBm. This results in an average power level at the 
transmission reference point of -10 dBm, allowing 10 dB for speech peaks. You 
can verify the accuracy of the setting by using RF test equipment to supply a 
signal at 60% deviation, and reading the output in the RMS level box. 

Note: The output level is currently limited to a maximum of -10 
dBm. This is to ensure compliance with telecommunication 
company requirements.

Input The Input box specifies the line level that the base station expects on the analog 
line input. When the base station receives audio at this level, it applies a gain so 
that it transmits at 60% maximum deviation, when in analog FM mode. Enter 
a value based on the level plan for the network. For example, if the level plan 
specifies -3 dBr at the analog line input, enter -13 dBm. Audio sent from the 
transmission reference point at -10 dBm will arrive at the analog line interface 
at -13 dBm. You can verify the accuracy of the setting by looping back the 
analog line and using the base station’s own ability to send a 1 kHz test tone, 
measuring the maximum deviation using RF test equipment.

Using Deviation Measurements to Set the Input Line Level
Traditionally, technicians use transmitter deviation measurements to set line 
levels. While line levels in a TB9100 can be correctly set without measuring the 
deviation, some may still wish to use this method.

To set the input line level

1. Apply a 1 kHz tone at the required reference level at the line input.

2. Set the base station to analog FM mode. (In digital P25 mode, the C4FM 
modem uses fixed deviation patterns that represent specific symbols. The 
deviation cannot be used for setting the line level.)

3. Adjust the input level (Configure > Analog Line > General) until the 
deviation is 60% of peak.

Note: After the line level is set, you can also check for a transmitted 
tone in P25 mode. However, you must first change the tone 
frequency to 500 Hz; the IMBE vocoder does not reproduce 

fundamental tones above about 500 Hz. 

Channel seize and analog valid
The General form (Configure > Analog Line > General) lets you specify which 
signaling methods can be used by the analog line. 
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E & M This check box enables E & M signaling. When the E line goes low, the base 
station interprets this as a channel seize. When the base station puts a valid signal 
on the analog line, it asserts its M line.

Tone remote This check box enables the use of tone remote signaling for channel seize. 
When the base station receives LLGT (keytone), it interprets this as a channel 
seize. The LLGT must have the properties specified by Configure > Analog 
Line > Tone Remote Options.

After MDC1200 This check box only applies when tone remote signaling is enabled. Select this 
check box and the base station waits when it receives LLGT for enough time 
to receive one or more MDC1200 tone bursts before seizing the channel.

Setting MDC1200 Options
The General form (Configure > Analog Line > General) lets you set 
configuration options for MDC1200 signaling.

MDC1200 The MDC1200 check box enables MDC1200 signaling across the analog line, 
provided the base station or analog gateway has an MDC1200 license.

Important: MDC 1200 signaling must be sent to the analog 
gateway/base station before digital P25 voice transmission can 
begin. This is an inherent characteristic of the MDC 1200 and 

digital P25 standards and necessarily increases the end-to-end delay, or causes 
the start of the call to be lost, or to interfere with the MDC 1200 signaling. 
Which of these outcomes occurs will depend on the dispatch equipment. 
Sending guard tone, a single function tone, and the PTT ID takes at least 
280 ms.

Make sure that you include the MDC 1200 signaling time when calculating the 
end-to-end delay of the system. You may be able to configure your dispatch 
equipment to achieve a balance of initial voice loss and end-to-end delay. 

MDC1200 output 
level

Defines the level of MDC1200 signaling in dBm0. This applies only to 
MDC1200 signaling that the base station has generated from P25 signaling. -
10 dBm0 corresponds to the level that MDC1200 is normally sent over the air 
(60% deviation). 



130 Part E: Configuring    © Tait Electronics Limited May 2006

ANI Specifies for incoming digital P25 calls when the MDC1200 ANI message is 
added to the voice stream sent on the analog line. The setting you choose must 
match the setting of the console system. 

Monitor Enable the Monitor check box to monitor any MDC1200 commands coming 
from the console system. The MDC1200 code for this command appears in 
hexadecimal in the Events box and the MDC1200 value of any destination 
addresses appears in the Address box. 

Enabling Encryption Warnings
The General form (Configure > Analog Line > General) lets you specify 
whether warnings about encryption are sent on the analog line.

Warn on clear 
speech

When this check box is selected, a single beep (1500 Hz) is sent on the analog 
line at the end of the over whenever a clear transmission is passed to the analog 
line. Clear the check box if your system doesn’t use encryption.

Warn on key 
mismatch

When this check box is selected, three beeps (500 Hz) are sent on the analog 
line at the end of the over if there is a mismatch between the received call and 
the current calling profile. A mismatch occurs if the call uses a key other than 
the one selected in the current calling profile, if the selected key is missing, or 
if the current calling profile specifies clear communications but the call uses a 
key. If any key matches the key used by the call, that call is decrypted. The 
dispatcher may need to change to a calling profile that uses the key used by the 
caller, so that the caller can decrypt the reply. 

Working with Calling Profiles
The Calling Profiles form (Configure > Analog Line > Calling Profiles) lets you 
view the list of profiles, add a new profile, and edit an existing profile. A calling 
profile defines the properties of calls that the dispatcher makes and receives. You 
can think of the analog line as equivalent to a radio; the calling profile defines 
the identity and behavior of that radio. Included in the calling profile is a service 
profile, which specifies what services the analog line supports, and a group 
membership, which specifies the groups it belongs to and therefore can listen in 
to. 

Option Description

Leading The ANI message is supplied to the console at the beginning of 
the over. As this information is not available until after the P25 
voice stream has begun, the base station or analog gateway 
must wait for it before forwarding voice on the analog line. 

Trailing The ANI message is supplied to the console at the end of the 
over. Delay is minimized, but the identity of the caller is not 
available until the end of the over.
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By default, the analog line uses the calling profile specified by the current 
channel. Dispatcher commands can select a different calling profile. If the 
console system uses MDC1200 signaling, aspects of the calling profile can be 
overridden.

The form displays a row of information for each profile. 

To create a new profile, click Add, and then click in each column as needed to 
edit it. To delete a profile, select it and click Delete.

Name The name of the profile. 

Enable The Enable column contains a check box. When this check box contains a tick, 
the profile is enabled. When the check box is cleared, the profile is disabled. 
This has the effect of disabling the analog line interface, if the current channel 
or a dispatcher command has selected this calling profile. 

If the analog line is not used, it may be desirable to disable the current calling 
profile to prevent unauthorized access to the channel group. You may want to 
disable the analog line temporarily. You can also set up a disabled calling profile 
and assign it to a channel in order to be able to disable the analog line interface 
through channel selection. 

Squelch Specifies what the analog line unmutes to. If the squelch is Normal, the base 
station switches any vote winner onto the analog line. If the squelch is Selective, 
the base station only switches the vote winner onto the analog line if it is 
addressed to the current calling profile’s line ID or to a group listed in the 
current calling profile’s group membership. The Squelch setting has no effect 
on analog FM calls. 

Call Type Specifies the type of call for dispatcher-initiated calls. The base station turns the 
audio on the analog line into the specified type (P25 group, P25 individual, or 
analog FM). The analog line can always pass calls of any type to the console. If 
you select analog FM, inapplicable columns are not editable.

If the console uses MDC1200 signaling, this setting can be overridden as 
follows. If the Call type column specifies analog FM, the channel group makes 
an analog FM call. If the Call type column specifies P25 group or P25 
individual, the channel group makes a P25 call of the type specified by the 
MDC1200 signaling. The line ID and destination addresses specified by the 
calling profile are overridden. 
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Group 
Membership

Selects one of the available sets of group IDs and assigns them to the console. 
Calls to these groups will be routed over the analog line to the console. 

Line ID Defines the individual ID of the analog line (digital P25 calls only). The base 
station will pass incoming individual calls with this destination ID to the analog 
line. The Line ID is also used as the source ID of all outgoing calls. 

Note: The analog line has additional IDs that are derived from the 
groups in the current group membership. This is done to support 
the way Status Messages are implemented. Some radios send Status 

Messages to an individual ID that is derived from the talk group assigned to the 
radio’s current channel. To derive this ID, the radio adds 0xFEF000 to the talk 
group. For example, talk group FFFF becomes individual ID 0xFFEFFF. Talk 
group 0x000A becomes individual ID 0xFEF00A. These additional line IDs 
mean that Status Messages from these radios are passed to the analog line. If the 
analog line uses MDC1200, it converts the configured Line ID (not the 
received ID) to MDC1200 and passes it on to the console system.

Destination Defines the unit or group ID that the call will be sent to (digital P25 calls only). 

If the selected call type is P25 group, enter a 5-digit group ID. 65535 (FFFF in 
hexadecimal) is a special group ID that sends the call to all radios on the system. 
This is also known as an unaddressed voice call. If you enter a group ID, make 
sure that the group membership profile assigned to the channel and to the 
analog line includes that group, otherwise the base station will not respond to 
communications from other group members.

If the call type is P25 individual, enter a 7-digit individual ID. 

This setting is overridden when the dispatch console uses MDC1200 signaling.

Service Profile Selects one of the available service profiles that specifies which services are 
available to the dispatch console (digital P25 calls only). The services the 
dispatch console is able to receive are determined by the service profile assigned 
to the current channel of the base station receiving the transmission.   

Encryption Specifies the analog line's encryption behavior. If ‘Clear’ is selected, the analog 
line does not encrypt calls and does not expect to have to decrypt them. Click 
in the column to display a drop-down list of keys. The key list comes from the 
Encryption form (Configure > Analog Line > Encryption). If a key is selected, 
the analog line encrypts outbound digital P25 calls using the secure key data for 
that key. It always decrypts inbound P25 calls if it has the key, but may sound 
a warning if a call does not use the expected key.

The encryption setting has no effect on analog FM calls.

Emergency Specifies whether calls that the dispatcher makes are emergency calls (digital 
P25 calls only). This setting is overridden when the console uses MDC1200 
signaling.

Encryption
The Encryption form (Configure > Analog Line > Encryption) is used for 
setting up encryption keys. The Unused keys area displays the CKR numbers 
of key data that has been loaded into the analog gateway but not associated with 
a key name. The Keys area lets you define keys, by giving them a name and a 
CKR. These keys are then available for assigning to calling profiles. You can 
also delete named keys from the keys list and zeroize all keys.



TB9100 Customer Service Software User’s Manual   Analog Line 133

Keys
The Keys area contains a table consisting of up to 16 rows, each containing a 
named key and a CKR number. Click on a column header to sort the table by 
that column. An arrow to the left of the table indicates which row is currently 
selected.

Name The name of the key. When you add a row to the Keys table, the CSS gives it 
a default name. You can leave this name or edit it to make it more meaningful, 
for example ‘Common key 1’ or ‘Police February.’ The name appears in a 
drop-down list in the Calling profiles form. Calling profiles refer to keys by 
name only.

CKR The CKR that you want associated with the key. You need to enter the CKR 
of secure key data that has been or will be loaded into the analog gateway. If 
you are connected to the analog gateway, the Unused keys area displays a list of 
CKRs that have not yet been assigned a name in the Keys table. 

Key present? If the CSS is connected to the analog gateway, this column indicates whether 
secure key data (the key ID, algorithm ID and key variable) is present for the 
CKR. For encryption to work, the secure key data must be present. If the 
column displays No, check that you entered the correct CKR number when 
naming the key.

Add Adds a new row to the Keys table.

Delete Deletes the selected row from the Keys table. This has no effect on the 
underlying secure key data.

Unused keys
The Unused keys area displays the CKR numbers of keys that have been loaded 
but not yet named.
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Zeroize
Click Zeroize all keys to remove all the secure key data that has been loaded 
by a key fill device. You can use this to remove obsolete key data from the 
analog gateway, before loading new key data. You should also zeroize all key 
data to maintain security when sending the analog gateway or the reciter for 
repair. 

 Defining Group Memberships
The Group Membership Table form (Configure > Analog Line > Group 
Memberships) lets you define sets of groups. At any particular time, the 
dispatcher belongs to one set of digital P25 groups and can listen to their calls. 
(The analog line belongs to a calling profile, which specifies one row in the 
group membership table. Calls to a group in the set are switched to the analog 
line, calls to other groups are not.) The analog gateway itself always receives and 
transmits irrespective of the group address.

You can enter up to ten sets of groups, each containing up to seven P25 group 
IDs. 

To add a set of groups

1. Click Add. A new row appears in the table. 

2. In the Name column, enter a suitable name or description for the set of 
addresses.

3. Enter a P25 group ID into the Group 1 column. These are 4-digit 
hexadecimal numbers. 

Note: If you enter nothing (leave the columns empty), one group is 
still specified: 65535 (0xFFFF). The base station will always pass calls 
to the group address 65535 on to the analog line. 

4. Repeat for subsequent group columns until you have entered all the groups 
that the dispatcher needs to listen to. The special group ID 

5. Click OK to confirm your changes and close the form. 
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Mapping Tone Remote Commands
The Tone Remote Mapping form lets you map tone remote function tones to 
calling profiles. By default, all function tones can trigger Task Manager actions. 
If you map a tone remote function tone to a calling profile, when the console 
sends the function tone, the base station’s analog line switches to that calling 
profile. If you want the function tone to do something other than select a calling 
profile, create an appropriate Task Manager statement with Tone remote 
detected (nnn) as the input. 

To map a function tone to a calling profile

1. Select Configure > Analog Line > Tone Remote Mapping. 

2. Select Single tone or Dual tone, based on the kind of function tones that 
the console system will produce. This configures the analog line for the 
detection of single-tone or dual-tone function tones. If you select Single 
tone, one tone column is displayed. If you select Dual tone, there are two 
columns.

3. If necessary, clear the Hide Task Manager actions check box.

4. In the row displaying the function tone frequency (or combination of 
frequencies, for dual function tones), click in the Action column. An arrow 
button appears.

5. Click the arrow to drop down a list of the available calling profiles together 
with the item ‘Task Manager.’

6. In the list, click the calling profile you want. 

Setting Tone Remote Options
Console systems can use a variety of frequencies and levels for the tone remote 
control of base stations. In the Tone Remote Options form (Configure > 
Analog Line > Tone Remote Options), you specify the parameter values that 
the connected equipment uses. A graph of tone remote signaling shows you 
visually the meaning of the parameters. Some values you can ascertain from the 
console system documentation, others may depend on the console system 
configuration. The console system and the base station must have compatible 
settings. 
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The Tone Remote Options form also has some monitoring items. You can use 
them to confirm that tone remote detection is working properly. 

Signaling duration The maximum time that the analog line will listen for HLGT and function 
tones. This time begins when the analog line detects HLGT. Any function 
tones received after this time has elapsed are not detected. 

Guard tone 
frequency

The frequency that the console system uses for the guard tone. HLGT and 
LLGT use the same frequency. If the console system is going to use MDC1200 
with analog FM radios, this frequency should be well above 2100 Hz, so that 
the notch filter does not remove significant amounts of energy from the 
MDC1200 signaling.

HLGT level HLGT must exceed this minimum level for the base station to detect the tone.

Function tone 
level

Single tone or dual tone function tones must exceed this minimum level for the 
base station to detect them.

LLGT level LLGT must exceed this minimum level and be less than the minimum HLGT 
level for the base station to detect the tone. 

Guard tone notch 
filter

When this check box is enabled, the base station removes the LLGT from the 
audio before sending it to the voter. Normally, the notch filter is enabled.

Monitoring Controls
Once you have set up the tone remote options, you can confirm that the analog 
line is correctly detecting and decoding them. Send some tone remote signaling 
from the console system and check the display of the following monitored 
items. 
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Guard tone detect Displays green when the analog line recognizes HLGT or LLGT.

Input overload Displays red if the level exceeds the limit that the analog line can handle. If 
overloads occur, the analog line cannot correctly detect tones.

Recent function 
tones

Displays the frequencies of the last four function tones detected by the analog 
line interface. If the analog line detects a function tone, its characteristics lie 
within the limits of the parameters defined in this Tone Remote Options form. 

Function tone 
count

Displays the number of function tones that have been detected. When you send 
a number of function tones from the console system, check that the count 
increments by that number.

Mapping MDC1200 Addresses
The MDC1200 Address Table (Configure > Analog Line > MDC1200 
Address Table) tells the analog line how to convert individual and group 
numbers from P25 to MDC1200 and vice versa. For example, when the 
dispatch console calls a group, the analog line converts the destination 
MDC1200 address to its P25 equivalent, which the channel group uses over the 
air. Similarly, when a radio calls the dispatcher, the analog line converts the 
radio’s P25 address to the equivalent MDC1200 address, which the dispatch 
console displays as the caller ID.

The default mappings will suffice in most circumstances. If necessary, the 
existing rows in the table can be modified or further rows can be added. All 
mappings involve a number conversion, so that the MDC1200 numbers 
displayed on the dispatch console can be highly similar to the equivalent P25 
numbers.

In the default mappings, the first table row maps P25 individual addresses 
between 1 and 999 to MDC1200 addresses 0001–0999. The second row maps 
P25 talkgroup addresses between 1 and 99 to 9001–9099. 

Adding an Address Mapping
If you need to map additional addresses to the ones already mapped, follow 
these steps.

1. Select Configure >Analog Line > MDC1200 Address Table.

2. Click Add. A new row appears in the table. 

3. In the Comment column, enter a name or remark to identify the block of 
addresses.

4. In the Group column, select Yes if you are mapping P25 group addresses 
or No if you are mapping P25 individual addresses. 

5. Under P25, enter into the Start column the lowest P25 address in the 
block. Enter into the End column the highest address in the block. 
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Tait recommends that you use group and individual addresses between 1 
and 9999. However, valid group addresses are 1-65535 (0xFFFF) and 
individual addresses 1-16777215 (0xFFFFFF). Generally, you can’t include 
addresses that have already been mapped, but you can re-use addresses from 
a block of group addresses in a block of individual addresses and vice versa. 
This is because a P25 group address is not identical to a P25 individual 
address with the same number; they have different byte sizes.

The size of the block is calculated and appears in the Size column. 

6. Under MDC1200, enter into the Start column the beginning of the 
equivalent MDC1200 block of addresses. MDC1200 addresses must 
normally be in the range 1-9999. You can’t include addresses that have 
already been mapped. The end of the MDC1200 address range is 
automatically calculated and appears in the End column. 

Note: Some analog console systems will not allow Radio Enable/
Radio Disable, Radio Check, Radio Monitor or Status Report 
(Status Request) if the hexadecimal MDC1200 radio address has an 

E or F in it. For assistance with mapping addresses with this or other similar 
special requirements, contact Tait. 

7. Click OK to confirm your changes and close the form. 

Tip: To shift a range, edit the address in the P25 or MDC 1200 Start 
column. To change the size of a range, edit the P25 size or the P25 
address in the End column.

Radio Numbering Example
The following example shows how a county Sheriff’s department could 
number its radios. 

Officers’ handportables, in-vehicle mobiles, and talkgroups each have their own 
number range. This example uses the default mapping and results in MDC1200 
numbers that are highly similar to the P25 numbers. 

P25 Start 
Address

P25 End 
Address

MDC1200 Start 
Address

MDC1200 End 
Address

Officers’ radios 1 99 0001 0099

Vehicles 201 299 0201 0299

Talkgroups 901 920 0901 0920
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Part F Alarms

The CSS can monitor the current status of a base station’s 
alarms. Many alarms have thresholds that you can alter to suit 
the application. Unwanted alarms can be disabled.

To view recent alarms, display the system log (Monitor > Data 
Logging > System Log). 

Topics

Monitoring Alarms

Disabling Unwanted Alarms

Altering Network Alarm Thresholds

Altering Base Station Alarm Thresholds
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Monitoring Alarms

The Status form (Monitor > Alarms > Status) shows the current status of alarms 
in the base station. The CSS must be connected to a base station before it can 
display the alarms.

LED-like icons indicate the status: 

Red (flashing) means that the alarm is active.

Green means that the monitored condition is OK and that there is no alarm.

Gray means that the alarm has been disabled or that the monitored condition 
is not available; for example, Final 2 alarms are gray if there is no Final 2 
stage.

Alarms are triggered when a monitored condition crosses a defined threshold. 
Some thresholds are fixed and built into the module firmware. Others are 
configurable in Configure > Alarms > Base Station Thresholds and Network 
Thresholds. Some parameters such as high voltage and high reverse power have 
two thresholds. When the configurable threshold is crossed, the base station 
generates an alarm. When the built-in threshold is crossed, the base station 
responds by protecting itself against damage. 

Tip: Use Task Manager to configure an automatic response to 
alarms. In general, each alarm has an equivalent Task Manager 
input. When the alarm occurs, Task Manager executes any tasks 

with that alarm as an input.
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Power Amplifier
The Power Amplifier area shows the alarm status of the PA associated with the 
reciter you are logged on to. When a fault is no longer active, any actions (for 
example, inhibiting transmission) are reversed.

No PA detected The reciter cannot obtain a response from a PA over the control bus. The PA 
may still be operating but the system has lost the ability to monitor PA alarms, 
carry out diagnostics, change configuration, or detect PA fan failure.   

1. No PA is installed.

2. Your system uses a third party PA which does not use the control bus and 
cannot respond to the reciter.

3. The control cable or exciter cable is not connected.

4. The PA is faulty and unable to communicate with the exciter. 

Invalid PA 
firmware

The firmware in the PA is invalid.

1. Use the CSS to download the firmware.

2. Return the PA to Tait.

Calibration invalid This alarm can only be triggered on startup, when the PA carries out self-tests. 
It indicates that settings stored in firmware have values outside acceptable limits. 
In response, the base station disables the transmitter. Re-calibrate the PA using 
the Calibration Software or send it to a service center for repair. 

Fan failed The PA told the reciter that its fan is on, but the reciter cannot detect fan 
motion. The base station takes no action when this alarm occurs, but it will act 
if the PA temperature becomes too high.

The fan has failed. Replace it.

Forward power 
low

The PA forward power output is below the configured minimum limit. If the 
VSWR is also raised, check for a load mismatch. Otherwise, there may be a 
fault in the output driver(s). 
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H/w configuration 
invalid

The PA has an invalid hardware configuration. Either the driver is not present 
or the configuration says that there is a Final 2 output stage but no Final 1, 
which is impossible.

Power foldback The PA has detected a fault condition and has reduced its power output to a 
minimal level to prevent damage. 

Check the other alarms to see what fault condition or conditions have caused 
this. If the fault condition clears, the PA automatically returns to its previous 
power output level and the alarm changes to green.

Reverse power 
high

The PA’s reverse power is above the configured maximum. Check for a load 
mismatch. With a resolution of only 1 W, this alarm is not sensitive if the power 
output is lower than 20 W. Check the VSWR fault alarm instead.

Shutdown The PA has detected a fault condition and has disabled the transmitter to 
prevent damage. Check the other alarms to see what fault condition or 
conditions have caused this. 

VSWR high The VSWR is above the configured threshold. A normal VSWR is ≤ 2:1. 
A high VSWR automatically means reduced output power. If the VSWR 
increases to 10:1 or more, the PA folds back its power output to a minimal level. 
If the VSWR returns to 5:1 or less, the PA recovers.

Check for a load mismatch on the PA’s RF output. 

Current The Current group of alarms detects excessive or inappropriate current draw. 
If an alarm shows red, the PA needs servicing.

Supply voltage The PA can detect whether its power supply voltage is too high or too low.

Supply voltage 
low

The PA supply voltage is 26 V or less, probably because the battery is running 
low. The fault condition disappears when the voltage exceeds 26.1 V.

Supply voltage 
high

The PA supply voltage is 29 V or more.

1. The third party power supply is incorrectly configured. 

2. A voltage regulator has failed. 

Note: The base station is not type-approved for operation when the 
supply voltage is outside the specified range. 

Alarm Description

Driver high The driver is drawing excessive current. A fixed limit has been 
exceeded.

Final 1 The Final 1 output stage is drawing excessive current. A fixed 
limit has been exceeded.

Final 2 The Final 2 is drawing excessive current. A fixed limit has been 
exceeded.

Imbalance One of the final stages is drawing significantly more current 
than the other.
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Temperature high This group of alarms shows whether the temperature in the driver, Final 1, or 
Final 2 output stage has exceeded the configured threshold. If a temperature 
exceeds a built-in limit, the PA folds back its power output until the 
temperature is within the normal range.

To see the actual temperatures, select Diagnose > Modules > PA Control Tests. 

Power Management Unit
The Power Management Unit area shows the alarm status of the PMU that 
supplies the base station with power.

No PMU detected The reciter is unable to detect the PMU on the control bus. There may be a 
fault or the PMU may still be operating satisfactorily. However, the system has 
lost the ability to monitor PMU alarms, carry out diagnostics, change 
configuration, or detect PMU fan failure.

Invalid PMU 
firmware

The firmware in the PMU is invalid.

1. Use the CSS to download the firmware.

2. Return the PMU to Tait.

Fan failed The PMU told the reciter that its fan is on, but the reciter cannot detect fan 
motion. The base station takes no action when this alarm occurs, but it will act 
if the PMU temperature becomes too high.

The fan has failed. Replace it.

Mains supply 
failed

The mains power supply to the PMU is absent or its voltage is outside 
acceptable limits. The PMU is using DC power from its battery source. 

Power up fault The PMU has detected an internal error and will reset itself. If the reset is 
successful, the alarm will clear.

Shutdown 
imminent

This alarm only appears if the PMU has a DC-DC converter and a Standby 
converter. A battery is currently being used to power the base station and its 
voltage has fallen to the absolute minimum. The PMU will stop operating 30 
seconds after activating this alarm. 

The main value of this alarm is as an input for Task Manager actions. You can, 
for example, have the base station send the alarm log just before shutting down. 
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Temperature high One of the PMU temperature sensors has detected a temperature that is above 
the fixed limit. 

Battery The PMU measures the voltage of its battery input.

Battery protection 
mode

Battery protection mode is on. This happens when a base station is operating 
on mains power, but the battery voltage is still below the configured minimum. 
Battery protection mode requires a PMU with a standby converter. 

Battery voltage 
low

The battery voltage is below the configured minimum. This minimum may 
have been set to alert you to the risk of damage to the battery from 
overdischarge. If the voltage falls below a fixed minimum, the PMU 
automatically shuts down to protect the battery and base station equipment. 

If mains power fails when the PMU is in battery protection mode, the base 
station shuts down instead of using battery power. This protects the battery.

1. The system has been operating on battery power; the battery has become 
flat and mains is restored. No action required.

2. The battery is not being charged. Check the PMU’s auxiliary output line, if 
it is being used for charging.

3. The battery is flat. Replace it.

4. The minimum battery voltage is set too high. 

Battery voltage 
high

The PMU’s battery voltage is higher than the configured maximum. The base 
station takes no action until the voltage reaches the fixed maximum, when it 
shuts down. 

Output The PMU measures the voltage and the amperage of its DC output to the PA 
and to the reciter. 

Output current 
high

The PMU is providing more than 15 A of current and is automatically limiting 
its output, lowering the output voltage. There is a short circuit or the PMU is 
faulty.

Output voltage 
low

The PMU’s DC output (nominally 28 V) is lower than the fixed minimum of 
24 V.

Output voltage 
high

The PMU’s DC output (nominally 28 V) is higher than the fixed maximum of 
32 V. 

Reciter
The Reciter area shows the Alarm status of the reciter. 
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Channel invalid (Rare) The base station has received an instruction to select an invalid channel 
number and has stopped transmitting and receiving. 

The channel could be invalid for one of the following reasons:

1. The current channel definition no longer exists. 

2. Task Manager has selected a channel that no longer exists.

3. The channel definition has an invalid index to other information. For 
example, it specifies channel profile 3 when there is no such profile. 

Network board 
calibration invalid

The base station cannot operate properly because the analog line has not been 
calibrated, or because the calibration procedure has not been properly 
completed, deleting the old calibration value, but not storing a new value. This 
alarm is not triggered when the analog line goes out of calibration.

Use the Calibration Software to calibrate the analog line.

Network board 
configuration 
invalid

The configuration data has become corrupted. Open the corresponding 
configuration file stored on the CSS PC and program it into the base station.

Digital board 
calibration invalid

The base station cannot operate properly because the digital board does not 
have valid calibration settings. This could be because a calibration procedure has 
not been properly completed, deleting the old calibration value, but not storing 
a new value. This alarm is not triggered when the reciter goes out of calibration.

1. Use the Calibration Software to adjust the frequency setup.

2. Use the Calibration Software to fully calibrate the reciter.

3. Calibrate the reciter TCXO.

4. Replace the reciter. 

Digital board 
configuration 
invalid

The configuration data has become corrupted. Open the corresponding 
configuration file stored on the CSS PC and program it into the base station.

Power up failure The reciter has failed one or more of its initialization self-tests and has gone into 
Failure mode. The transmitter and receiver are disabled and any system interface 
outputs are deactivated. 

Note: This alarm will not show if the reciter cannot communicate 
with the CSS.

1. Reset the base station. This may clear the fault.

2. Send the reciter to a Service Center.

Temperature high The temperature of the reciter has exceeded the built-in threshold of 
162.5 deg F (72.5 deg C). To see more details about the reciter and its fan, 
select Monitor > Modules > Reciter.

1. The reciter fan has failed.

2. The reciter is not fitted with a fan and the combination of ambient 
temperature and duty cycle is too high for operation without a fan.

Synthesizer out of 
lock

The reciter has three different synthesizer alarms.

Synthesizer out of 
lock: Digital

One or more of the DSP and sampling clocks is out of lock. In response, the 
base station disabled the receiver and the transmitter.
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1. The base station is configured for an external reference of a particular 
frequency, but the actual frequency of the external reference is different. 

2. The master synthesizer is unable to lock onto the frequency. The base 
station will run, but the accuracy of its receive and send frequencies cannot 
be guaranteed. Send the reciter for repair.

Synthesizer out of 
lock: Exciter

The exciter synthesizer is unable to lock on to the frequency it is configured to 
operate at. In response, the base station disabled the transmitter.

1. Check that this frequency is within the exciter’s RF frequency range. 

2. Do a diagnostic test to determine the reciter’s switching range, and then 
check that the frequency is within the exciter’s switching range. 

3. If the frequency is outside the switching range, use the Calibration Software 
to alter the switching range. Otherwise send the reciter for repair.

Synthesizer out of 
lock: Receiver

The receiver synthesizer is unable to lock onto the frequency it is configured to 
operate at. In response, the base station disabled the receiver.

1. Check that this frequency is within the receiver’s RF frequency range. 

2. Do a diagnostic test to determine the lock range, and then check that the 
frequency is within that range. 

3. If the frequency is outside the lock range, use the Calibration Software to 
alter the switching range. Otherwise send the reciter for repair.

System
The System area displays alarms that are triggered by system conditions. These 
alarms do not indicate base station faults. You can set a threshold for these 
alarms if this is appropriate for your system. For example, set a suitable BER 
threshold to provide an alarm indicating problems with the linking 
infrastructure.

Air intake 
temperature

The base station is normally fitted with a sensor that measures the air 
temperature at the PA fan intake and determines whether it is above or below 
the configured limits.

Air intake 
temperature low

The temperature is below the configured minimum. The base station is not 
designed for operation below the default minimum.
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Air intake 
temperature high

The temperature has exceeded the configured maximum. The PA can sustain 
full-powered continuous operation at an air intake temperature of up to 60° C. 
Fan operation and PA power foldback are unaffected by this alarm; it is the 
heatsink temperature, not the air intake temperature, that turns a base station 
fan on or folds back PA power.

BER The base station estimates the BER, based on the amount of forward error 
correction it is carrying out on the digital RF it receives. If the estimate lies 
above the threshold set in Configure > Alarms > Network Thresholds, the 
alarm is triggered. 

BER high A high BER indicates that the quality of the received signal is poor, for example 
because the radio user is almost outside the base station’s coverage area. 

External 
Reference

The base station can detect whether an external reference is present and 
whether it is usable.

External reference 
absent

The base station cannot detect an external reference frequency source. It is now 
using its own source.

1. There is no external reference source. Many applications do not need one. 
You can disable the alarm (Configure > Alarms > Control).

2. The source has become unplugged.

3. The source is not working.

An external reference is critical for simulcast applications and for K-band 
operation.

External reference 
invalid

An external reference frequency is connected to the base station, but the base 
station cannot lock on to its channel frequency using that reference. It is now 
using its own source.

1. The base station is configured (Configure > Base Station > Miscellaneous) 
to expect a 10 MHz frequency, but the source is 12.8 MHz (or vice versa). 

2. The reference source is faulty.

Network Most network alarms give early warning that the network is becoming 
congested.

Network user 
traffic

Packets are taking too long to traverse the network. The Maximum round trip 
delay threshold has been exceeded.

QoS jitter The voice stream sent by this base station is experiencing a delay variation 
greater than the configured threshold when it arrives at one or more of the 
other base stations in the channel group.

QoS lost packets The number of packets lost has exceeded one or more of the configured 
thresholds.
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Disabling Unwanted Alarms

You can disable any of the base station’s alarms. Some alarms may not be 
appropriate for your system.

If you disable an alarm, it is disabled in the Alarm status form and it does not 
turn on the control panel alarm LED. However, the alarm still generates a syslog 
message, which the base station stores in its log and optionally sends to a syslog 
collector, but that message is downgraded to the level of Notice. In addition, 
any Task Manager tasks with that alarm as an input are still processed. 

For detailed information about individual alarms, see “Monitoring Alarms” on 
page 141.

To disable unwanted alarms

1. Select Configure > Alarms > Control. 

2. Clear the check boxes of the alarms to be disabled.

3. Click OK.
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Altering Base Station Alarm Thresholds

The Base Station Thresholds form (Configure > Alarms > Base Station 
Thresholds) lets you alter thresholds for base station alarms.

Some alarm thresholds are fixed; they are built in to the base station and cannot 
be changed. Others have default values and you may want to adjust them to 
better reflect your system’s operating conditions or monitoring procedures. 
This can be important if an alarm is used as an input in Task Manager tasks.

The Minimum column displays lower thresholds. The Maximum column 
displays upper thresholds. Most parameters have only one threshold. The read-
only Currently column displays the current value of the parameter to help you 
select a suitable threshold. 

To adjust a threshold, edit its value or click one of the adjacent arrows, and then 
click OK to confirm your changes and close the form. When the current value 
of a parameter goes above the maximum or below the minimum, the base 
station triggers the corresponding alarm. The alarms that these thresholds apply 
to are described in “Monitoring Alarms” on page 141. The equivalent Task 
Manager inputs are described in “Alarm Inputs” on page 184. 

PA

Power output The minimum value defines the lower limit for the PA forward power output. 
When the output falls below this limit, the base station triggers the alarm 
Forward power low and the Task Manager input PA forward power low 
becomes true.

Reverse power 
output

The maximum value defines the upper limit for the PA’s reverse power. When 
the reverse power exceeds this limit, the base station triggers the alarm Reverse 
power high and the Task Manager input Reverse power high becomes true. 

When using a 5 W PA, or any PA set to 20 W or less, disable this alarm and use 
the VSWR alarm instead. The resolution of the reverse power measurement is 
only 1 W, so the reverse power alarm would only trigger if there is a serious 
antenna fault. VSWR has a better precision and reliably detects load failure.
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VSWR The Maximum column defines the upper limit for the VSWR. When the 
VSWR exceeds this limit, the base station triggers the alarm VSWR high and 
the Task Manager input VSWR fault becomes true. The hysteresis is fixed at 
0.2. For example, if the threshold is 1.5:1, when the VSWR falls to 1.3:1, the 
alarm is cleared and the Task Manager input becomes false. 

Final temperature The Maximum column defines the upper limit for the operating temperature 
at the Final 1 and Final 2 stages of the PA. When the temperature exceeds this 
limit, the base station triggers one of the Temperature high alarms and the Task 
Manager input PA temperature high becomes true.

Driver 
temperature

The Maximum column defines the upper limit for the operating temperature 
at the driver stage of the PA. When the temperature exceeds this limit, the base 
station triggers one of the Temperature high alarms and the Task Manager input 
PA temperature high becomes true.

Air intake 
temperature

The Maximum column defines the upper limit for the air intake temperature 
that is measured at the PA. When the temperature exceeds this limit, the base 
station triggers the Air intake temperature high alarm and the Task Manager 
input PA air intake temperature high becomes true.

The Minimum column defines the lower limit for the air intake temperature 
that is measured at the PA. When the temperature falls below this limit, the base 
station triggers the Air intake temperature low alarm and the Task Manager 
input PA air intake temperature low becomes true.

PMU

Battery voltage The Minimum column defines the lower limit for the battery voltage that is 
supplied to the DC-DC converter. Different limits apply, depending on which 
nominal voltage the DC-DC converter is designed for. When the voltage falls 
below the relevant limit, the base station triggers the Battery voltage low alarm 
and the Task Manager input Battery voltage low becomes true.

The Maximum column defines the upper limit for the battery voltage that is 
supplied to the DC-DC converter. Different limits apply, depending on which 
nominal voltage the DC-DC converter is designed for. When the voltage 
exceeds the relevant limit, the base station triggers the Battery voltage high 
alarm and the Task Manager input Battery voltage high becomes true.

Both the upper and lower limits have a hysteresis of 0.1 V. 

Estimated BER
This area lets you set the alarm threshold for the bit error rate of the RF input. 
The BER is an estimate, because it is computed from the number of errors in 
the signal fixed by forward error correction. 

Threshold Defines the percentage bit error rate above which the BER high alarm is 
triggered. The default is 5%, which is about the limit at which forward error 
correction can still resolve errors.

Estimated BER Displays the current measured BER. 

Averaging period The time in seconds over which the BER is averaged. The default is 7 seconds 
(approximately one over).
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Altering Network Alarm Thresholds

The Network Thresholds form (Configure > Alarms > Network Thresholds) 
lets you modify the thresholds, mostly for measures of the quality of service of 
the network link to other base stations in the channel group. Generally, you can 
leave defaults as they are. When a threshold is exceeded, an alarm condition 
results. The aim of adjusting them is to ensure that alarms trigger before the 
quality of service deteriorates under network load, giving you some advance 
warning. 

Tip: Select Monitor > Interfaces > Digital Line to view current 
values for quality of service measures. These can help in the setting 
of appropriate thresholds.

Max loss per call The maximum allowable number of packets lost in one over. It is designed for 
detecting a sudden acute loss of service. The base station calculates the packets 
lost from a jump in the sequence number from one packet to the next. You can 
select up to 50, which is roughly equivalent to a gap of one second. If the 
threshold you set is exceeded, the base station raises the QoS lost packets alarm. 

 Max loss rate The maximum number of packets lost per RTCP interval (one second). If this 
is exceeded, the base station raises the QoS lost packets alarm. The maximum 
loss rate is designed for detecting a longer-term chronic degradation in quality 
of service.

Max interarrival 
jitter

The maximum allowable jitter for packets arriving at the network interface. 
The jitter is calculated for each over and if it exceeds this threshold, the base 
station raises the QoS jitter alarm.
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Logging

The Logging form (Configure > Alarms > Logging) lets you enable and 
configure the sending of some or all system log messages to a central syslog 
collector. Messages are sent in the syslog format.

Send syslog 
messages to 
network

Select this check box to have the base station send its log messages over the 
digital line.

Note: Syslog messages can cause voice drop-outs. A switched 
network does not have QoS and so cannot give voice packets 
priority. If the base station’s logging level is low (Notice or Trace), 

syslog messages may combine with voice to exceed the available bandwidth, 
causing voice drop-outs. See the Network Installation Guide for guidance on 
bandwidth allocation and syslog bandwidth requirements.

Log address Enter the IP address of a host running syslog collector software. Use dotted 
decimal notation. The base station will send its log messages to this address. 

Logging Level Select the lowest level of messages to be sent to the log address. All messages at 
or above this level will be sent. The different syslog message levels are as follows:

The advantage of selecting ‘Error’ is that the base station only sends messages if 
there is a problem. The loading on the linking infrastructure is minimal.

The advantage of selecting ‘Notice’ is that you do not lose the system log if the 
base station resets. The whole system log is sent to the syslog collector. If the 
base station resets, its system log is cleared. 

Level Description

Emergency Alarm conditions that make the base station unusable.

Alert Alarm conditions that require immediate action to prevent failure.

Critical Alarm conditions that indicate a trend towards failure, for example, 
high temperature.

Error Alarm conditions that indicate an error within the base station’s 
interfaces. 

Warning Events that do not affect behavior, but that may be of significance 
to operators or maintainers.

Notice Events that may be helpful to operators or maintainers. 

Trace Tait-internal messages. 
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You need to select ‘Notice,’ if you want to set the syslog collector up to respond 
if a base station fails. Each base station sends a ‘heartbeat’ message at level 
‘Notice’ to the syslog collector. If a base station fails, the syslog collector no 
longer receives the heartbeat and can raise the alarm.

You can select ‘Trace’ to provide the syslog collector with the maximum detail 
possible. This may be useful during system installation. 



TB9100 Customer Service Software User’s Manual   Diagnosing 155

Part G Diagnosing

Using the CSS, you can carry out diagnostic tests on the base 
station and its modules. For many tests, the base station must be 
in Standby mode. However, you can view any diagnostic form in 
Run mode.

Generally a diagnostic form displays relevant information, so that 
you can monitor base station status before, during, and after the 
test. Often you can combine different tests.

Some diagnostic tests check aspects of the base station. Others 
provide you with a simple function (for example, looping back 
the analog line) that facilitates setting up or troubleshooting the 
base station’s interface to external equipment. 

Topics

Carrying Out Diagnostic Tests

RF Interface

Receiver Tests

Measuring Received Signal Levels

Determining Synthesizer Lock Ranges

Transmission Tests

Providing Raw C4FM Data

Line Interfaces

Analog Line Tests

Testing Connections

System Interface Tests

Modules

PA Control Tests

PMU Control Tests

Control Panel Tests
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Carrying Out Diagnostic Tests

Most diagnostic tests are carried out in a similar way. The following gives 
general instructions on how to do it.

When you start a test, the base station uses its existing settings such as frequency 
and level, unless you enter different values. When you stop a test or it comes to 
an end, the base station always returns to the configuration it was in before the 
test began. For example, after making a test transmission at a manually selected 
frequency, the base station reverts to the frequency it was previously configured 
for. 

Some tests can only be carried out when the base station is in Standby mode. 
Colors in the square alongside the Start test button indicate the supported 
modes: yellow means Standby mode and green means Run mode. Hover the 
mouse over the square and a tooltip specifies the supported modes.

To carry out a diagnostic test

1. Connect to the base station. You can be remotely connected, but you do 
need to be on site to test the control panel and the speaker.

2. Click Diagnose.

3. In the navigation pane, select an item. The corresponding form appears.

4. In the form, check the base station’s current status.

5. If the rectangle alongside the Start Test button is yellow and gray, click 
Standby on the toolbar. 

6. Click Start Test. 

This either carries out the test or it enables other buttons on the form so that 
you can carry out a test. The item in the navigation pane turns red and the 
Start Test button changes to Stop Test. 

During the test, the base station will respond to any faults that occur (if, for 
example, the PA overheats, it will fold the power back) but there will be no 
alarm notification, because Task Manager is not active in Standby mode.

7. If desired, you can navigate to other forms to view monitoring screens, 
check the base station’s configuration. Some tests also allow you to 
simultaneously carry out other tests.

8. If necessary, click Stop Test to end the test (some tests end automatically). 
Selecting Run mode or disconnecting the CSS also ends the test. 
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RF Interface

The CSS lets you carry out a variety of tests on the connected base station’s RF 
interface. You can receive on any frequency and bandwidth, scan the switching 
range and display the signal strength, test synthesizer lock ranges, and transmit 
carrier, FM, or C4FM.

Receiver Tests
The Receiver form (Diagnose > RF Interface > Receiver) lets you carry out 
various tests on the TB9100 receiver.

Testing Receiver Operation
The Set receiver frequency test provides a quick way to check that the receiver 
is operating. You manually set the receiver frequency and do not need to alter 
the base station’s configuration. The test can be carried out on analog FM or 
digital P25 transmissions.

1. Connect an RF source to the reciter or arrange for a suitable radio to 
transmit a signal. 

2. Select Diagnose > Reciter > Receiver. In the Frequency box, enter the 
frequency you want to receive on. Alternatively, use the arrow buttons to 
shift the frequency up or down.

3. In the Channel Spacing box, select a value from the drop-down list.

4. On the toolbar, click Standby.

5. Click Start Test. 

The Current receiver values area displays information about the received 
signal.

The Synthesizer LED indicates whether the receiver synthesizer managed to 
lock onto the frequency. The Receive frequency box displays the receiver’s 
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current operating frequency. The current RSSI and SINAD are also dis-
played.

Note: The SINAD is approximate and is obtained by measuring the 
out-of-band noise. This value should not be relied upon to make 
calibrated measurements. 

Note: The speaker may not give any indication that a signal has been 
received.

6. If desired, modify the receive frequency by clicking the up or down arrows. 
(You can repeat this as often as you want.)

The End Test button turns into a disabled Starting Test button until the new 
frequency has been tested. The form now displays the new values. 

7. Click Stop Test when you are finished.

Testing Receiver Sensitivity
You can carry out a basic test of the receiver’s sensitivity without using test 
equipment. The test only works if a 50 ohm load is connected to the receiver’s 
RF input and no RF signal is being received. You can set this up by connecting 
up a test set and switching its RF off.

1. Disconnect the receive antenna and connect a 50 ohm load.

2. Select Diagnose > RF Interface > Receiver. 

3. On the toolbar, click Standby.

4. Click Start Test. The box alongside indicates whether the receiver passed 
or failed the test. The test is carried out at the frequency and channel spacing 
defined by the current channel. 

If the test result is ‘fail’ and the receiver was not receiving any RF, the 
receiver front end is not properly tuned and/or the RSSI calibration is inac-
curate. Use the calibration software to tune the receiver front end and re-
calibrate the RSSI.
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Measuring Received Signal Levels
You can measure the strength of RF signal that the base station receives across 
a band of frequencies. A bar graph displays the results. 

This test lets you see what signals are out there; it does not determine the 
receiver’s sensitivity.

To measure signal levels

1. Select Diagnose > Reciter > Signal Level.

2. In the Center frequency box, specify the middle frequency of the band 
you want to test. This can be any frequency within the receiver’s switching 
range.

3. In the Channel spacing box, select a value from the drop-down list. This 
specifies the size of the step from one frequency to the next. If this 
corresponds to the channel spacing, you will measure signal levels of the 
different channels in the band.

4. Under Peak hold, select On if you want the display to show the strongest 
signal received on any pass. This means signals from infrequent users are 
more likely to be included. Select Off if you want to see only the results of 
the most recent pass.

5. On the toolbar, click Standby.

6. Click Start Test. The base station sets the receiver to a frequency, measures 
the RSSI, increments the frequency by the value in the Channel spacing 
box, measures its RSSI and so on for 101 steps below and above the center 
frequency you specified. Once it has completed a pass over all 101 
frequencies, it begins the next pass. You can leave the test running as long 
as you wish.
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7. Click End Test to stop the test. 

The graph displays the measured RSSI values and annotates the x-axis with 
the correct frequency values. The data is automatically saved to a file 
(signal_level_log.csv) in the LogFiles folder. You can open this file in a 
spreadsheet program. 

Determining Synthesizer Lock Ranges
You can test the reciter’s synthesizers to determine the range of frequencies that 
the receiver and the exciter can operate on. Use these tests to check that the 
reciter is calibrated correctly for the channels that it will operate on.

The Clock source box indicates whether the reference frequency is internal 
or external to the base station.

The bottom group of boxes with LEDs indicate the lock status of various parts 
of the reciter in its current operation.

To test the exciter or receiver lock range 

1. Select Diagnose > Reciter > Synthesizers.

2. On the toolbar, click Standby.

3. Click Start Test in the Exciter synthesizer or Receiver synthesizer area. 

The exciter or receiver checks all the channel frequencies in the band that 
the base station is type-approved to operate in.

4. In the Lower Frequency and Upper Frequency boxes, view the results 
of the test. These values report the range within which the synthesizer is able 
to lock onto the specified frequency. 

Note: The reported ranges are conservative. In fact, the base station 
will be able to transmit and receive outside the range, but with 
reduced transmit output and receive sensitivity. 

5. Click Stop Test. The exciter and receiver frequencies revert to what they 
were when you started the test.
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Transmission Tests 
The Transmission form (Diagnose > Power Amplifier > Transmission) lets you 
set up and start a carrier-only test transmission. If desired, you can modulate the 
carrier by starting a FM test or a C4FM test while this carrier test is running. 

Tip: Alternatively, test the transmitter by pressing the Carrier button 
on the control panel. This transmits using the current configuration.

Carrier The Carrier area lets you configure and start a test transmission. Initially, it 
displays values from the current channel configuration.

Transmitter 
output

The Transmitter output area displays forward and reverse power gauges, and 
lets you choose whether to view the values as watts or dBm. Underneath is the 
VSWR.

FM The FM area lets you configure and start FM modulation, once a Carrier test is 
running.

Note: If the current channel profile disables the transmitter (see “RF 
transmit” on page 103), you can still carry out a carrier test and a FM 
test, but not a C4FM test. 

Carrier Test
To test the base station’s ability to transmit carrier, follow these steps.

1. Select Diagnose > RF Interface > Transmission Tests.

2. In the Transmitter frequency box, enter a frequency or use the arrows to 
increment or decrement the current frequency.

Important: Do not select a prohibited frequency. For example, 
406.0-406.100 MHz is reserved internationally for distress beacons.
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3. In the Power box, specify the RF output power that the test will run at. 
The box to the right displays the equivalent power in dBm.

Important: Check the transmit frequency and RF power output 
before beginning the test. In the TB9100, the transmission test does 
not default to the currently configured frequency and power. Make 

sure you do not inadvertently transmit on someone else’s frequency.

4. Wait until the base station is not busy, to avoid interrupting a conversation, 
go to Standby mode, and then click Start Test. 

The PA outputs an RF signal on the RF Out N-connector. The Trans-
mitter output area gives you a graphical display of the forward and reverse 
power and the VSWR.

5. If desired, you can modulate the carrier using FM (see “FM Test” on 
page 163) or C4FM (see “C4FM Test” on page 163).

6. Click Stop Test at any time to end the test. 

FM Test
To test the base station’s ability to transmit carrier modulated with analog FM, 
you run a Carrier test, then start an FM test to add analog FM modulation to 
the carrier. Follow these steps.

1. Under Carrier, start a Carrier test (see “Carrier Test” on page 162).

2. Under FM, configure FM modulation as follows.

a. In the Deviation box, select a maximum transmit deviation.

b. In the Modulation level box, specify what percentage of the maximum 
deviation the test tone will have.

c. In the Modulation frequency box, specify the frequency of the tone 
that will modulate the test signal. 

3. Under FM, click Start Test. 

C4FM Test
To test the base station’s ability to transmit carrier modulated with C4FM, the 
digital P25 standard’s modulation scheme, you run a Carrier test, then start a 
C4FM test to add C4FM modulation to the carrier. Follow these steps.

1. Under Carrier, start a Carrier test (see “Carrier Test” on page 162).

2. Under C4FM, click P25_Conformance1011 Hz in the Test pattern 
box. This defines a fixed pattern of bits which are transmitted using C4FM 
and which result in a test tone of 1011 Hz at the receiver vocoder. The 
receiving radio must be configured for the default NAC (0x293).

3. Under C4FM, click Start Test. 
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Conformance Tests
To make test transmissions in order to test the base station’s transmitter or 
another receiver for conformance to the P25 standard, follow the instructions 
for a C4FM test (“C4FM Test” on page 163), but select a different test pattern. 
The results you obtain can be compared with the results on the factory test 
sheet.

The following test patterns are available:

For more details about these tests, see the Project 25 standards document TIA-
102.CAAA-A 

Providing Raw C4FM Data
The Miscellaneous form lets you tell the base station to start providing output 
from the receiver as raw C4FM data. 

1. Select Diagnose > RF Interface > Log C4FM.

2. In the Log box, specify whether the data is sent to a syslog collector (at 
severity level Trace) or to the serial port. The serial port baud rate is set to 
19,200 for the duration of the logging, overriding the configured setting. 

3. Click Start log. 

Option Description

C4FM_V52BER A standard transmitter test pattern used to check a receiver’s BER.

C4FM_ModulationFidelity Standard Transmitter C4FM Modulation Fidelity Pattern. The transmitter 
output is sent directly to test equipment to check the accuracy of the base 
station’s radio modem. 

P25_ConformanceSilence Standard Silence Test Pattern. Used for testing a receiver. When this pattern 
is decoded, there should be no sound from the receiver.

P25_Conformance1011Hz Standard Tone Test Pattern. Presents a 1011 Hz tone at the receiver vocoder. 
The default NAC is embedded in the test pattern so the receiver must be 
configured with this NAC. 

P25_StdDeviation Transmits the dibits 11 and 01 using the C4FM modulation scheme. The 
test is used to measure the bandwidth used when transmitting the dibits 
with the greatest frequency offset.

P25_LowDeviation Transmits the dibits 10 and 00 using the C4FM modulation scheme. The 
test is used to measure the bandwidth used when transmitting the dibits 
with the least frequency offset. With this test pattern, a standard frequency 
counter can be used to measure the frequency of the transmitter’s carrier.

SerialInput Transmits the bit pattern received on the base station’s antenna to the serial 
input.
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Line Interfaces

The CSS lets you carry out a range of tests on the analog and digital lines, the 
digital inputs and output, the E & M lines, and the serial port.

Analog Line Tests
The CSS lets you carry out transmit and loopback tests on the analog line. You 
can also monitor line levels. 

Sending a Test Tone
The reciter can output an audio test tone. You can use this to test the reciter's 
ability to output audio on its analog line or to set up and configure the interface 
from external equipment to the base station. 

1. Select Diagnose > Line Interfaces > Analog Line.

2. Under Transmit, enter the desired test tone frequency into the Frequency 
box.

3. In the Level box, enter a level in dBm.

4. Click Start Test.

5. View the Monitor area to verify that the base station is sending the test 
tone. 

6. Adjust the external equipment as required.

7. Click Stop Test to end the test.
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Monitoring Line Levels
The reciter can measure the mean levels of the current analog line input and 
output and display them on the CSS. 

You can use this diagnostic tool in the following situations:

Troubleshooting: the measurement shows you whether audio is arriving at 
the base station. 

Adjusting the audio output of other equipment such as a console. 

Note: If you don’t want audio input during the test to be 
transmitted, put the base station into Standby mode.

To monitor audio levels

1. Make sure that the analog line is connected. 

2. Select Diagnose > Line Interfaces > Analog Line.

The bars display the average levels for audio that the base station sends and 
receives on the analog line. Levels are measured over a window of 500 ms 
and updated twice a second. The base station cannot actually measure values 
at the analog line interface: it measures them in the digital domain and com-
pensates for calibration and line level adjustment effects.

Looping Back Audio
You can loop audio back on the analog line (this simply connects the audio in 
line to the audio out line). When the audio is looped back, you can, from the 
dispatch console end of the audio line, check on line levels or check that the 
line works in both directions. 

To loop back the analog line

1. Make sure that the analog line is connected.

2. Select Diagnose > Line Interfaces > Analog Line.
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3. On the toolbar, click Standby.

4. In the Loopback area, click Start test. The State box now displays 
Enabled. 

5. When you have finished testing the analog line, click Stop test. The State 
box now displays Disabled.

Testing Connections
The CSS supports the use of the ping command to test whether there is an IP 
connection to any entity with an IP address. In this way, you can test the IP/
Ethernet links to routers and other base stations in the TaitNet P25 network. 
You can also use multicast IP addresses to check the membership of a channel 
group.

To carry out a ping test

1. Select Diagnose > Line Interfaces > Connections.

2. In the Destination IP address box, enter the IP address of the destination 
host. Use dotted decimal notation, for example 172.25.206.26.

3. Click Ping.

The CSS instructs the base station to send a ping command to the IP address 
you entered. Responses are displayed in the large Response box and the 
number of responses in the small Responses box below.

System Interface Tests
The System Interface form (Diagnose > Line Interfaces > System Interface) lets 
you work with digital inputs and outputs. You can view the current state of all 
digital inputs and toggle the digital output to help you test any equipment 
connected to it. This can be done on site or on the bench when the base station 
is connected to a CTU. 

The Digital inputs area displays the current settings of digital inputs. 

The Digital outputs area lets you toggle the single digital output.

The area below displays the current state of the E line and M line and lets you 
toggle the M line output.

The Computed input value area displays the binary number that is currently 
set by the digital input lines. This value is used as a Task Manager input.

Testing Digital Inputs
The Digital inputs area displays the current state of all digital inputs to the 
reciter. 

A digital input can be high (green LED) or low (red LED). 
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To test a digital input

1. Select Diagnose > Line Interfaces > System Interface.

2. Using the equipment connected to the digital input, toggle the state of that 
input.

Note: If digital input 4 is not available (through configuring pin 1 as an output), 
ignore its display.

3. In the Digital inputs area, check that the state of that input changed. 

Testing Digital Outputs
If the system interface is configured to provide a digital output, you can toggle 
that output between high and low. Pin 9 can provide digital output 0 and pin 1 
can provide digital output 1. Use this test to make sure that the output is 
working and to check that any equipment attached to that output responds as 
intended.

To test a digital output

1. Select Diagnose > Line Interfaces > System Interface.

2. Click Start Test. This enables the Toggle buttons in the Digital outputs 
area. This area now displays the output states as they were when you started 
the test.

3. Click the digital output’s Toggle button to change its state.

When the output is high, its LED is green. When it is low, the LED is red.

4. Check the response of any attached equipment.

When you have finished testing the outputs, click Stop Test. This returns all 
digital outputs to the state they were in when you started the test.

Testing the E & M Lines
The base station can be configured to use the E & M lines on the RJ45 
connector to carry channel seize and analog valid signals (Configure > Base 
Station > System Interface). 

Digital Input Pin number

0 4

1 6

2 7

3 8

4 1
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To test the E & M lines

1. Select Diagnose > Line Interfaces > System Interface.

2. Click Start Test. 

3. Using the equipment (for example the Tait CTU) connected to the E line, 
toggle the state of that input.

4. In the E wire input box, check that the state of the E line changed. 

5. Click the Toggle button alongside the M wire output box.

6. Check the equipment to verify that the state of the M line changed.

Viewing the Computed Input Value
The Computed input value area (Diagnose > Line Interfaces > System 
Interface) indicates the number of bits that the base station is using to compute 
its input value as well as the computed value itself. The former is a configurable 
item (Configure > Base Station > System Interface) and the latter can be used 
as a Task Manager input to trigger desired actions such as changing channel. 
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Modules

The CSS lets you carry out various tests on base station modules. You can 
toggle fans, simulate a mains failure, and test the controls on the control panel.

PA Control Tests
The PA Control Tests form (Diagnose > Modules > PA Control Tests) lets you 
test the PA fan and front panel fault LED. 

The PA Control Tests form provides you with information about the PA before 
you carry out any tests.

LED Indicates whether the PA has any current faults. 

State Indicates whether the fan is currently active.

Current 
temperature

The Current temperature area displays four thermometers that monitor the four 
PA temperature sensors.

Testing the PA Fault LED
You can test that the LED on the front of the PA is able to light up. (This LED 
is only visible when the front panel is removed.) 

1. Select Diagnose > Modules > PA Control Tests. 
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2. Click Start Test. This uncouples the fault LED from the PA’s operational 
logic and flashes the LED on and off continuously.

3. Verify that the PA fault LED is in fact flashing.

4. Click Stop Test to end the test. 

Testing the Fan
You can ask the base station to turn the PA fan on and off. This tests the fan 
and its control circuitry.

Test the fan after fixing a fan problem or fitting a new fan. When you fit a fan, 
use this test to verify that the fan is correctly connected, so that the PA (and not 
the PMU) activates it. 

Note: The base station can detect the motion of 3-wire fans and will 
raise an alarm if the fan does not operate.

To test the fan

1. Select Diagnose > Modules > PA Control Tests. 

2. Click Start Test. This uncouples the fan from the base station’s control but 
leaves it in its current state.

3. Click Toggle Fan. If the fan was off, this should turn it on.

4. Check that the fan is operating. A 5-second timer counts down. When it 
expires, the test ends and control of the fan reverts to the base station. 
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PMU Control Tests
The PMU Control Tests form lets you simulate a mains failure. You can also 
check that the fan, the fault LED, and the auxiliary output are working. 

Simulating Mains Failure
The Control Tests form lets you simulate a mains failure so that you can test the 
base station’s battery backup and the PMU’s DC-DC converter. The test can 
only be run if there is a DC power supply. 

To simulate mains failure

1. On the toolbar, select Standby.

2. Select Diagnose > Modules > PMU Control Tests.

3. Click Mains Failure Test.

The State LED should go off, indicating that mains power is no longer avail-
able to the base station. 

4. Verify that the base station is still operating.

5. To end the test, click End Test.

Testing the Fan
You can ask the base station to turn the PMU fan on and off; this tests the fan 
and its control circuitry.

Test the fan after fixing a fan problem or fitting a new fan. When you fit a fan, 
use this test to verify that the fan is correctly connected, so that the PA and not 
the PMU activates it. 

Note: The base station can detect the motion of 3-wire fans and will 
raise an alarm if the fan does not operate.
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To test the fan

1. Select Diagnose > Modules > PMU Control Tests.

2. Click Start Test.

3. Click Toggle Fan. 

4. The State LED should change from On to Off, or from Off to On. 

After ten seconds, the test automatically ends and the base station takes back 
control of the fan. 

Testing the Auxiliary Power Output
If the PMU is fitted with an auxiliary power supply submodule, you can test 
the PMU’s ability to switch its auxiliary output on and off.

Note: The auxiliary power output must be on. If it is configured to 
be on only when the PMU uses mains power, make sure that the 
PMU is not using battery power.

To test the auxiliary power output

1. Select Diagnose > Modules > PMU Control Tests.

2. Go into Standby mode.

3. Under Auxiliary power output, click Start Test.

4. Click Toggle output.

The state of the LED should change.

5. Click Stop Test.

Testing the PMU fault LED
You can test that the fault LED on the front of the PMU is able to light up. 
(This LED is only visible when the front panel is removed.)

1. Select Diagnose > Modules > PMU Control Test.

2. Click Start Test to the left of the PMU fault LED. This uncouples the LED 
from the PMU’s operational logic.

3. Check that the PMU LED flashes on and off. (The control panel LED 
should also light up, unless all PMU alarms are disabled.) 

4. Click Stop Test to restore the LED’s connection with the PMU. 
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Control Panel Tests
The Control Panel form (Diagnose > Modules > Control Panel) lets you carry 
out tests to verify that the controls on the front of the base station are working. 
You need to be at the base station site to carry out these tests.

To test control panel buttons

1. Under Button test, click Start Test. This disables all control panel functions. 
The base station will now pass control panel inputs to the CSS. 

2. Press a button on the control panel. 

Note: The right-hand Speaker and Carrier buttons are currently not 
used.

3. Check that the corresponding LED in the CSS form turns green.

4. Repeat steps 2 and 3 for each other button you want to test.

5. Click Stop Test to conclude the test. 

To test the microphone’s PTT button

1. Under Button test, click Start Test. This disables all control panel funct-
ions. The base station will now pass any control panel inputs to the CSS. 

2. Press the PTT button on the microphone.

3. Check that the PTT button LED in the CSS form turns green.

4. Click Stop Test to conclude the test. 

To test the control panel LEDs

1. Under LED test, click Start Test.

2. Check that each of the control panel LEDs is going on and off in a 
recognizable sequence.

Note: The Power LED is not affected by this test.

3. Click Stop Test to conclude the test. 

To test the speaker

1. Under Speaker test, click Start Test.

2. Turn up the volume and listen to confirm that a 700 Hz test tone at 0 dBm 
is coming from the speaker.

3. Click Stop Test to conclude the test. 
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Part H Task Manager

The CSS is your window into Task Manager. You can view the list 
of tasks, create new tasks from the available list of inputs and 
actions, and create custom inputs and actions. 

You can also monitor recent Task Manager actions and disable 
any tasks that may be causing problems. 

Topics

Working With the Task List

Inputs

Actions

Task Manager Examples

Customizing Task Manager

Monitoring Task Manager
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Introduction to Task Manager

Task Manager operates like this. When the base station is in Run mode, Task 
Manager processes its task list every 10 ms. If a task’s input has become true, its 
action is calculated. Once Task Manager has completed processing its task list, 
it makes the results available to other firmware processes. When the next 10 ms 
interval is reached, Task Manager begins again with the next processing cycle.

To change the way Task Manager works, you add new tasks or modify existing 
tasks, and then you program the changes into the base station. In effect, you are 
creating scripts that make the base station perform simple actions. This 
customizes the way the base station operates without modifying its firmware. 
Task Manager can perform many functions that previously required expensive 
external equipment. 

Task Manager Rules
If you are going to be writing your own sets of tasks, be aware of the following 
rules that define the way Task Manager processes tasks.

A task is only carried out if its input changes. For example, when the base 
station is in Run mode, the task IF base station in Run mode THEN 
Increment counter 1 is not carried out. Counter 1 only changes when the 
base station goes into Run mode, because it is only then that the input 
changes from false to true.

Tasks often need to be created in pairs. For example, if you want to set the 
digital output high in response to an input, you also need to set it low when 
that input becomes false. Otherwise the output goes high and always stays 
high. 

IF Analog received THEN Set digital output high
IF NOT Analog received THEN Set digital output low

Tasks are evaluated in the order of the task list. 

External inputs (for example, alarms) never change in the middle of 
processing the task list. Changes to these inputs are queued until Task 
Manager finishes processing the task list. For example, if an alarm is triggered 
while Task Manager is in the middle of the task list, the equivalent alarm 
input does not change until the beginning of the next processing cycle.

Internal inputs (for example, locks) can change in the middle of processing 
the task list. For example, if a task unlocks automatic CWID, a task later in 
the list with the input ‘IF automatic CWID unlocked’ will be processed in 
the same processing cycle.

Tasks that are in the General folder are always processed if their input 
becomes true. Tasks that are in a channel profile or signaling profile folder 
are only processed if the current channel uses that profile. 
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Processing Cycle
To help reduce the amount of processing that Task Manager must do, the base 
station does some additional processing when an input is changed. All Task 
Manager tasks with that input are flagged “must be evaluated” and a flag “an 
input has changed” is set. This processing is done as soon as the input changes. 

At the 10 ms tick, Task Manager begins its processing cycle. First it checks the 
flag “an input has changed.” If no input has changed, it stops and waits for the 
next 10 ms tick. If at least one input has changed, it goes through the task list. 
First it checks whether a task has been flagged “must be evaluated.” If it has, 
Task Manager processes that task, determining the action to be taken. This is 
made available to other software processes as soon as the whole task list has been 
processed.

10 ms
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any input
changed?'

Get next task

Must task be
evaluated?

Is input true?

Perform task
action Log task
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Any more
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Input Types
Task Manager inputs are of two main types, ‘basic’ and ‘lock.’ Tasks are 
processed differently, depending on the kind of input they have. You need to 
understand these differences if you are creating complex sets of tasks.

Basic inputs Basic inputs come from various parts of the base station. They include all alarms. 
While basic inputs can become true at any time, Task Manager will only process 
them in the course of the regular 10 ms processing cycle. For example, if an 
input becomes true in the middle of a processing cycle, Task Manager won’t 
process tasks with that input until the next processing cycle. This is because it 
only learns of the change after the completion of the first cycle. 

Lock inputs Lock inputs such as ‘Receiver unlocked’ can only become true through a Task 
Manager lock action. They are internal to Task Manager. Most become true 
automatically each time the base station enters Run mode. 

Action Types
Task Manager actions are of two main types, ‘lock’ and ‘do now’. These actions 
have different effects. 

Lock actions Lock actions lock, unlock or toggle a base station function. By default, functions 
are unlocked (except for the Auxiliary Supply). When Task Manager locks a 
function, that function cannot operate. The lock status of these functions is 
displayed in Monitor > Task Manager > Locks. 

Task Manager tasks can have lock actions as an input. When Task Manager 
unlocks a function (for example automatic CWID), the equivalent input (in this 
case Automatic CWID unlocked) becomes true and any tasks with that input 
will be processed. 

’Do now’ actions ‘Do now’ actions issue a command to the base station to do something 
immediately, for example to change channel or send the alarm log. This is a 
one-off action which has no continuing effect on the base station’s status. A ‘do 
now’ action cannot be re-triggered until the original action is completed. For 
example, Task Manager cannot carry out the action Transmit CWID now 
when the base station is still transmitting the CWID from a previous Transmit 
CWID now action. 

Custom Inputs and Actions
A task can only have one input and one output. However, you can combine 
existing inputs or actions to form your own custom inputs or actions. 

A custom input combines up to eight different inputs. It becomes true when 
the combination becomes true, according to the rules of the Boolean logic that 
you specify for the combination.

Similarly, a custom action can combine up to eight actions. When a task with 
a custom action is processed, all its constituent actions are carried out. 

You can also use counters, timers, and your own flags when defining tasks.
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Working With the Task List

The Task List form (Configure > Task Manager > Task List) lets you work 
with the task list that the Task Manager processes. You can view the task list, 
add new tasks, modify existing ones, and rearrange the order and structure of 
tasks. Generally, a set of tasks is headed by a comment indicating their nature 
and purpose. Comments have no effect on Task Manager processing. 

The Task list item area lets you edit a selected item, which can be a task or a 
comment. When a task is selected, you can click one of the special Help icons 
to display information about the task’s input or action. The area also indicates 
the total number of enabled tasks.

The task list displays tasks in folders. Double-click a folder (or click its +/- icon) 
to open or close it. An open folder displays the tasks and comments that belong 
to it. Tasks generally have a tick; this means that they are enabled; tasks with a 
cross have been disabled. Click an item to select it; it appears inside the Task 
List Item area. 

The folders group related tasks. Tasks in a folder for a particular profile (for 
example, the default channel profile, or Signaling profile 1) are only processed 
if the current channel uses that profile. 

The buttons to the right lets you maintain the tasks in the list. For example, you 
can add an item or modify the selected item.
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Maintaining the Task List
In Task Manager forms, the buttons to the right of the task list help you 
maintain the task list. To use some buttons, you must first select a task list item 
by clicking it. 

<<Update Item Saves changes you made to the selected item and updates the display in the Task 
List.

<<Insert Item Inserts the task displayed in the Task list item area just below the selected item 
in the task list. See also “Adding a Task” on page 182.

Delete Item The Delete button deletes the current task list item.

Custom Actions Opens the Custom Actions form, where you can define your own combination 
of existing actions. 

Custom Inputs Opens the Custom Inputs form, where you can define your own combination 
of existing inputs. 

Move Up / Move 
Down

Shift the selected item up or down one line. Use these buttons to rearrange the 
order of tasks and comments in the task list.

Increase Indent / 
Decrease Indent

Let you add or remove an indent from a selected task. Indents have no effect 
on Task Manager processing; they help to make tasks easier to read and 
understand. You can only indent tasks that are under a comment. 

Enable / Disable By default, tasks are enabled; when an input condition becomes true, Task 
Manager processes the task. The Enable / Disable button lets you disable a task 
so that it has no effect, or toggle it between enabled and disabled. 

Enabled Displays the total number of enabled Task Manager statements. You can have 
up to 200 enabled tasks. 

Disabled Displays the total number of disabled Task Manager statements. The total 
number of statements (enabled and disabled) must not exceed 400.

Comments Displays the total number of Task Manager comments. You can have up to 100 
comments.
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Adding a Task
To make full use of the base station’s capabilities, you need to add your own 
tasks to the list that Task Manager processes. This enables Task Manager to 
respond to events in a way that is tailored to your system. However, the set of 
actions must be well thought out to operate in exactly the way you want. 

Important: It is possible to create tasks that undermine the base 
station’s ability to operate properly. Make sure that the choices you 
make are appropriate. Be particularly careful with powerful actions 

such as Lock transmitter. 

Important: While Tait has carefully tested each input and each 
action, it is not possible to test the enormous number of possible 
combinations of inputs and actions. Thoroughly test any tasks you 

add before commissioning the base station. If you are uncertain about anything, 
refer to your supplier.

You can add a task anywhere in the task list. The order of tasks in the task list 
represents the order that they are processed in. 

Note: Tasks in a channel profile or a signaling profile folder will only 
be processed if the current channel has that profile assigned to it.

To define a task

1. Select Configure > Base Station > Task Manager.

2. In the task list, click a task or comment below which you want to add the 
task. Alternatively, click a folder. 

3. Select Task in the Task list item area.

4. In the drop-down text box, select IF. 

Alternatively, if you want the task to be processed when the input condition 
goes from true to false, select IF NOT. For example, tasks with the input 
‘IF NOT Rx Gate valid’ will be processed when the base station stops 
receiving a RF signal that fulfils all the gating requirements.

5. Position the mouse cursor over the next drop-down box and click to open 
the list of available inputs.

6. Select an input from the list. It appears in the box.

7. In the same way, select an action from the drop-down list of the last drop-
down text box. 

8. Click <<Insert Item. The task appears in the task list. 

9. If necessary, use the buttons on the right to move the task up or down, or 
to indent it.
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Adding a Comment
When you define a set of tasks, you need to provide a comment that names 
them and indicates what they are for and how they work. You may also want 
to add further comments on individual tasks.

To add a comment

1. Select Configure > Base Station > Task Manager.

2. In the task list, click the task above which you want to add the comment. 
Alternatively, click a folder. 

3. In the Task list item area, select the Comment option. 

4. Inter the text of the comment into the box below.

5. Click <<Insert Item. The comment appears in the task list.

6. If necessary, use the buttons on the right to move the comment up or down, 
or to indent tasks under it.

7. Click OK to confirm your changes and close the form.

Disabling a Task
You can disable any task in the task list. This is an easy way to stop Task 
Manager doing something you don't want it to do. (When the base station is in 
Standby mode, Task Manager is disabled and no tasks are executed.)

To disable a task

1. In any Task Manager form, click a task.

2. Click Enable/Disable. The tick at the beginning of the task turns into a 
cross.

Tip: Disable a comment to disable all tasks indented under that 
comment.
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Inputs

An input is anything that Task Manager monitors. When the state of that input 
changes from false to true, Task Manager executes tasks with that input. IF 
NOT tasks are executed when the state of the input changes from true to false. 

To select an input

1. In the Task list item area, click in the Task input box. A menu with 
several submenus appears.

2. Click on an item in the menu or submenu.

To obtain Help on the input of a task

1. In the task list, click the task. The task appears in the Task list item area.

2. Click the Help button beside the Task input box.

Alarm Inputs
You can select any alarm as a Task Manager input. This makes it possible to 
individually configure the base station's response to any alarm. For information 
about base station alarms, see “Monitoring Alarms” on page 141. All alarms are 
basic inputs. Even if an alarm is disabled in the Alarm Control form, tasks with 
that alarm as an input will be processed.

Base station alarm on
This input becomes true when any base station alarm is triggered. 

Battery protection mode on
This input becomes true when the PMU is operating in battery protection 
mode, triggering the ‘Battery protection mode’ alarm. For information about 
this alarm, see “Battery protection mode” on page 145. 

Battery voltage high
This input becomes true when the ‘Battery voltage high’ alarm is triggered. For 
information about this alarm, see “Battery voltage high” on page 145. 

Battery voltage low
This input becomes true when the ‘Battery voltage low’ alarm is triggered. For 
information about this alarm, see “Battery voltage low” on page 145. 

Channel invalid
This input becomes true when the ‘Channel invalid’ alarm is triggered. For 
information about this alarm, see “Channel invalid” on page 146. 

External reference absent
This input becomes true when the ‘External reference absent’ alarm is triggered. 
For information about this alarm, see “External reference absent” on page 148. 
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External reference invalid
This input becomes true when the ‘External reference invalid’ alarm is 
triggered. For information about this alarm, see “External reference invalid” on 
page 148. 

Fan failed
This input becomes true when the PA or PMU ‘Fan failed’ alarm is triggered. 
For information about these alarms, see “Fan failed” on page 142 for the PA or 
“Fan failed” on page 144 for the PMU. 

Invalid channel selected
This input becomes true when Task Manager has selected a channel that is 
invalid. 

Network board alarm on
This input becomes true when any network board alarm is triggered.

Network board BER high
This input becomes true when the BER high alarm is triggered. For 
information about this alarm, see “BER high” on page 148.

Network board invalid calibration
This input becomes true when the Calibration invalid alarm is triggered. For 
more information, see “Digital board calibration invalid” on page 146.

Network board invalid configuration
This input becomes true when the Configuration invalid alarm is triggered. For 
more information, see “Digital board configuration invalid” on page 146.

Network board network usage traffic fault
This input becomes true when the Network user traffic alarm is triggered. For 
more information, see “Network user traffic” on page 148.

Network board QoS Jitter
This input becomes true when the QoS jitter alarm is triggered. For more 
information, see “QoS jitter” on page 148.

Network board QoS lost packets
This input becomes true when the Lost packets alarm is triggered. For more 
information, see “QoS lost packets” on page 148.

No PA detected
This input becomes true when the ‘No PA detected’ alarm is triggered. This 
occurs when the module fails or control bus communications are disrupted. For 
information about this alarm, see “No PA detected” on page 142.

No PMU detected
This input becomes true when the ‘No PMU detected’ alarm is triggered. This 
occurs when the module fails or control bus communications are disrupted. For 
information about this alarm, see “No PMU detected” on page 144.
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PA air intake temperature high
This input becomes true when the ‘Air intake temperature high’ alarm is 
triggered. For information about this alarm, see “Air intake temperature high” 
on page 148. 

PA air intake temperature low
This input becomes true when the ‘Air intake temperature low’ alarm is 
triggered. For information about this alarm, see “Air intake temperature low” 
on page 147. 

PA alarm on
This input becomes true when any PA alarm is triggered.

PA current fault
This input becomes true when any of the PA’s current alarms are triggered. 
This happens if any part of the PA is drawing excessive current, or if one final 
stage uses significantly more current than the other. For information about these 
alarms, see “Current” on page 143.

PA forward power low
This input becomes true when the ‘Forward power low’ alarm is triggered. For 
information about this alarm, see “Forward power low” on page 142. 

PA is shut down
This input becomes true when the PA’s ‘Shutdown’ alarm is triggered. For 
information about this alarm, see “Shutdown” on page 143. 

PA power foldback
This input becomes true when the PA’s ‘Power foldback’ alarm is triggered. For 
information about this alarm, see “Power foldback” on page 143. 

PA supply voltage fault
This input becomes true when one of the PA’s power supply voltage alarms is 
triggered. This happens if the voltage is too high or too low. For more 
information, see “Supply voltage” on page 143. 

PA temperature high
This input becomes true when the one or more of the PA’s ‘Temperature high’ 
alarms is triggered. For information about this alarm, see “Temperature high” 
on page 144. 

PMU alarm on
This input becomes true when any PMU alarm is triggered.

PMU mains supply failed
This input becomes true when the PMU’s ‘Mains supply failed’ alarm is 
triggered. For information about this alarm, see “Mains supply failed” on 
page 144. 
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PMU output failed
This input becomes true when one of the PMU’s output alarms is triggered, 
because the voltage is high or low or the current is high. For information about 
these alarms, see “Output” on page 145. 

PMU power up fault
This input becomes true when the PMU’s ‘Power up fault’ alarm is triggered. 
For information about this alarm, see “Power up fault” on page 144. 

PMU shutdown imminent
This input becomes true when the PMU’s ‘Shutdown imminent’ alarm is 
triggered. For information about this alarm, see “Shutdown imminent” on 
page 144. 

PMU temperature high
This input becomes true when the PMU’s ‘Temperature high’ alarm is 
triggered. For information about this alarm, see “Temperature high” on 
page 145. 

Reciter alarm on
This input becomes true when any reciter alarm is triggered. 

Reverse power high
This input becomes true when the ‘Reverse power high’ alarm is triggered. For 
information about this alarm, see “Reverse power high” on page 143. 

Note: Use the VSWR fault input instead of the Reverse power high 
input if the transmit power is set to less than 20 W or if the base 
station has a 5 W PA. The resolution of the reverse power 

measurement is 1 W; only a very serious antenna fault would trigger the reverse 
power high alarm if the power setting is low.

Synthesizer failed
This input becomes true when a synthesizer goes out of lock or the external 
frequency reference is invalid and the corresponding alarm is triggered. For 
information about these alarms, see “Synthesizer out of lock” on page 146 and 
“External reference invalid” on page 148.

VSWR fault
This input becomes true when the ‘VSWR high’ alarm is triggered. For 
information about this alarm, see “VSWR high” on page 143. 

Analog Line Interface
Analog line inputs are concerned with the state of the analog line interface. 

Channel seized
The Channel seized input becomes true when the analog interface receives a 
channel seize signal. This signal must be received by the means that the base 
station is configured to recognize (digital input, E & M, or tone remote). 
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Tone remote detected
The Tone remote detected (nnn) input becomes true when the base station 
detects function tone number nnn on its analog line. To select this input, you 
must specify a frequency (Tone 1) for a single tone or a frequency pair (Tone 
1 and Tone 2), depending on whether the analog line is configured for single 
tone or dual tone. 

Base station in Run mode
The Base station in Run mode input becomes true when the base station 
goes into Run mode. This occurs on startup and when you tell a base station in 
Standby mode to change to Run mode. 

Use this input for tasks you want included in Task Manager’s initialization 
routine, to start timers, and to lock base station functions that you only want to 
operate under particular circumstances.

Important: The inverse of this input (IF NOT Base station in 
Run mode) must not be used; when the base station is not in Run 
mode, Task Manager is not operating.

Example

IF Base station in Run mode THEN Lock transmitter
IF Base station in Run mode THEN Lock receiver

This example could be used to configure a backup base station with everything 
locked but ready to go into operation when needed.

Channel
The Channel nnn input becomes true when the base station changes channel 
to the channel in the channel table with the name nnn. 

Channel changed
The Channel changed input becomes true when the base station changes 
from one channel to another.

Digital I/O
Digital I/O inputs are concerned with the state of the digital inputs and outputs. 

Digital input (n) high 
The Digital input (n) high input becomes true when digital input n goes 
high.

Pin 1 can be configured as digital input 4, as an antenna relay driver, or as digital 
output 1. The Task Manager input ‘Digital input 4 high’ reflects the state of pin 
1, no matter how it is configured. It can therefore be used to modify base station 
operation depending on the state of the antenna relay driver. 

Example

As the base station digital inputs float high, you probably want to create 
statements that trigger when the input is pulled low.

IF NOT Digital input (2) high THEN Go to channel 2.
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Digital input value
The Digital input value nn input becomes true when the setting of one or 
more digital inputs is changed so that the binary equivalent of those settings 
equals nn. Low is read as ‘1’ and high as ‘0’. 

Example

IF Digital input value 3 THEN Go to channel 3

Digital output high
The Digital output high (output n) input becomes true when the base 
station sets digital output n high. This can only happen through the Task 
Manager actions Set digital output high and Toggle digital output.

Locks
Lock inputs only change through Task Manager lock actions. All lock inputs 
become true when the base station enters Run mode. A lock input also 
becomes true when its function is unlocked after having been locked. 

The auxiliary power supply is an exception to the above. 

Analog line unlocked
The analog line is unlocked when the base station enters Run mode and when 
Task Manager unlocks the analog line after having previously locked it.

Automatic CWID unlocked
The automatic sending of a CWID is unlocked when the base station enters 
Run mode or when Task Manager unlocks the channel group after having 
previously locked it.

Auxiliary supply unlocked
On entering Run mode, the auxiliary supply is locked. The auxiliary supply is 
unlocked when Task Manager unlocks it. If the Auxiliary power control box 
(Configure > Base Station > Miscellaneous) is set to Task Manager, the 
auxiliary power output is also on.

Channel group unlocked
The channel group is unlocked when the base station enters Run mode or 
when Task Manager unlocks the channel group after having previously locked 
it.

Receiver unlocked
The receiver is unlocked when the base station enters Run mode or when Task 
Manager unlocks the receiver after having previously locked it.

Subaudible encoding unlocked
The encoding of subaudible signaling is unlocked when the base station enters 
Run mode or when Task Manager unlocks this function after having previously 
locked it.
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Subaudible/NAC decoding unlocked
The decoding of subaudible signaling and the NAC is unlocked when the base 
station enters Run mode or when Task Manager unlocks this function after 
having previously locked it.

Transmitter unlocked
The transmitter is unlocked when the base station enters Run mode or when 
Task Manager unlocks the transmitter after having previously locked it.

Network
Network inputs are concerned with base station functioning that affects the 
wider network.

Function code received
The Function code received (nn) input becomes true when the base station 
receives the function code nn from another base station in its channel group 
over the digital line. This input makes it possible for the base stations in a 
channel group that are not connected to an analog console system to act on 
dispatcher commands. See “Propagating Tone Remote Commands to the 
Channel Group” on page 123.

Example

IF Function code received (02) THEN Go to Channel 2.

Function code sent
The Function code sent (nnn) input becomes true when Task Manager 
instructs the base station to send function code nnn on the digital line. It does 
not become true when the base station automatically informs the channel group 
that it has received a function tone. 

Vote won by Analog line
The Vote won by Analog line input becomes true when the base station’s 
voter declares the signal on the analog line to be the best and the channel group 
repeats that signal. 

Vote won by Digital line
The Vote won by Digital line input becomes true when the base station’s 
voter declares the signal received on the digital line to be the best and the 
channel group repeats that signal. 

Vote won by Control panel
The Vote won by Control panel input becomes true when the base 
station’s voter declares the signal received from the control panel microphone 
to be the best and the channel group repeats that signal. 

Vote won by RF
The Vote won by RF input becomes true when the base station’s voter 
declares the signal received from the base station’s own receiver to be the best 
and the channel group repeats that signal. 
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RF interface
RF interface inputs are concerned with the state of things at the base station’s 
RF interface.

Analog received
The Analog received input becomes true when the base station starts 
receiving an analog FM signal on its RF interface.

Analog transmitted
The Analog transmitted input becomes true when the base station starts 
transmitting an analog FM signal on its RF interface.

APCO received
The APCO received input becomes true when the base station recognizes, 
through detecting frame synchronization, that it is receiving a digital P25 digital 
signal on its RF interface. 

APCO transmitted
The APCO transmitted input becomes true when the base station begins 
transmitting a digital P25 signal on its RF interface. 

PA carrier present
Whenever the reciter tells the PA to start transmitting, the PA carrier present 
input becomes true.

Received NAC
The Received NAC nnn input becomes true when the base station begins 
receiving a digital transmission with a NAC of nnn. While the base station can 
only detect the subaudible signaling that it is configured for, it can detect any 
NAC. This means that you can set up any action to be triggered by receiving a 
particular NAC. 

Rx Gate valid
The Rx Gate valid input becomes true when the criteria for unmuting the 
receiver are met. Rx Gate valid becomes true even if the receiver signal does 
not win the vote. Rx Gate valid becomes true for analog FM and for digital 
P25 signals. 

Subaudible tone detected
The Subaudible tone detected input becomes true when the base station 
detects the subaudible tone that is configured for the current channel. The base 
station is only able to detect the one subaudible tone that it is configured for.
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Task Manager
Inputs under the Task Manager heading are concerned with special aspects of 
Task Manager: Custom inputs, flags, timers, and counters. 

Counter at maximum
The Counter at maximum (Countername) input becomes true when the 
particular named counter reaches the maximum value set for it in Configure > 
Task Manager > Counters. 

The counter value changes through Task Manager actions such as Increment 
counter. Counter values are read at the beginning of a processing cycle. If the 
counter value changes during the processing cycle, it is immediately available; 
any subsequent tasks will use the new input. When the base station enters Run 
mode, all counters are reset to 0.

Example

IF Counter at maximum (LightTrigger) THEN Set digital output 
low. 

Custom Inputs
The Custom Inputs submenu contains all the custom inputs that have been 
defined for the base station using Configure > Task Manager > Custom Inputs.

Flag set (flagname)
The Flag set (flagname) input becomes true when Task Manager sets the 
corresponding flag. Flagname represents any name that you assigned to the flag 
in Configure > Task Manager > Flags. The state of flags is read at the beginning 
of a processing cycle. If a flag state changes during the processing cycle, it is 
immediately available; any subsequent tasks will use the new input. When the 
base station enters Run mode, each flag is cleared, unless a Task Manager task 
explicitly sets it. 

Timer expired
A timer can only be started by the Task Manager action Start timer. It expires 
when the timer’s maximum time has elapsed. This time was entered in 
Configure > Task Manager > Timers. 

Example

IF Timer expired (CWID timer) THEN Transmit CWID now. 

This input can be used to set up regular actions such as transmitting the CWID. 
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Trunking
Trunking inputs can be used when the base station is part of a trunking system 
and is connected to an external trunking site controller. 

Control channel
The Control channel input becomes true when a base station enters Run 
mode and is handled by the trunking controller as a control channel or when a 
base station, operating as a traffic channel, takes over the control channel 
function when the previous control channel fails. This input makes it possible 
for Task Manager to modify base station operation to suit control channel 
operation. 

The Control channel input becomes false when a traffic channel enters Run 
mode. The input IF NOT Control channel can be used to configure base 
station operation specifically for traffic channel operation. 

Example

IF Control channel THEN Go to channel 1
IF NOT Control channel THEN Go to channel 2

Site controller present
The Site controller present input becomes true when a base station enters 
Run mode and receives heartbeat messages from an external trunking site 
controller. This input makes it possible for Task Manager to modify base station 
operation to suit trunking operation.

The Site controller present input becomes false if the base station loses 
contact with its site controller. The input IF NOT Site controller present 
can be used to configure base station operation when site controller 
communications fail.
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Actions

An action is something that Task Manager instructs the base station to do. 

There is often a group of actions relating to a particular base station function. 
For example, Task Manager can lock, unlock, or toggle the automatic 
transmission of a base station identity, or set, clear, or toggle a flag.

To select an action

1. In the Task list item area, click in the Task action box. A menu with 
several submenus appears.

2. Click on an item in the menu or submenu.

To obtain Help on the output of a task

1. In the task list, click the task. The task appears in the Task list item area.

2. Click the Help button beside the Task action box.

Channel Actions
Channel actions make it possible to change the base station’s current channel.

Go to channel
The Go to channel action instructs the base station to change channel and 
operate according to the configuration defined by the channel with the name 
specified in the action. It stays on that channel until another Task Manager 
action changes channel (for example following a base station reset).

The actual change of operating channel happens at the end of a processing 
cycle. This means, for example, that if the task list has a Go to channel 
channel 005 action followed by a Go to channel channel 006 action, the 
base station will only ever change to channel 006.

Important: Make sure that Task Manager actions do not ask the base 
station to change channel more often than once every 500 ms.

Go to next channel
The Go to next channel action instructs the base station to operate on the 
next valid channel in the channel table. If the base station was on Channel 001, 
it changes to Channel 002. It stays on that channel until a Task Manager action 
changes channel (for example following a base station reset).

The actual change of operating channel happens at the end of a processing 
cycle. This means, for example, that if the task list has two Go to next 
channel actions, the base station will move two channels down the channel 
table. 

If the base station is already operating on the last channel in the channel table, 
the action takes it to the first channel.

Important: Make sure that Task Manager actions do not ask the base 
station to change channel more often than once every 500 ms.
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Go to previous channel
The Go to previous channel action instructs the base station to operate on 
the previous valid channel in the channel table. If the base station was on 
Channel 002, it changes to Channel 001. It stays on that channel until a Task 
Manager action changes channel (for example following a base station reset). 

In base stations with a complex set of Task Manager tasks, you need to 
understand exactly how this action works. It is not a ‘do now’ action; the actual 
change of operating channel happens at the end of a processing cycle. This 
means, for example, that if the task list has two Go to previous channel 
actions, the base station will move two channels up the channel table. 

If the base station is already operating on the first channel in the channel table, 
the action takes it to the last channel.

Important: Make sure that Task Manager actions do not ask the base 
station to change channel more often than once every 500 ms.

Digital output actions
Task Manager actions can set the digital outputs high or low or toggle them 
between the two states.

Set digital output high
The Set digital output high action sets the selected digital output line high. 

The actual setting of the digital output doesn’t happen till the end of a 
processing cycle. So the task list can set the digital output high or low many 
times, but the output line will only ever be set in the way that the last action in 
the task list specifies. 

When you select this action, a dialog box pops up so that you can select which 
digital output line you want to use. The Task Manager action will only have an 
effect if the relevant system interface pin has been configured as a digital output. 

Set digital output low
The Set digital output low action sets the selected digital output line low.

The actual setting of the digital output doesn’t happen till the end of a 
processing cycle. So the task list can set the digital output high or low many 
times, but the output line will only ever be set in the way that the last action in 
the task list specifies. 

When you select this action, a dialog box pops up so that you can select which 
digital output line you want to use. The Task Manager action will only have an 
effect if the relevant system interface pin has been configured as a digital output. 

Example

IF Counter at maximum (LightTrigger) THEN Set digital output 
low. 

Toggle digital output
The Toggle digital output action changes the state of the selected digital 
output line. If it was low, it become high. If it was high, it becomes low. 
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The actual setting of the digital output doesn’t happen till the end of a 
processing cycle. So the task list can change the state of the digital output many 
times, but the output line will only ever be set in the way that the last action in 
the task list specifies. 

When you select this action, a dialog box pops up so that you can select which 
digital output line you want to use. The Task Manager action will only have an 
effect if the relevant system interface pin has been configured as a digital output. 

Fan test now
The ‘do now’ action Fan test now instructs the base station to run the fans 
for 5 seconds, irrespective of the temperature. If the fans are already running, 
this has no effect.

Locks
Lock actions lock, unlock or toggle a base station function. By default, functions 
are unlocked (except for the Auxiliary Supply). When Task Manager locks a 
function, that function cannot operate. If Task Manager unlocks a function, it 
is free to operate. (However, for the function to actually operate, it may need 
to be licensed and to be enabled in configuration.) 

Generally speaking, if you create a task that locks a function, you need to create 
at least one equivalent function that unlocks it again.

The current status of Task Manager locks is displayed in Monitor > Task 
Manager > Locks. 

Each lock action has an equivalent lock input. When Task Manager unlocks a 
function (for example automatic CWID), the equivalent input (in this case 
Automatic CWID unlocked) becomes true and any tasks with that input will 
be processed. 

Analog line lock
Task Manager can lock the analog line. This disconnects the dispatch console 
from the base station. No analog voice can pass between the console and the 
base station. Physical signaling on the E line is recognized, but the channel 
cannot be seized.

Automatic CWID lock
Task Manager can lock the automatic transmission of a CWID. This stops the 
base station from transmitting its CWID as configured in Configure > RF 
Interface > CWID. It does not affect the ability of Task Manager to send a 
CWID using the action Transmit CWID now.

Auxiliary supply lock
If the Auxiliary power control box (Configure > Base Station > Miscellaneous) 
is set to Task Manager, locking the auxiliary supply turns it off and unlocking 
it turns it on.

Example

IF Base station in Run mode THEN Unlock auxiliary supply

This task turns the auxiliary output on whenever the base station enters Run 
mode. 
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Channel group lock
Task Manager can lock the current channel group. This disconnects the base 
station from its channel group so that it cannot receive a voice stream or 
function code from other channel group members. 

Changing channel group (by changing channel) has no effect on the lock. 

Example

IF Tone remote detected (650) THEN Lock Channel Group.
IF Tone remote detected (850) THEN Unlock Channel Group.

This pair of tasks makes it possible for the dispatcher to instruct the base station 
to disconnect itself from the channel group, so that dispatcher communications 
only use that base station, and then to re-connect the base station, as needed.

Receiver lock
Task Manager can lock the receiver. This prevents the base station from 
receiving any RF signals. 

Subaudible encode lock
Task Manager can lock the encoding of subaudible signaling. When encoding 
is locked, transmissions do not contain any subaudible signaling.

The transmission of the NAC cannot be locked, because it is not possible to 
send P25 digital transmissions without a NAC.

When decoding is unlocked, the transmitter behaves according to the current 
signaling profile. 

Subaudible/NAC decode lock
Task Manager can lock the decoding of subaudible signaling and the NAC. 
When decoding is locked, the receiver unmutes irrespective of the subaudible 
signaling or the NAC that the received signal contains. 

When decoding is unlocked, the receiver behaves according to the current 
signaling profile. 

Transmitter lock
Task Manager can lock the transmitter. This prevents the base station from 
sending any RF signals. 

RF repeat actions
If the RF Repeat setting of the current channel (in the channel table) is set to 
DispatchControlled, Task Manager can enable, disable, or toggle the base 
station’s RF repeat function.

Example

IF Tone remote detected (550) THEN Enable RF repeat
IF Tone remote detected (650) THEN Disable RF repeat
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Send function code
The Send function code action sends the defined function code over the 
digital line to all base stations in the current channel group. This action is 
needed in order to inform the channel group when a base station receives a tone 
remote function tone.

Example

IF Tone remote detected (550) THEN Send Function Code 5

Statements of this type make it possible for commands received over the line 
interface to be relayed to the other base stations in the channel group, so that 
all can, for example, change channel. 

Task Manager
Outputs under the Task Manager heading are concerned with special aspects of 
Task Manager: counters, custom outputs, flags and timers. 

Counter actions
Task Manager actions make it possible to increment or decrement a counter 
value, or to reset the value to 0. Before creating statements with these actions, 
set up one or more counters in Configure > Task Manager > Counters. 

Increment counter
The Increment counter (nn) action adds one to counter nn. When a 
counter reaches its specified maximum, it triggers actions with the input 
Counter at maximum (nn). Further Increment counter actions have no 
effect.

Decrement counter
The Decrement counter action subtracts one from the current value of the 
counter specified. If the counter is at 0, Decrement counter actions have no 
effect.

Reset counter
The Reset counter action sets the value of the counter specified to zero, so that 
it must begin counting anew. 

Flag actions
Task Manager actions can set or clear flags. Before creating statements with flag 
actions, name one or more flags in Configure > Task Manager > Flags.

Set flag
Task Manager can set or clear any of 16 numbered flags. A flag can only have 
one of two states: set or cleared. The state of a flag can be used as an input in 
other tasks.

Clear flag
Task Manager can set or clear any of 16 numbered flags. A flag can only have 
one of two states: set or cleared. The state of a flag can be used as an input in 
other tasks.
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Toggle flag
Task Manager can set or clear any of 16 numbered flags. Toggling a set flag 
clears it. Toggling a cleared flag sets it. The state of a flag can be used as an input 
in other tasks.

Timer actions
Task Manager can start or stop timers. Before creating statements with timer 
actions, set up one or more timers in Configure > Task Manager > Timers.

Start timer
Task Manager can start or stop any of its 16 timers. When a timer is started, it 
is re-initialized, then it begins to count up from zero to the maximum set in 
Configure > Task Manager > Counters and Timers. When it has reached that 
maximum, it expires. You can create tasks that are executed when a timer 
expires.

Stop timer
Task Manager can start or stop any of its 16 timers. When a timer is stopped, it 
ceases to count up, so it does not expire. If it is re-started, it starts counting up 
again from 0. You can create tasks that are executed when a timer expires.

Transmit CWID now
The ‘do now’ action Transmit CWID now instructs the base station to 
immediately transmit the CWID message defined in the CWID form. This 
action enables you to configure CWID transmissions in a way that is not 
otherwise possible. For example, you could have the CWID transmitted more 
than once a minute or at every transmit tail. 

Transmit CWID now is not affected by the Task Manager Automatic CWID 
lock. 

Custom Actions
The Custom Actions submenu contains all the custom actions that have been 
defined for the base station using Configure > Task Manager > Custom 
Actions. 
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Task Manager Examples

Task Manager makes it possible for you to build complex functions into the 
base station. Here are some examples of to give you an idea of what can be 
done. 

Important: While Tait has carefully tested Task Manager, no 
guarantee can be given that these examples will work correctly for 
your system. Make sure that you thoroughly test any set of Task 

Manager tasks before commissioning the system.

Scanning Repeater
Task Manager makes it possible for a stand-alone TB9100 to function as a 
scanning repeater.

The set of Task Manager statements below works like this. When the TB9100 
goes into Run mode, the ChangeChannel timer starts. When that timer stops, 
Task Manager instructs the TB9100 to go to the next channel in the channel 
table. If the TB9100 receives a call that wins the vote, it stops scanning. When 
the call ends, a second timer (OnChannel) is started. This timer stops the base 
station scanning long enough to give the called party time to respond.

IF Base station in Run mode THEN Start timer (ChangeChannel)
IF Vote won by RF THEN Stop timer (ChangeChannel)
IF Vote won by RF THEN Stop timer (On Channel)
IF NOT Vote won by RF THEN Start timer (On Channel)
IF Timer expired (ChangeChannel) THEN Go to next channel
IF Timer expired (ChangeChannel) THEN Start timer 

(ChangeChannel)
IF Timer expired (On Channel) THEN Go to next channel
IF Timer expired (On Channel) THEN Start timer (ChangeChannel)

Important: Set the ChangeChannel timer to at least 350 ms. 
Changing channels too quickly can put excess load on the firmware 
and cause it to miss its deadlines. The consequences could include 

the firmware protection mechanisms restarting the base station. 

Give the On Channel timer a suitable value (for example, 5 seconds), to give 
the called party time to respond before the base station changes channel. 

A small variation on this set of statements can make the base station stay on its 
home channel until an external signal triggers the scanning.
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Customizing Task Manager

Customizing Task Manager adds to its power and flexibility. There are several 
options available. You can create custom inputs or actions and define timers, 
counters, and flags. You can then use them to create tasks that will be executed 
when the custom input becomes true, the timer expires, the counter reaches its 
maximum, or the flag is set. 

Working With Custom Inputs
The Custom Inputs form (Configure > Task Manager > Custom Inputs) lets 
you work with custom inputs. It lists the existing custom inputs and lets you see 
what combination of standard inputs each consists of. You can also create new 
custom inputs and edit or rename existing ones. 

A custom input is a user-defined Task Manager input that consists of a 
combination of standard inputs. Custom inputs make it possible to define tasks 
that will be processed when a combination of inputs becomes true. (A Task 
Manager task can only have one input.)

Viewing a Custom Input
1. Click an item in the Custom Input Name column.

2. View the display in the rest of the form. It shows the standard inputs used 
to create the custom input, whether they are negated, and the logic of their 
combination. The standard truth table determines the outcome for the 
different states of any pair. (See “Truth Table” on page 202.)

The Logic column shows graphically how the standard inputs will be com-
bined. First the input is negated, if its Not check box is selected. Then it is 
combined with the adjacent input to which it is joined by a line. The result 
of that combinatorial operation is combined with the input or result that it 
is joined to, and so on, until the final result is obtained. In this way, up to 
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eight standard inputs can be combined to produce an input that can only be 
true or false.

Defining a Custom Input
1. Click New. 

2. Edit the name that appears in the Custom Input Name column.

3. Click in an Input box and select an input from the list. 

4. If you want the negative of the input to contribute to the custom input’s 
logic, select the Not check box alongside.

5. Repeat steps 3 and 4 for all the standard inputs that will go to make up the 
custom input. The Input boxes that you choose will determine the order in 
which the standard inputs are combined. 

6. Under the Logic heading, select the appropriate options in the drop-down 
boxes to give the logical combination of inputs that you want. (For 
information about the effect of the different options, see “Truth Table” on 
page 202.)

7. Click OK.

Truth Table
The truth table below displays the possible individual values for input A and 
input B, and the result when you combine those values using each of the six 
available logic operators. So, for example, if A is true and B is false and we 
combine A and B using XOR, the result is true. 

A B AND NAND XOR XNOR OR NOR

false false false true false true false true

false true false true true false true false

true false false true true false true false

true true true false false true true false
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Working With Custom Actions
The Custom Actions form (Configure > Task Manager > Custom Actions) lets 
you work with custom actions. It displays the list of existing custom actions. If 
you select a custom action, it displays the set of standard actions that it consists 
of. You can also create new custom actions and edit or rename existing ones. 

A custom action is a user-defined Task Manager action that consists of more 
than one standard action. It saves you writing several different tasks with the 
same input.

Viewing a Custom Action
1. Click an item in the Custom Action Name column.

2. View the Standard Actions column. It lists the standard actions that the 
custom action consists of.

Defining a Custom Action
1. Click New. 

2. Edit the name that appears in the Custom Action Name column.

3. Click in the first row of the Standard Actions column and select an action 
from the list. 

4. Repeat step 3 for all the standard actions that will go to make up the custom 
action. 

5. Click OK.



204 Part H: Task Manager    © Tait Electronics Limited May 2006

Defining Counters, Timers, and Flags
Counters, timers, and flags make it possible for Task Manager to do such things 
as respond to three presses of PTT or to email a status message once a week.

Note: Short timers may not be accurate. This is because it may take 
Task Manager longer than 10 ms to process its tasks, causing it to 
miss the next instruction to go through its task list. Tait recommends 

that you avoid short timers (< 50 ms) if the task list has more than 10 enabled 
tasks. 

To define a counter

1. Select Configure > Task Manager > Counters.

2. If desired, enter a suitable name for the counter into the Name box.

3. In the Maximum box, enter the highest number that the counter can 
reach. 

When the counter reaches its maximum, the input Counter at maximum 
becomes true for that counter and any tasks containing it are processed.

To define a timer

1. Select Configure > Task Manager > Timers.

2. If desired, enter a suitable name for the timer into the Name box.

3. In the Units box, specify what unit of time the number you entered 
represents. 

When the timer reaches its maximum, the input Timer expired becomes 
true for that timer and any tasks containing it are processed.

To define a flag

1. Select Configure > Task Manager > Flags.

2. If desired, enter a suitable name for the flag into the Name box.

3. Click OK.
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Monitoring Task Manager

The items under Monitor > Task Manager provide options for monitoring 
Task Manager. If the base station is behaving unexpectedly, you can check to 
see whether Task Manager has locked any base station functions. Alternatively, 
have a look at the system log; it records any actions that Task Manager carries 
out. You also can view the current state of timers, counter, and flags.

Viewing Locks
The Locks form (Monitor > Task Manager > Locks) shows you whether Task 
Manager has locked any base station functions. 

If the function is locked, the form displays a red locked padlock. 

If the function is unlocked, the form displays a green open padlock.

When the base station enters or re-enters Run mode, all functions (except for 
the auxiliary supply) are unlocked. A function can only be locked through Task 
Manager action.

The Locks form is an important place to check, if the base station is not 
behaving as expected. 

Analog line When the analog line is locked, the analog line cannot be used. 

Auxiliary supply By default, the auxiliary supply is locked. 

Locking or unlocking the auxiliary supply only has an effect if the auxiliary 
supply is configured to be under the control of Task Manager (Configure > 
Base Station > Miscellaneous). In this case, when the auxiliary supply is locked, 
the auxiliary power output is turned off. When the auxiliary supply is unlocked, 
it is on and supplying power. 

Channel group When the channel group is locked, the base station cannot input or output a 
voice stream over its digital line.

Automatic CWID When automatic CWID is locked, the base station cannot automatically 
transmit a continuous wave ID (Morse code). However, Task Manager can still 
initiate the sending of the CWID using the action Transmit CWID now.
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Receiver When the receiver is locked, it is unable to pass any received audio.

Transmitter When the transmitter is locked, it is unable to transmit.

Subaudible 
encode

When the encoding of subaudible signaling is locked, subaudible signaling is not 
added to the transmitted signal. (The encoding of the NAC cannot be locked.)

Subaudible/NAC 
decode

When the decoding of subaudible signaling and the NAC is locked, subaudible 
signaling and the NAC are not decoded, which means that the receiver 
unmutes to any CTCSS tone, DCS code, or NAC. 

Viewing Timers
The Timers form (Monitor > Task Manager > Timers) displays the current 
state of any timers that you configured for Task Manager. 

The Name column lists the timers. A bar graph shows how far each timer has pro-
gressed towards its maximum value, which is displayed in the Maximum column. 

Viewing Counters
The Counters form (Monitor > Task Manager > Timers) displays the current 
state of any counters that you configured for Task Manager. 

The Name column lists the counters. A bar graph shows how far each counter 
has progressed towards its maximum value, which is displayed in the Maximum 
column.

Viewing Flag States
The Flags form (Monitor > Task Manager > Timers) displays the current state 
of any custom flags that you configured for Task Manager. 

Each of the possible flags has an LED alongside it. A flashing red LED means 
that the flag is set. A green LED means that is is cleared.
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Glossary

This glossary contains an alphabetical list of terms and abbreviations related to 
the TB9100 base station.

A

administrator A special type of access to CSS functions, used for activities such as changing 
passwords.

ADC Analog-to-Digital Converter. A device for converting an analog signal to a 
digital signal that represents the same information.

AES AES (Advanced Encryption Standard) is an encryption algorithm that uses keys 
of up to 256 bits. 

AGC Automatic Gain Control. A device that optimizes signal level.

Algorithm ID The Algorithm ID is an identifier that specifies an encryption algorithm (for 
example, DES or AES).

analog FM mode A mode of operation in which the RF interface transmits and receives analog 
FM signal. The digital line sends and receives the analog signal as G. 711 speech 
packets.

analog valid Analog valid is a signal that indicates that the base station is presenting a valid 
output on the analog line. This output can originate from an analog FM or from 
a digital P25 call. The M-line carries the analog valid signal. 

ANI Automatic Number Identification. A service that provides the receiver of a call 
the number of the caller.

APCO The Association of Public Safety Communications Officials in the United 
States. The APCO Project 25 standards committee defined a digital radio 
standard. The standard is often referred to as APCO or P25.

B

Base station In general, a radio receiver and transmitter that is located in a specific place (at 
a site) that allows portable and mobile radio terminals to communicate over a 
larger range. Specifically, Tait TB9100 equipment in a subrack.

BCD BCD (binary coded decimal) is a code in which a string of four binary digits 
represents a decimal number.



208 Glossary    © Tait Electronics Limited May 2006

BER Bit Error Rate. A measure of the quality of digital transmission, expressed as a 
percentage. The BER indicates the proportion of errors in a transmission.

C

C4FM Compatible Four-level Frequency Modulation. A modulation scheme defined 
in the CAI standard for 12.5 kHz bandwidth.

CAI Common Air Interface. The over-the-air data formats and protocols defined by 
the APCO P25 committee.

Calibration 
Software

The TB9100 Calibration Software is a utility for defining the switching ranges 
of the receiver and the exciter and for flattening the receiver response across its 
switching range. It can also be used to calibrate TB9100 modules.

call A complete exchange of information between two or more parties. A call 
requires a receive signal path and a transmit signal path. In trunked systems, a 
call is a conversation, made up of a number of overs, but in conventional 
systems, a call is an over.

calling profile A group of configuration settings that defines the properties of the TB9100 
analog line, which can be regarded as equivalent to a radio on the network. 

channel A channel is:
1. A path through which signals can flow.
2. In the RF domain, a frequency pair (or just a single frequency in a simplex 
system).
3. A set of configuration information that defines the frequency pair and other 
related settings (a channel configuration). Generally, ‘channel’ has this meaning 
in the CSS.

channel group A channel group is a single logical channel consisting of a set of base stations. 
The base stations are linked by an IP network and share a common multicast IP 
address. 

channel profile A channel profile is a named group of configuration settings that help to define 
the properties of a channel. Each channel in the channel table must have a 
channel profile assigned to it.

channel seize Channel seize is a signal received at the analog line interface, requesting the base 
station to accept the analog signal as an input into the channel group. The base 
station can be configured to acknowledge an asserted E-line, LLGT, or LLGT 
following MDC1200 signaling as a channel seize signal.

channel spacing Channel spacing is the bandwidth that a channel nominally occupies. If a base 
station has a channel spacing of 12.5 kHz, there must be a separation of at least 
12.5 kHz between its operating frequencies and those of any other equipment. 
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channel table The channel table is the base station’s database of channel configurations.

CKR The CKR (common key reference) is a number used by the key fill device and 
by the CSS to indirectly refer to an encryption key without using its Key ID or 
Algorithm ID.

circuit domain The part of the base station processing functionality that processes speech signal 
as a continuous stream of bits – a digital circuit. The opposite of packet domain.

CODEC An IC which combines analog-to-digital conversion (coding) and digital-to-
analog conversion (decoding).

configuration file A configuration file consists of all the configuration settings needed for a base 
station, stored as a file in the configurations folder. Configuration files have the 
extension *.apc.

connection list A connection list contains the names and IP addresses of base stations that the 
CSS can connect to.

control bus The control bus is used for communications between base station modules in a 
subrack. It is an I2C bus, a bi-directional two-wire serial bus which is used to 
connect integrated circuits (ICs). I2C is a multi-master bus, which means that 
multiple chips can be connected to the same bus, and each one can act as a 
master by initiating a data transfer. 

control panel The control panel is an area at the front of the base station with buttons, LEDs 
and other controls that let you interact with the base station.

CRTP Compressed RTP.

CSS Customer Service Software. Tait PC-based software for monitoring, 
configuring, and diagnosing a Tait TB9100 base station.

CTCSS CTCSS (continuous tone controlled squelch system), also known as PL (private 
line) is a type of signaling that uses subaudible tones to segregate groups of users.

custom action A custom action is a user-defined Task Manager action that consists of more 
than one pre-defined action.

custom input A custom input is a user-defined Task Manager input that consists of a set of 
pre-defined inputs that are combined using Boolean logic.

CWID CWID (Continuous Wave IDentification) is a method of automatically 
identifying the base station using a Morse code. Continuous wave means 
transmission of a signal with a single frequency that is either on or off, as 
opposed to a modulated carrier. 
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D

DAC Digital-to-Analog Converter. A device for converting a digital signal to an 
analog signal that represents the same information.

DCS DCS (digital coded squelch), also known as DPL (digital private line), is a type 
of subaudible signaling used for segregating groups of users. DCS codes are 
identified by a three-digit octal number, which forms part of the continuously 
repeating codeword. When assigning DCS signaling for a channel, you specify 
the three-digit code.

de-emphasis De-emphasis is a process in the receiver that restores pre-emphasized audio to 
its original relative proportions. 

DES DES (Data Encryption Standard) is the encryption algorithm selected by the 
P25 standard. Generally, P25 traffic uses the DES-OFB mode.

digital input value A value that the base station computes from the state of a configured number 
of digital inputs. The digital input value is an input into Task Manager.

digital P25 mode A mode of operation in which the RF interface transmits and receives digital 
signal as defined by the APCO P25 CAI. The digital line sends and receives 
IMBE speech packets.

dispatcher A dispatcher is a person who gives official instructions by radio to a fleet.

dotted quad A method for writing IPv4 addresses. The form is DDD.DDD.DDD.DDD 
where DDD is an 8-bit decimal number.

DSP Digital Signal Processor.

dual mode The ability to operate as a transceiver in two different ways: analog FM and P25 
digital. Dual mode equipment can be configured to support either mode or to 
switch between modes from one over to another.

duty cycle Duty cycle is used in relation to the PA. It is the proportion of time (expressed 
as a percentage) during which the PA is operated.

E

EIA Electronic Industries Alliance. Accredited by the American National Standards 
Institute (ANSI) and responsible for developing telecommunications and 
electronics standards in the USA.

encryption The coding of voice (or data) into unintelligible forms for secure transmission.
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EMC Electromagnetic Compatibility. The ability of equipment to operate in its 
electromagnetic environment without creating interference with other devices.

ETSI European Telecommunications Standards Institute. The non-profit 
organization responsible for producing European telecommunications 
standards.

F

FCC Federal Communications Commission. The FCC is an independent United 
States government agency that regulates interstate and international radio 
communications.

Feature Code Code that identifies a feature license that can be enabled or disabled using the 
Software Feature Enabler.

Feature Code 
Sequence Number

Number that indicates how many times a feature license has been enabled or 
disabled. 

Feature license key A set of digits purchased from Tait that is required to enable a feature license.

FEC Forward Error Correction.

FFSK Fast Frequency Shift Keying. A modem encoding scheme for carrying data on 
FM radios.

flag A flag is a programming term for a “yes/no” indicator used to represent the 
current status of something. The base station has a set of flags that Task Manager 
can set and clear.

FLASH Electrically block erasable and programmable read-only memory.

FM Frequency Modulation. Often used as an adjective to denote analog radio 
transmission.

frequency band The range of frequencies that the equipment is capable of operating on.

front panel The cover over the front of the base station containing fans for the PA and 
PMU.

G

G. 711 The name of the ITU standard that defines how speech is digitally encoded (64 
kbit, A-law or u-law). When the base station is in analog mode, G. 711 speech 
is sent and received on the digital line interface. 
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gating Gating is the process of opening and closing the receiver gate. When a valid 
signal is received, the receiver gate opens. 

group call A group call is a call that involves more than two radios simultaneously.

H

hiccup mode Many power supplies switch off in the event of a short-circuit and try to start 
again after a short time (usually after a few seconds). This “hiccup”-type of 
switching off and on is repeated until the problem is eliminated.

hub A unit for connecting hosts together. It sends all incoming ethernet packets to 
all the other hosts.

hysteresis Hysteresis is the difference between the upper and lower trigger points. For 
example, the receiver unmutes when the upper trigger point is reached, but will 
mute again until the level falls to the lower trigger point. An adequate hysteresis 
prevents the receiver gate from repeatedly muting and unmuting when the level 
varies around the trigger point. 

I

IMBE Improved Multiband Excitation. A voice compression technology patented by 
Digital Voice Systems, Inc and used in the vocoders of P25 radios. 

inbound Inbound describes the direction of a signal: from a subscriber unit over the air 
interface to the fixed station.

inhibit A control command that can be sent across the CAI to inhibit a radio. An 
inhibited radio appears to the user as if it is powered off. 

IP Internet Protocol. IP is a protocol for sending data packets between hosts.

isolator An isolator is a passive two-port device which transmits power in one direction, 
and absorbs power in the other direction. It is used in a PA to prevent damage 
to the RF circuitry from high reverse power.

K

key ID The Key ID is the identifier for a key variable.

key variable The key variable is a parameter used by the encryption algorithm to encrypt or 
decrypt a message. 
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L

LAN Local Area Network

LED Light Emitting Diode. Also the screen representation of a physical LED.

LLGT Low level guard tone. One of a set of tones used to remotely control base 
stations.

M

MDC1200 MDC1200 is a proprietary signaling protocol developed by Motorola and used 
to enhance basic communications in analog PMR. 

monitor The Monitor function unmutes the receiver, so that the user can hear all traffic 
on a channel.

multicast group The group of hosts associated with a specific IP multicast address.

multicast IP address An IP address that addresses a group of hosts rather than a single host. 

mute A mute controls the circumstances under which a received signal is passed to 
the radio’s speaker. When a mute is active, the radio’s speaker only unmutes 
under certain conditions, determined by the type of signaling operating on a 
channel and the squelch threshold.

N

NAC Network Access Code. The 12 most significant bits of the network identifier 
information that precedes every packet sent on the CAI. The NAC identifies 
which network the data belongs to, allowing base stations and mobiles to ignore 
packets belonging to interfering networks.

navigation pane The navigation pane is the left-hand pane of the CSS application window. It 
displays a hierarchical list of items. When you click an item, the main pane 
displays the corresponding form.

normal squelch A type of squelch operation in which the receiver unmutes on any signal with 
the correct NAC (digital P25) or subaudible signaling (analog FM).

O

octet A set of 8 bits.

operating range Operating range is another term for switching range.
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outbound Outbound describes the direction of a signal: from a fixed station over the air 
interface to a subscriber unit.

over A single transmission, which begins when a user presses PTT and ends when 
the user stops pressing.

P

P25 Project 25. A suite of standards and requirements intended for digital public 
safety radio communications systems.

PA The PA (power amplifier) is a base station module that boosts the exciter output 
to transmit level.

packet domain The speech processing area that deals with speech data that has been collected 
up into a packet. IP networks convey packets. The opposite of circuit domain. 

PCB Printed Circuit Board

PMU The PMU (power management unit) is a module that provides power to the 
base station.

pre-emphasis Pre-emphasis is a process in the transmitter that boosts higher audio frequencies. 

program The act of sending a configuration data set from the CSS to the base station.

Project 25 A project set up by APCO (the Association of Public Safety Communications 
Officials International), together with other US governmental organizations, to 
develop standards for interoperable digital radios to meet the needs of public 
safety users.

PSTN Public Switched Telephone Network: The public telephone network.

PTT Push To Talk. The button on a radio terminal that keys the transmitter.

Q

QoS Quality Of Service.

R

reciter The reciter is a module of a TB9100 base station that acts as receiver and exciter.
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repeater talkaround Repeater talkaround allows the radio user to bypass repeater operation and so 
communicate directly with other radios. While repeater talkaround is active, all 
transmissions are made on the receive frequency programmed for the channel.

reverse tone burst Reverse tone bursts can be used with CTCSS. When reverse tone bursts are 
enabled, the phase of the generated tones is reversed for a number of cycles just 
before transmission ceases. If the receiver is configured for reverse tone burst, it 
responds by closing its gate.

RISC Reduced instruction set chip. The name used for the control processors in the 
reciter’s digital board and network board.

RS-232 A serial communications protocol.

RSSI RSSI (Received Signal Strength Indicator) is a level that indicates the strength 
of the received signal. 

RTP RTP (Real Time Protocol) is an Internet protocol that supports the real-time 
transmission of voice and data.

Run mode Run mode is the normal operating mode of the base station.

Rx Receiver.

S

selective squelch A type of squelch operation in which the receiver unmutes only on signals that 
are explicitly addressed to that receiver. This can be done through a talk group 
ID or unit ID (digital P25) or through MDC1200 signaling (analog FM).

sensitivity The sensitivity of a radio receiver is the minimum input signal strength required 
to provide a usable signal.

signaling profile A signaling profile is a named set of configuration items related to signaling that 
can be applied to any channel. Items include subaudible signaling and transmit 
timers. 

SINAD SINAD (Signal plus Noise and Distortion) is a measure of signal quality. It is 
the ratio of (signal + noise + distortion) to (noise + distortion). A SINAD of 
12 dB corresponds to a signal to noise ratio of 4:1. The TB9100 can provide an 
approximate SINAD value while in service by comparing the in-band audio 
against out-of-band noise. This value should not be relied upon to make 
calibrated measurements.

site 1. The base station electronics at a particular location. This includes power 
supplies, transmitters, receivers, network interfaces and controllers. 2. The 
location of that electronic equipment.
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SMR Specialized Mobile Radio. A communications system used by police, 
ambulances, taxis, trucks and other delivery vehicles. 

squelch Squelch is a feature of radio equipment. It ensures that the speaker only 
unmutes when a valid signal is received. To be valid, it must, for example, 
exceed a certain signal strength.

Standby mode Standby mode is a mode of base station operation in which active service is 
suspended so that special operations can be carried out, such as programming a 
new configuration into the base station. 

subaudible 
signaling

Subaudible signaling is signaling that is at the bottom end of the range of audible 
frequencies. The TB9100 base station supports CTCSS and DCS subaudible 
signaling. 

subtone A subtone (subaudible signaling tone) is a CTCSS tone or a DCS code. 

supplementary 
service

A term used in the P25 standards. It refers to a group of services that is additional 
to the basic service that a telecommunications network provides. Examples 
include encryption and radio unit monitoring.

switching range The switching range is the range of frequencies (about 10 MHz) that the 
equipment is tuned to operate on. This is a subset of the equipment’s frequency 
band.

syslog protocol syslog is a standard protocol used for the transmission of event notification 
messages across IP networks. Base stations can send messages such as alarms to 
an IP address on the TaitNet P25 network. The base station’s logs store 
messages in the syslog format. 

T

TaitNet Brand name for any PMR network designed and manufactured by Tait 
Electronics Limited.

TaitNet P25 
network

A set of Tait base stations interconnected by an IP network that can carry voice 
and data traffic. 

TB9100 Base Station A Tait TB9100 base station consists of the equipment necessary to receive and 
transmit on one channel. Generally, this means a reciter, a PA, and a PMU. 
Often abbreviated to TB9100 or base station. 

Task action A task action is the second part of a Task Manager task. It specifies what the 
base station must do when the first part (the input) becomes true.

Task input A task input is the first part of a Task Manager task. It specifies what the must 
become true before the base station carries out the second part. 
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Task Manager Task Manager is a part of the TB9100 base station firmware that carries out tasks 
in response to inputs. These tasks are formulated using the CSS.

TCP Transmission Control Protocol. A complex protocol on top of IP for sending 
reliable streams of data with flow control.

TELCO Telephone company.

TIA Telecommunications Industry Association

toggle The term toggle is used to describe the switching between two states. If 
something is on, toggling it turns it off. If it is off, toggling it turns it on.

tone A tone is a sound wave of a particular frequency.

TSBK A TSBK (trunking signaling block) is an over-the-air message format used in 
digital P25 mode for setting up trunked calls and for supplementary services 
such as messaging and status updates. 

Tx Transmitter.

U

uninhibit A control command that can be sent across the CAI to restore and inhibited 
radio to normal functioning. 

UDP User Datagram Protocol. A simple protocol on top of IP for sending streams of 
data.

UTC Coordinated Universal Time (word order from French). An international time 
standard that has replaced Greenwich Mean Time.

V

valid signal A valid signal is a signal that the receiver responds to by unmuting the receiver. 
A signal is valid, for example, when it is stronger than a minimum level and 
when it has the specified NAC.

vocoder Voice encoder/decoder. A processing element that compresses/decompresses 
the digital voice signal.

VoIP Voice over IP. The name for the technology that puts speech signals in packets 
and then routes them over an IP backbone network.
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voting Voting is the systematic sampling of a group of channels for the channel with 
the greatest signal strength. Voting provides wide-area coverage and ensures 
that as the user moves throughout the coverage area the strongest channel is 
always available for a call. The TB9100 has an internal voter, which decides 
which base station input is passed to the switch for distribution to the 
configured and enabled outputs.

VSWR Voltage Standing Wave Ratio (VSWR) is the ratio of the maximum peak 
voltage anywhere on the line to the minimum value anywhere on the line. A 
perfectly matched line has a VSWR of 1:1. A high ratio indicates that the 
antenna subsystem is poorly matched.

W

watchdog A watchdog circuit checks that the system is still responding. If the system does 
not respond (because the firmware has locked up), the circuit resets the system. 

Z

zeroize To zeroize is to render one or more keys useless by overwriting the key data 
with zeros. 
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Index

A
access code 13

changing 47
setting up 47

AC-DC converter 70, 80
actions (Task Manager) 194

channel 194
custom 199

Administrator privilege 13
AES encryption license 14
AGC 103
air intake temperature 68

alarm 147
alarm 10, 139

adjusting thresholds 150, 152
disabling 149
flashing icon 18
monitoring 141
monitoring from CSS 18
sending to central collector 153
Task Manager inputs 184

Alarm Center 153
Alarm status LED 77
analog FM

disabling across digital line 60
feature license for 14, 44
receiving 98

analog gateway 12
feature licenses required for 43
interfacing to console system 117

analog line 12
configuring 117
enabling 131
encryption status of 64, 65
encryption warnings 130
feature license for 14
individual ID of 132
locking 196
looping back 166
measuring level of 166, 166
monitoring 63, 67
monitoring levels 67
monitoring overload 66
monitoring signaling 66
selecting encryption key 132
setting line levels 127
signaling options 118
squelch setting 63, 131

test tone 165
testing 165

analog valid 118, 128
monitoring 65

ANI 124
configuring 130

antenna relay 91
and RF repeat 8
configuring pin 1 as driver for 90
timing diagram 92, 93

application log 76
application window 25
audio filter 103
audio input

measuring level of 166
audio output

generating 165
automatic gain control 103
auxiliary power output 80, 94

control of 94
monitoring state of 71
testing 173
turning on and off 196

B
Base encryption license 14
base station

broadcasting identity 109
configuring 81
connecting to 17, 28
different options 38
disconnecting from 32
feature licenses required 43
IP address 111
list of 39
multicast address of 116
name 111
network identity 111
password 28
programming configuration into 36
receive only 38
resetting 33
testing 155
upgrading firmware 40
with external power supply 38

Base Station Thresholds form 150
basic inputs 179
basic tasks 23
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battery
configuring minimum voltage 93
protection mode 145
state of 70
voltage 70
voltage high 145
voltage low 145

battery backup
testing 172

battery charger
configuring auxiliary power as 94

baud rate, of serial port 89
BER 148

alarm 148
alarm threshold 151
current value 151
monitoring 53

buffer underflow 57

C
C4FM modulation

testing 163
calibration

date of 78
call alert 88, 125
call records 72
call statistics 75
caller identification 124
calling profile 5, 130

enabling 131
monitoring current 63
selecting by tone remote 135
selecting encryption key 132

carrier gating 99
carrier test 162
Celsius 48
channel 3

adding 87
current 4
dispatcher changing 122
invalid 146
monitoring by dispatcher 122
monitoring current settings 51
profiles assigned to 5
prohibited frequencies 86
selected by digital inputs 87
selected by dispatcher 87
selecting (by Task Manager action) 194
selecting automatically 87

channel group 5, 114
adding 114
checking settings 56

configuring for digital P25 and/or analog
FM 116

duplex mode 115
editing 115
locking 197
monitoring current 60
monitoring voting 61
multicast address of 116
port number of 114
propagating commands to 123
receivers on same frequency 116
sending function code to 198
simplex mode 115
testing for presence of other members 167

channel guard see subaudible signaling
channel profile 5, 96

adding 97
editing 98

channel seize 118, 128
monitoring 65

channel spacing
of receiver 102
of transmitter 102

channel table 4, 84
adding a channel 87
arrow in 84

CKR 133
coded squelch see DCS code
comment, in Task Manager 183
common uplink frequency 62
compatibility file 40
computed input value 90

using to select channel 87
viewing 169

configuration 20, 81
creating 34
default file location 48
programming into base station 36
programming into newer base station 37
programming into older base station 37
reading 35
reading from newer base station 37
reading from older base station 37
saving to file 35
selecting 83
synchronizing with base station 36
updating after firmware upgrade 42
viewing 20
ways of working with 34

conformance tests 164
conncfg.dat file 39
connecting to base station 17, 28

from networked PC 29
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connection list 39
console

interfacing to analog gateway 117
control channel

Task Manager input 193
control panel

disabling 95
status of power supply to 71
testing 174
testing LEDs 174

counter
defining 204
Task Manager action 198
viewing 206

CSS 1
accessing forms in 25
application window 25
event log 76
IP address of 28
monitoring alarms 18
monitoring interfaces 51
starting 25

CTCSS 7, 107
setting deviation of 103

current channel 3
custom action 179, 203

defining 203
viewing 203

custom input 179, 201
defining 202
viewing 201

CWID 109
can interrupt calls 110
locking automatic transmission of 196
monitoring transmission of 55
transmitting (by Task Manager action) 199

D
data

enabling base station for 89
data logging 11, 72
database version 78
dBm, converting to microvolts 101
DC-DC converter 70, 80
DCS code 7, 107

inverted 107
matching base station’s code to radios’ code 7
setting deviation of 103

DCS end tone 108
De pre emph full filter 103
De pre emph speech filter 103
de-emphasis 103

default.apt file 35
DES encryption

feature license for 14
deviation

measuring 128
reduced by subaudible signaling 103

diagnosing 21
how to 157
overview 155

digital board
calibration invalid 146
configuration invalid 146

digital input
using to compute an input value 90
using to select channel 87
viewing state of 167

digital input value 90
viewing 169

digital line
configuring 111
feature license required for voice calls 14
monitoring 55
monitoring packet loss 56
quality of service 61
testing 165
testing links 167

digital output
configuring pin 1 as 90
configuring pin 9 as 90
monitoring 168
setting high (Task Manager action) 195
setting low (Task Manager action) 195
testing 168

digital P25
false detection of 106
feature license for 44
receiver squelch for 99
receiving 98

Digital Private Line see DCS code 7
disconnecting from base station 32
dispatcher

call destination of 132
caller ID of 132
caller identification 125
changing channel 122
command set 121
duplex or simplex link to channel group 115
enabling/disabling radios 126
individual call 123
list of groups to belongs to 134
making a group call 123
monitoring channel 122
propagating commands to channel group 123
remotely monitoring radios 126
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selecting channel 87
selecting groups to belong to 132
selecting mode 121
specifying call type for 131

do now actions (Task Manager) 179
dual mode 98
duplex mode 115
duty cycle

monitoring 68

E
E & M lines 118, 129

monitoring status 66
testing 168

E line input
monitoring 66
viewing status of 168

emergency alarm 126
emergency alert 88
emergency ANI 125
enabling additional features 43
encryption 12

feature license for 14
key empty 64
key mismatch 130
status of line input 64
status of line output 65
warnings 130

encryption key
naming 133
present? 133
selecting 132
unused 133
zeroizing 134

end-to-end delay
increased by MDC1200 129

Ethernet cable 28
EVM 62

monitoring 53
exciter, switching range of 77
external reference

alarm 148
specifying frequency of 95

F
Fahrenheit 48
fan

configuring operation of 94
emulating T800 95
failed (PA) 142

failed (PMU) 144
failed (reciter) 146
monitoring 67, 71
rotation detector 94
testing 170, 171, 172
testing (Task Manager action) 196

fault diagnosis 21
feature enabler 14
feature licenses

determining which are required 43
disabling 45

features
list of 14

filter, on audio path 103
firmware

downgrading 39
folder for upgrade files 48
updating configuration after upgrade 42
upgrading 40
version 78, 79

firmware version 40
flag

defining 204
viewing 206

forms in CSS, accessing 25
forward power 55, 68

low 142
frequency

prohibited 86
function code

sending to channel group 198
function tone

level of 136
monitoring 66, 137
see also tone remote

G
gateway address 112
getting started 15
group call 123
group membership 5, 134
groups that dispatcher belongs to 134
Guest privilege 13

H
hang time 108
hardware version 78, 79
heatsink temperature

of PA 170
HLGT 119
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frequency used 136
level of 136
monitoring 137

hysteresis, in receiver gating 100

I
identity

broadcasting 109
impairment 62
Information messages 74
inhibit 89
initial delay 112

monitoring 57
inputs (Task Manager) 184

alarm 184
Analog line 187
custom 201

inverted DCS code 107
IP address

of base station 111
of channel group 60, 116
of CSS 28

isolator 79

J
jitter 56

alarm 148
alarm threshold 152
monitoring at other base stations 62

jitter buffer 112
configuring 112
monitoring 57

K
kernel 78

upgrading 42
kernel version 40
Key empty 64
key mismatch 130
key missing 64
key present? 133
keytone 119

see also tone remote
using to signal channel seize 129

L
license file, folder to store in 48

license key 43
licensing features 14
line level 127

and deviation measurement 128
monitoring 65
of MDC1200 signaling 129

line signaling
monitoring 66

linking infrastructure
options for speech transport 116

LLGT 119
frequency used 136
level of 136
monitoring 66, 137
using to signal channel seize 129

local repeat holdoff 112
localhost 56
lock 205
lock actions (Task Manager) 179, 196
lock inputs 179
lock range 77

determining 161
log files, location of 48
Logic box 100
loopback test 166

M
M line output

monitoring 66
testing 168

mains supply
simulating failure 172
state of 70

Maintainer privilege 13
Max Tx deviation box 102
MDC1200 120

enabling 129
feature license for 14
increases end-to-end delay 129
line level of 129
monitoring 66
monitoring from CSS 130
supported functions 124

message 88
microphone

disabling 95
testing microphone channel switch 174
testing PTT operation 174

microslots per slot 104
microvolts, converting to dBm 101
mid band 102
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mode
changing 32
viewing current 27

modules
testing 170

Monitor LED 66
monitor squelch 6
monitoring 19, 49

interfaces 51
PA 68
PMU 69
reciter 67

Morse code 109
multicast address 116

N
NAC

configuring 104, 106
locking the decoding of 197
monitoring received 52
monitoring transmitted 54

narrow band 102
navigation pane 19, 25

red item in 157
network board

calibration invalid 146
configuration invalid 146

network identity 111
gateway address may be required 112

network link
monitoring 56

Network Thresholds form 152
Networked user data license 14
No key message 65
no license 64, 65
noise gating 99
normal squelch 6
notch filter 136

O
operating channel 87
operating system kernel version 78
output current 71
output voltage 71

P
P25 common air interface license 14
PA

alarms 142
calibration invalid 142
configured power output 85
current alarms 143
firmware invalid 142
invalid hardware configuration 143
monitoring 68
monitoring air intake temperature 68
monitoring duty cycle 68
monitoring temperature of 170
not detected 142
power foldback 143
power rating 79
shutdown 143
state of power supply to 70
supply voltage alarms 143
temperature 68
temperature alarms 144
testing fault LED 170
version 79
viewing information on 78

packet loss 56
alarm 148
alarm threshold 152

padlock icon 205
paging 88
password access to base station 33

new base station has null password 28
patch cable 28
ping command 167
PMU

alarms 144
auxiliary power output 94
configuring shutdown voltage 93
current high 145
fan failed 144
firmware invalid 144
mains failed 144
monitoring 69
monitoring fan 71
monitoring output 71
not detected 144
powerup fault 144
product code 79
serial number 79
shutdown imminent 144
submodules in 80
temperature high 145
testing fault LED 173
version 80
viewing information on 79
voltage high 145
voltage low 145

port number 114
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power output
configured value 85
monitoring 68
of PA 68
to PA 70
to reciter 71

Power shutdown voltage box 94
Power startup voltage box 94
preamble 112

antenna relay may affect 112
pre-emphasis 103
presence check 89
Private Line see CTCSS tone
privilege 13

changing 46
obtaining 45

product code 79
profiles 5
programming configuration 36

Q
quality of service

alarms 148
monitoring 56
monitoring each base station 61

R
radio check 126
Read icon 35
receive filter 103
receiver

channel spacing 102
current status 51
lock range 161
locking 197
logging raw C4FM data 164
measuring received signal level 160
operating without a configuration 158
selecting mode 98
switching range 77
testing 158
testing sensitivity 159
unmuting to any NAC 106

Receiver channel box 102
receiver gating 99
receiver squelch 6, 99
reciter

alarms 145
lock range 161
monitoring operational information on 67

power up failure 146
serial numbers of 78
state of power supply to 71
temperature high 146
version 78
viewing information on 77

remote monitor 89, 126
resetting the base station 33
reverse power 55, 68
reverse power high 143
reverse tone burst 108
re-voting 116
RF interface

configuring 96
monitoring 51
testing 158

RF repeat function 8
affected by channel group 8
and antenna relay 8
configuring 8, 85
controlling by dispatcher 85, 122
enabling via Task Manager 197
monitoring 54, 63
of the channel group 62

RSSI
monitoring 53, 67

RSSI gating 99
RSSI output 90

configuring Pin 9 as 90
Run mode 32

troubleshooting 32
Rx Gate 118

S
scanning repeater (Task Manager code) 200
security 13
selective call 127
selective squelch 6
serial number 78, 79
serial port 89
service profile 5, 88

monitoring current 64
signal level

measuring across band 160
signal quality 62
signaling profile 5, 104

adding 104
editing 105

simplex channel group 115
simplex operation 91
SINAD
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input into voting 62
measurement method 159
monitoring 53, 67

SINAD gating 99
site controller present

Task Manager input 193
Soft-off time 108
software feature enabler 14, 43
speaker

disabling 95
testing 174

speech band filter 103
speech transport over digital line 60, 116
squelch 6, 63, 131
squelch tail 107
Standby converter 80

state of DC supply to 70
Standby mode 32
stat alert see MDC1200
status bar 27
Status form 141
status report 88
status request 88
status symbol 104
subaudible band filter 103
Subaudible deviation 103
subaudible signaling 7

locking 197
monitoring received 52
monitoring transmitted 54

subnet mask 112
subtone 7, 107
switching range

determining 161
exciter 77
receiver 77
when last altered 78

synchronizing a configuration file 36
synthesizer

alarm 146
determining lock range 161
out of lock 146

syslog collector 153
system alarms 147
System Interface form 89
system log 11, 73

sending to central collector 153

T
tail timers 107
task

adding 182
disabling 183

task list 180
Task Manager 175

actions 179
adding comments 183
adding tasks 182
basic inputs 179
custom actions 199
customizing 201
disabling tasks 183
example tasks 200
examples 200
input types 179
inputs 184
introduction 177
lock inputs 179
processing cycle 178
rules 177
viewing locks 205

temperature
monitoring on PA 170
monitoring on reciter 67
of PA 68
threshold for turning PA fan on 95

temperature alarm
air intake 147

temperature display 48
test tone frequency 128
test tone, generating 165
testing 21

audio output 165
auxiliary power output 173
battery backup 172
control panel 174
digital I/O 167
fan 170, 171, 172
lock range 161
PA fault LED 170
PMU fault LED 173
transmitter 162

timer
defining (Task Manager) 204
starting (by Task Manager action) 199
stopping (by Task Manager action) 199
viewing 206

tone remote 119
analog line license needed 119
feature licenses required for 44
frequency used 136
making compatible with console system 135
mapping commands to calling profiles 135
monitoring 66, 136
notch filter 136
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propagating commands to channel group 123
supported commands 121
using to signal channel seize 129

toolbar 25
trace log 11, 74
transmit buffer

monitoring 57
Transmit enable license 14
transmit filter 103
transmit frequency 85
transmit tail

monitoring 55
transmit timers 107
transmitter

carrier test 162
disabling 103
FM transmission test 163
initial delay 112
locking 197
maximum deviation 102
monitoring 53
power output 68
source of 54
testing 162
testing C4FM modulation 163
testing conformance to P25 standard 164
using received NAC 106

trunking
feature licenses required for 44
IP address of channel controller 116
monitoring 59, 60
setting microslots per slot 104
Task Manager inputs for 193

truth table 202
TSBK

feature licenses required for 44
Tx Key 118

U
uninhibit 89
unused keys 133
upgrading

base station firmware 40
kernel 42

user data
feature licenses required for 44

V
version mismatch 37, 37
version number

of PA 79
of PMU 80
of reciter 78

voice alert 127
voice delay 112
voice drop-outs

viewing call records causes 72
viewing system log causes 73
viewing trace log causes 74

voltage
shutdown threshold 93

voting 116
monitoring 61

VSWR 55, 143
monitoring 68

W
warn on clear speech 130
warn on key mismatch 130
wide band 102

Z
zeroizing keys 134
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Tait General Software Licence Agreement

This legal document is an Agreement between you (the 
“Licensee”) and Tait Electronics Limited (“Tait”). By using any 
of the Software or Firmware items prior-installed in the related 
Tait product, included on CD or downloaded from the Tait 
website, (hereinafter referred to as “the Software or Firmware”) 
you agree to be bound by the terms of this Agreement. If you do 
not agree to the terms of this Agreement, do not install and use 
any of the Software or Firmware. If you install and use any of the 
Software or Firmware that will be deemed to be acceptance of the 
terms of this licence agreement.
The terms of this Agreement shall apply subject only to any 
express written terms of agreement to the contrary between Tait 
and the Licensee.

Licence
TAIT GRANTS TO YOU AS LICENSEE THE NON-EXCLUSIVE 
RIGHT TO USE THE SOFTWARE OR FIRMWARE ON A SINGLE 
MACHINE PROVIDED YOU MAY ONLY:
1. COPY THE SOFTWARE OR FIRMWARE INTO ANY MACHINE 
READABLE OR PRINTED FORM FOR BACKUP PURPOSES IN 
SUPPORT OF YOUR USE OF THE PROGRAM ON THE SINGLE 
MACHINE (CERTAIN PROGRAMS, HOWEVER, MAY INCLUDE 
MECHANISMS TO LIMIT OR INHIBIT COPYING, THEY ARE 
MARKED “COPY PROTECTED”), PROVIDED THE COPYRIGHT 
NOTICE MUST BE REPRODUCED AND INCLUDED ON ANY SUCH 
COPY OF THE SOFTWARE OR FIRMWARE; 
AND / OR

2. MERGE IT INTO ANOTHER PROGRAM FOR YOUR USE ON 
THE SINGLE MACHINE (ANY PORTION OF ANY SOFTWARE OR 
FIRMWARE MERGED INTO ANOTHER PROGRAM WILL 
CONTINUE TO BE SUBJECT TO THE TERMS AND CONDITIONS 
OF THIS AGREEMENT).

THE LICENSEE MAY NOT DUPLICATE, MODIFY, REVERSE 
COMPILE OR REVERSE ASSEMBLE ANY SOFTWARE OR 
FIRMWARE IN WHOLE OR PART.

Important Notice
THE SOFTWARE OR FIRMWARE MAY CONTAIN OPEN SOURCE 
SOFTWARE COMPONENTS (“OPEN SOURCE COMPONENTS”). 
OPEN SOURCE COMPONENTS ARE EXCLUDED FROM THE 
TERMS OF THIS AGREEMENT EXCEPT AS EXPRESSLY STATED IN 
THIS AGREEMENT AND ARE COVERED BY THE TERMS OF THEIR 
RESPECTIVE LICENCES WHICH MAY EXCLUDE OR LIMIT ANY 
WARRANTY FROM OR LIABILITY OF THE DEVELOPERS AND/OR 
COPYRIGHT HOLDERS OF THE OPEN SOURCE COMPONENT 
FOR THE PERFORMANCE OF THOSE OPEN SOURCE 
COMPONENTS. YOU AGREE TO BE BOUND BY THE TERMS AND 
CONDITIONS OF EACH SUCH LICENCE. FOR MORE 
INFORMATION SEE:
http://support.taitworld.com/go/opensource

Title to Software 
THIS AGREEMENT DOES NOT CONSTITUTE A CONTRACT OF 
SALE IN RELATION TO THE SOFTWARE OR FIRMWARE SUPPLIED 
TO THE LICENSEE. NOT WITHSTANDING THE LICENSEE MAY 
OWN THE MAGNETIC OR OTHER PHYSICAL MEDIA ON WHICH 
THE SOFTWARE OR FIRMWARE WAS ORIGINALLY SUPPLIED, OR 
HAS SUBSEQUENTLY BEEN RECORDED OR FIXED, IT IS A 
FUNDAMENTAL TERM OF THIS AGREEMENT THAT AT ALL 
TIMES TITLE AND OWNERSHIP OF THE SOFTWARE OR 
FIRMWARE, WHETHER ON THE ORIGINAL MEDIA OR 
OTHERWISE, SHALL REMAIN VESTED IN TAIT OR THIRD 
PARTIES WHO HAVE GRANTED LICENCES TO TAIT.

Term and Termination 
THIS LICENCE SHALL BE EFFECTIVE UNTIL TERMINATED IN 
ACCORDANCE WITH THE PROVISIONS OF THIS AGREEMENT. 
THE LICENSEE MAY TERMINATE THIS LICENCE AT ANY TIME BY 
DESTROYING ALL COPIES OF THE SOFTWARE OR FIRMWARE 
AND ASSOCIATED WRITTEN MATERIALS. THIS LICENCE WILL BE 
TERMINATED AUTOMATICALLY AND WITHOUT NOTICE FROM 
TAIT IN THE EVENT THAT THE LICENSEE FAILS TO COMPLY 
WITH ANY TERM OR CONDITION OF THIS AGREEMENT. THE 
LICENSEE AGREES TO DESTROY ALL COPIES OF THE SOFTWARE 
OR FIRMWARE AND ASSOCIATED WRITTEN MATERIALS IN THE 
EVENT OF SUCH TERMINATION.

Limited Warranty 
THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE 
COMPONENTS) IS SUPPLIED BY TAIT AND ACCEPTED BY THE 
LICENSEE “AS IS” WITHOUT WARRANTY OF ANY KIND EITHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT BEING LIMITED 
TO ANY IMPLIED WARRANTIES AS TO MERCHANTABILITY OR 
FITNESS FOR ANY PARTICULAR PURPOSE. THE LICENSEE 
ACKNOWLEDGES THAT THE SOFTWARE OR FIRMWARE 
(INCLUDING OPEN SOURCE COMPONENTS) IS USED BY IT IN 
BUSINESS AND ACCORDINGLY TO THE MAXIMUM EXTENT 
PERMITTED BY LAW NO TERMS OR WARRANTIES WHICH ARE 
IMPLIED BY LEGISLATION SHALL APPLY TO THIS AGREEMENT. 
TAIT DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED 
IN THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE 
COMPONENTS) WILL MEET THE LICENSEE’S REQUIREMENTS OR 
THAT THE OPERATION OF THE SOFTWARE OR FIRMWARE 
(INCLUDING OPEN SOURCE COMPONENTS) WILL BE 
UNINTERRUPTED OR ERROR FREE.

Exclusion of Liability
IN NO CIRCUMSTANCES SHALL TAIT BE UNDER ANY LIABILITY 
TO THE LICENSEE, OR ANY OTHER PERSON WHATSOEVER, 
WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT 
(EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT), 
EQUITY, UNDER ANY STATUTE, OR OTHERWISE AT LAW FOR 
ANY LOSSES OR DAMAGES WHETHER GENERAL, SPECIAL, 
EXEMPLARY, PUNITIVE, DIRECT, INDIRECT OR 
CONSEQUENTIAL ARISING OUT OF OR IN CONNECTION WITH 
ANY USE OR INABILITY OF USING THE SOFTWARE OR 
FIRMWARE (INCLUDING OPEN SOURCE COMPONENTS).

THE LICENSEE’S SOLE REMEDY AGAINST TAIT WILL BE LIMITED 
TO BREACH OF CONTRACT AND TAIT’S SOLE AND TOTAL 
LIABILITY FOR ANY SUCH CLAIM SHALL BE LIMITED AT THE 
OPTION OF TAIT TO THE REPAIR OR REPLACEMENT OF THE 
SOFTWARE OR FIRMWARE OR THE REFUND OF THE PURCHASE 
PRICE OF THE SOFTWARE OR FIRMWARE.

General
THE LICENSEE CONFIRMS THAT IT SHALL COMPLY WITH THE 
PROVISIONS OF LAW IN RELATION TO THE SOFTWARE 
OR FIRMWARE.

Law and Jurisdiction 
THIS AGREEMENT SHALL BE SUBJECT TO AND CONSTRUED IN 
ACCORDANCE WITH NEW ZEALAND LAW AND DISPUTES 
BETWEEN THE PARTIES CONCERNING THE PROVISIONS 
HEREOF SHALL BE DETERMINED BY THE NEW ZEALAND 
COURTS OF LAW. PROVIDED HOWEVER TAIT MAY AT ITS 
ELECTION BRING PROCEEDINGS FOR BREACH OF THE TERMS 
HEREOF OR FOR THE ENFORCEMENT OF ANY JUDGEMENT IN 
RELATION TO A BREACH OF THE TERMS HEREOF IN ANY 
JURISDICTION TAIT CONSIDERS FIT FOR THE PURPOSE OF 
ENSURING COMPLIANCE WITH THE TERMS HEREOF OR 
OBTAINING RELIEF FOR BREACH OF THE TERMS HEREOF.

No Dealings 
THE LICENSEE MAY NOT SUBLICENSE, ASSIGN OR TRANSFER 
THE LICENCE OR THE PROGRAM EXCEPT AS EXPRESSLY 
PROVIDED IN THIS AGREEMENT. ANY ATTEMPT OTHERWISE TO 
SUBLICENSE, ASSIGN OR TRANSFER ANY OF THE RIGHTS, 
DUTIES OR OBLIGATIONS HEREUNDER IS VOID.

No Other Terms 
THE LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS 
AGREEMENT, UNDERSTANDS IT AND AGREES TO BE BOUND BY 
ITS TERMS AND CONDITIONS. THE LICENSEE FURTHER AGREES 
THAT SUBJECT ONLY TO ANY EXPRESS WRITTEN TERMS OF 
AGREEMENT TO THE CONTRARY BETWEEN TAIT AND THE 
LICENSEE THIS IS THE COMPLETE AND EXCLUSIVE STATEMENT 
OF THE AGREEMENT BETWEEN IT AND TAIT IN RELATION TO 
THE SOFTWARE OR FIRMWARE WHICH SUPERSEDES ANY 
PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN AND 
ANY OTHER COMMUNICATIONS BETWEEN THE LICENSEE AND 
TAIT RELATING TO THE SOFTWARE OR FIRMWARE.
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